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Preface

This guide provides information and instructions about the basic system
configuration on the Nortel* Ethernet Routing Switch 4500 series. Before
you start the configuration process, consult the documentation included
with the switch and the product release notes (see "Related publications"
(page 14)) for errata.

The topics in "Related topics" (page 13) relate to the system configuration
process but are not described in depth in this guide. For more information
about a specific topic, see the book for that specific topic.

Related topics

Topic Book

Switch security Nortel Ethernet Routing Switch 4500 Series
Security — Configuration (NN47205-505)

VLANSs Nortel Ethernet Routing Switch 4500 Series

Configuration — VLANSs, Spanning Tree, and
MultiLink Trunking (NN47205-501)

Spanning Trees and Nortel Ethernet Routing Switch 4500 Series

Spanning Tree Groups Configuration — VLANS, Spanning Tree, and
MultiLink Trunking (NN47205-501)

MultiLink Trunking Nortel Ethernet Routing Switch 4500 Series

Configuration — VLANSs, Spanning Tree, and
MultiLink Trunking (NN47205-501)

Quality of Service Nortel Ethernet Routing Switch 4500
Series Configuration — Quality of Service
(NN47205-504)

IP Filtering Nortel Ethernet Routing Switch 4500 Series
Security — Configuration (NN47205-505)
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14 Preface

Nortel Ethernet Routing Switch 4500 Series
"4500 Series Switch platforms" (page 14) outlines the switches that are part
of the Nortel Ethernet Routing Switch 4500 series of switches.

4500 Series Switch platforms

Model Model-specific features

4526FX 24 100BaseFX ports (MTRJ connector) plus 2 10/100/1000
SFP combo ports
Redundant power slot for DC/DC converter installation

4550T 48 10/100BaseTX RJ-45 ports plus 2 10/100/1000 SFP
combo ports
Redundant power slot for DC/DC converter installation

4550T-PWR 48 10/100BaseTX RJ-45 ports with Power over Ethernet
plus 2 10/100/1000 SFP combo ports

Integrated redundant power connector for RPS 15 cable
connection

4548GT 48 10/100/1000BaseTX RJ-45 ports and 4 shared SFP
ports
Redundant power slot for DC/DC converter installation

4548GT-PWR 48 10/100/1000BaseTX RJ-45 ports with PoE and 4 shared
SFP ports

Integrated redundant power connector for RPS 15 cable
connection

Related publications
For more information about the management, configuration, and use of the
Nortel Ethernet Routing Switch 4500 Series, see the publications listed in
"Nortel Ethernet Routing Switch 4500 Series documentation” (page 14).

Nortel Ethernet Routing Switch 4500 Series documentation

Title Description Part Number
Nortel Ethernet Regulatory and safety NN47205-100
Routing Switch 4500 information for the Nortel
Series Regulatory Ethernet Routing Switch 4500
Information Series.
Nortel Ethernet Instructions to install a switch NN47205-300
Routing Switch 4500 in the Nortel Ethernet Routing
Series Installation Switch 4500 Series. This guide

also provides an overview

of hardware important to the

installation, configuration, and

maintenance of the switch.
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Related publications 15

Title

Description

Part Number

Nortel Ethernet
Routing Switch 4500
Series Release Notes
— Software Release
5.0

An overview of new features,
fixes, and limitations of the
4500 Series switches. Also
included are supplementary
documentation and document
errata.

NN47205-400

Nortel Ethernet
Routing Switch 4500
Series Overview —
System Configuration

General instructions to configure
switches in the 4500 Series that
are not covered by the other
documentation.

NN47205-500

Nortel Ethernet
Routing Switch 4500
Series Configuration
— VLANS, Spanning
Tree, and MultiLink
Trunking

Instructions to configure
spanning and trunking protocols
on 4500 Series switches.

NN47205-501

Nortel Ethernet
Routing Switch 4500
Series Configuration
— System Monitoring

Instructions to configure,
implement, and use system
monitoring on 4500 Series
switches.

NN47205-502

Nortel Ethernet

Routing Switch 4500
Series Configuration
— Quality of Service

Instructions to configure and
implement QoS and filtering on
4500 Series switches.

NN47205-504

Nortel Ethernet
Routing Switch 4500
Series Security —
Configuration

Instructions to configure and
manage security for switches in
the 4500 Series.

NN47205-505

DC-DC Converter Instructions to install and use the | 215081-A
Module for the DC-DC power converter.

Baystack 5000 Series

Switch

Installing the Nortel Instructions to install and use the | 217070-A
Ethernet Redundant Nortel Ethernet RPS 15.

Power Supply Unit 15

Installing SFP and Instructions to install and use 318034-D

XFP Transceivers
and GBICs

small form-factor pluggable
transceivers and gigabit interface
converters.
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16 Preface

Finding the latest updates on the Nortel Web site
The content of this documentation was current at the time of release. To
check for updates to the documentation and software for the Nortel Ethernet
Routing Switch 4500 Series, go to www.nortel.com/support and use the
following procedure.

Step Action

1 Select Ethernet Routing Switches from the Product Categories
list in section 1.

2 Select Ethernet Routing Switch 4500 from section 2.

3 Select one of the following from section 3.

« Documentation

e Software

4 Click Go.

—End—

How to get help
This section explains how to get help for Nortel products and services.

Getting help from the Nortel Web site
The best way to get technical support for Nortel products is from the Nortel
Technical Support Web site:

www.nortel.com/support

This site provides quick access to software, documentation, bulletins, and
tools to address issues with Nortel products. From this site, you can:

* download software, documentation, and product bulletins

» search the Technical Support Web site and the Nortel Knowledge Base
for answers to technical issues

* sign up for automatic notification of new software and documentation
for Nortel equipment

* open and manage technical support cases

Getting help over the phone from a Nortel Solutions Center
If you do not find the information you require on the Nortel Technical Support
Web site, and you have a Nortel support contract, you can also get help
over the phone from a Nortel Solutions Center.

Nortel Ethernet Routing Switch 4500 Series
Overview — System Configuration
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In North America, call 1-800-4NORTEL (1-800-466-7835).

Outside North America, go to the following Web site to obtain the phone
number for your region:

www.nortel.com/callus

Getting help from a specialist using an Express Routing Code
To access some Nortel Technical Solutions Centers, you can use an Express
Routing Code (ERC) to quickly route your call to a specialist in your Nortel
product or service. To locate the ERC for your product or service, go to:

www.nortel.com/erc

Getting help through a Nortel distributor or reseller
If you purchased a service contract for your Nortel product from a distributor
or authorized reseller, contact the technical support staff for that distributor
or reseller.
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4500 Series user interfaces

The switch administrator can choose from three interfaces to configure
switches on the Nortel Ethernet Routing Switch 4500 Series switches. This
chapter provides an introduction to each user interface, instructions for use,
and instructions for installation if applicable.

This chapter contains the following topics:
¢ "Command line interface" (page 19)
« "Java Device Manager" (page 22)

e "Web-based Management Interface" (page 56)

Command line interface

The command line interface (CLI) is the text-based interface used in switch
configuration and management.

The following sections describe CLI access and commands:
¢ "Accessing the CLI" (page 19)

e "CLI command modes" (page 21)

Accessing the CLI
Access the CLI by either of the following:

+ direct console connection to the switch

* remote connection to switch using a Telnet protocol

To connect to the CLI, perform the following procedure.

Step Action
1 Connect to the switch over a Telnet session or through the console
port.

a. If you connect remotely to the switch through the Telnet protocol,
ensure that access through this protocol is enabled and that the
IP address of the switch is valid.

Nortel Ethernet Routing Switch 4500 Series
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20 4500 Series user interfaces

b. If you connect to the switch through a direct console connection,
connect an approved console cable to the console port on the
switch, and use a terminal emulation program that is configured
with the settings listed in "Terminal Emulation settings” (page 20).

Terminal Emulation settings

Property Value
Baud Rate 9600 bps
Data Bits 8
Stop Bits 1
Parity None
Flow Control None
Terminal Protocol VT100 and VT100/ANSI
2 If applicable, enter the password to gain access to the switch or

stack. Obtain this password from the switch administrator. For more
information about maintaining switch access passwords, see Nortel
Ethernet Routing Switch 4500 Series Security — Configuration
(NN47205-505).

3 After you establish communication with the switch, a banner screen
appears as illustrated in "CLI Banner Screen" (page 20). Press
CTRL+Y to access the CLI.

CLI Banner Screen

nun wuy lﬂﬂﬂﬂlﬂﬂﬂlﬂﬂl HURRRRENAN  HERRUNUBURERE BRuBRERERRYE Hun
Huuy HHY HEBHBBRERRURN BHHBHHIIHHEE SHERRNBRARIES BUUBEREE0E a0
Huuuy Hug Ben Hay nay nu Hay Ha Hun
Hupuuy Huy Ben sy nuy Hu Hun Huy nun
HHE nER o nHe BRi Hun nHuRRERREREY Hi HunuuRREg Hun
HHy  wiH nne sen Hun nuunRERERn nan HanunnREy Hun
e HumUNY Bl nin nay Hith e Hau i
Hauy nunuy wul aan nuy ey fnuy qun
Hay HHy pREgppnsdERnn gun nuy noy EESEREE S U
nug Huy pRERRnAsERR Han nun no PRSI B b

Enter Ctrl-¥ to begin. Build Info: Oct 18 2006, 15:18:56, hshld botanvbay5.8.8_

%% Ethernet Routing Switch 4548GT-PUR Eaiaded
wnx Nortel et
wwn Copyright {c) 1996-2886,. All Rights Reserved R
el SSH EEEl
s HilzBA Fi:1.8.8.14 SW:v5.0.8.883 ikl

The CLI prompt appears. See "CLI command modes" (page 21).

—End—
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B |

CLI command modes
The CLI has four command modes based on the level of permissions
assigned to you. The password that you use to log on determines the
level of permissions. Each command mode provides access to a specific
group of commands.

The four command modes, from most to least restricted, are
« User EXEC mode

The User EXEC mode (also referred to as exec mode) is the default CLI
command mode. User EXEC is the initial mode of access when you
first turn on a switch. User Exec mode provides a limited subset of CLI
commands, is the most restrictive CLI mode, and has few privileges.

e Privileged EXEC mode

Use Privileged EXEC mode (also referred to as privExe mode) to
perform basic switch-level management tasks, such as downloading
software images, setting passwords, and booting the switch.

e Global Configuration mode

Use Global Configuration mode (also referred to as config mode) to set
and display general configurations for the switch, such as IP address,
SNMP parameters, Telnet access, and VLANS.

* Interface Configuration mode

Use Interface Configuration mode (also referred to as if-config mode) to
configure parameters, such as speed, duplex mode, and rate-limiting,
for each port or VLAN.

The Command modes table lists the four command modes, the prompt for
each, the CLI commands to use to proceed to the next mode, and the CLI
commands to enter and exit the modes. Each switch displays a prompt
specific to the switch type. The prompts displayed in the table are for a
Nortel Ethernet Routing Switch 4500 Series 4548-GT-PWR switch.

Command modes

Current command
mode

CLI prompt

To move up to
the next mode

To leave
current mode

User EXEC

4548GT-PWR>

Use the enable
command to
move to the
Privileged EXEC
mode.

Use one of
the following
commands to
close the CLI
session:

. exit

e logout

Nortel Ethernet Routing Switch 4500 Series
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22 4500 Series user interfaces

Current command
mode

CLI prompt

To move up to
the next mode

To leave
current mode

Privileged EXEC

4548GT-PWR#

Use the
configure
command

to move to

the Global
Configuration
mode.

You are
prompted to
specify your
connection: exa
mple—terminal or
console.

Use the exit
command to
return to the User
EXEC mode.
Use the logout
command to
close the CLI
session.

Global Configuration

4548GT-PWR (config) #

Use the
interface
fastethernet
all command
to move to

the Interface
Configuration
mode.

Use the exit
command to
return to the
Privileged EXEC
mode.

Use the logout
command to
close the CLI
session.

Interface
Configuration

4548GT-PWR (config-if)#

This is the top
level.

Use the exit
command

to return to
the Global
Configuration
mode.

Use the end
command to
return to the
Privileged EXEC
mode.

Use the logout
command to
close the CLI
session.

Java Device Manager
The Java Device Manager (JDM) is a graphical user interface (GUI)
application used in switch configuration and management operations. The
JDM provides a real-time graphical representation of the front panel of
the switch being administered. From this view, you can perform all switch
configuration tasks.

Copyright © 2007, Nortel Networks
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Java Device Manager 23

Unlike the CLI and Web-based Management Interface, the JDM is a client
application that resides on a computer with network access to the devices to
be monitored and configured by an administrator. This being the case, any
user who wishes to access a Nortel Ethernet Routing Switch 4500 Series
through the JDM must install the application on an appropriate computer.

This section contains the following topics:

"Obtaining the Java Device Manager" (page 23)

"Installing the Java Device Manager" (page 24)

"Starting the Java Device Manager" (page 36)

"Configuring Device Manager properties" (page 37)
"Opening a Switch with the Java Device Manager" (page 40)

"Device Manager interface components” (page 42)

Obtaining the Java Device Manager
If the JDM is not already installed on the switch management computer, you
can download it from the Nortel Web site.

To obtain the JDM, perform the following procedure:

Step Action

1 Open a new Web browser window and, in the Address area, type
http://www.nortel.com/support.

2 If the Browse product support tab is not already selected, click it.

3 From the list, provided in the product family box, select Nortel
Ethernet Routing Switch.

4 From the product list select Nortel Ethernet Routing Switch 4500
Series.

5 From the content list, select Software.

6 Click Go.

The available software list appears.

7 The available software list displays all software associated with the
selected switch family, in descending chronological order (newest
to oldest).

8 To select the newest JDM software version, click the link next to the

version that appears first in the list.
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9 Software specific to each operating system environment is listed. To
download the correct version for the operating system that runs on
the switch administration computer, click the associated link.

10 When the prompt screen appears, select Save the file to the local
file system.

The JDM software download starts.

11 When the download is complete, see "Installing the Java Device
Manager" (page 24).

—End—

Installing the Java Device Manager
After you obtain the latest version of the JDM, you must install it on the
computer designated for switch administration. Installation procedures
vary depending on the operating system environment of the administrative
computer. Refer to the appropriate section for installation procedures.

¢ "Installing the JDM in a Microsoft Windows Environment" (page 24)
¢ "Installing the JDM in a UNIX Environment" (page 30)
Before you start the installation procedure in any operating system

environment, ensure that you unistall all previous versions of the software
and that you install the new version of the application in a new directory.

Installing the JDM in a Microsoft Windows Environment
The minimum system requirements for installing the JDM in a Microsoft
Windows environment are

* Operating System Version
— Windows NT, Windows 95, Windows 98, Windows2000, or
WindowsXP
« CPU Requirements
— Pentium 1l 350 MHz or better

¢ Memory Requirements
— 256 MB DRAM or better

e Hard Drive Requirements

— 300 MB of available space
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To install the Java Device Manager in a Windows environment, perform the
following procedure.

Step Action

1 Close all programs.

2 Locate the downloaded executable file on the local computer.

3 Double-click the jdm xxx.exe executable file to begin the
installation process. In the downloaded file, the xxx is substituted
with the version number of the software.

4 The installation program is loaded. When the program is ready
to proceed with the installation, a message box similar to the one
illustrated in "Introductory Windows installation message box" (page
25) appears. Follow all instructions on this screen before you
proceed with the installation.

Click Next when you are ready.
Introductory Windows installation message box
¥ Java Device Manager,
Introduction
- Introduction Installamawhere will guide you through the installation of Java Device
’ \ Manager.
|}
Itis strongly recommended that you quit all programs before
J continuing with this installation.
]
] Click the 'Mext' button to proceed to the next screen. fyou want to
" change something an a previous screen, click the 'Previous' button.
]
You may cancel this installation at any time by clicking the '‘Cancel’
Cancel
5 The license agreement message box appears.

Accept the license agreement, which is mandatory to install the
JDM. Read the license agreement fully. Indicate your acceptance
by selecting | accept the terms of the License Agreement. To
proceed, click Next.

"Windows License Agreement message box" (page 26) illustrates an
example of this message box.
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Windows License Agreement message box

Y2 Java Device Manager

License Agreement

= Introduction Installation and Use of Java Device Manager Requires Acceptance

= License Agreement \ of the Following License Agreement:
. 2

Nortel Networks Inc. Software License Agreement
]
C This Software Licensze Agreernent ("License Agreement) iz
O between you, the end-user {"Customer™ and Mortel Metworkes
]
= 1 accept the terms of the License .ﬂgreementé
\ ; :

¢~ 1do NOT accept the terms of the License Agreement

Cancel Previous ‘ Mesxt ‘

6 After you accept the license agreement, the next dialog box (see
"Windows Choose Install Sets dialog box" (page 27)) prompts you
for an installation set. Although four options are available, Nortel
recommends that you select Typical to ensure that all application
components are installed. If you require a more specialized
installation, select one of the other options. The four options are
as follows:

* Typical—Install all software components and online Help is
installed.

* Minimal—Install only the software; do not install online Help.
* Help—Install only online Help.

* Custom—Select the software components and online Help that
you want to install.

Click Next to proceed.
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Windows Choose Install Sets dialog box

2 Java Device Manager

Choose Install Sets

- Introduction

Typical

The JOM application and all on-line help fileswill be installed.

[

~ License Agreement

m Choose Install Sets Minimal

" —u 1 Onlythe JDM application will be installed. This option is
® ﬁ Help

™ ——— 1 Only all an-line help files will be installed.

L ﬁ Custom

n ——— 1 Choose this option to customize the features to be installed.

Cancel Previous

27

On the next dialog box (see "Windows Choose Install Folder dialog
box" (page 27)), type a location on the local file system to install the
JDM, or select a location by clicking Choose. Click Restore Default
Folder to restore the default installation location at any time. Click

Next to proceed.

Windows Choose Install Folder dialog box

Y2 Java Device Manager

Choose Install Folder

—Intraduction . Where Would You Like to Install?

~ License Agreement CoProgram FileswDh

= Clieoe il St Restore Default Folder ‘ Choosze... ‘

m Choose Install Folder

Cancel Prewvious © Rext

On the dialog box (see "Windows Choose Shortcut Folder dialog
box" (page 28)), select a location for the placement of icons in the

Start menu. After you make this selection, click Next to proceed.
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Windows Choose Shortcut Folder dialog box

2 Java Device Manager E|§|®
Choose Shortcut Folder

= InrodguEnon Where would you like to create product icons?

= LICENSE AQMERIMENT ® In & newy Program Group: Java Device Manager| ‘
= LNo0se INstall Sers

= N00se INstall Folner Oln an existing Program Group: ‘
] LNo0se SAOMCUT Folder

™ e} Inthe Start Menu

]

" O Onthe Desktop

O Inthe Guick Launch Bar

e} COther: ‘

o Diont rreate icans

InstallAnywhere by Zero G

[ Previous l et l
9 Confirm the previous selections on the Pre-Installation Summary

message box (see "Windows Pre-Installation Summary message
box" (page 28)). If all selections are accurate, click Install to begin
installing the JDM on the local computer. If changes are necessary,
click Previous to return to the screens in question.

Windows Pre-Installation Summary message box

Y2 Java Device Manager [ZIIE[XI

Pre-Installation Summary

= Introduction . Please Review the Following Before Continuing:

~ License Agreement Product Name:
Java Device Manager

~ Choose Install Sets
Install Folder:

= Choose Install Folder CAProgram FilesiJoM

Shortcut Folder:
=Choose Shaiteatholoer CADncuments and Settingsiekpetersistart
o Pl hatalaiopetT MenuviProgramsiNartel Applications
Disk Space Information {for Installation Target):
[ ] Required: 188,139,036 bytes

[ ] Rvailable: 5,162,299,392 bytes

Cancel Prewvious ‘

10 During the installation process, the message box illustrated in
"Windows Installation Progress message box" (page 29) shows the
progress of the installation.

Nortel Ethernet Routing Switch 4500 Series
Overview — System Configuration
NN47205-500 02.01 Standard
5.0 23 February 2007
Copyright © 2007, Nortel Networks Nortel Networks Confidential



Java Device Manager 29

Windows Installation Progress message box

Y2 Java Device Manager

Installing Java Device Manager

= Introductiol

~ License Agreement

NQORTEL
NETWORKS

~ Choose Install Sets
= Choose Install Folder
= Choose Shorteut Folder

= Pre-Installation Summary

Networks

m Installing. .

Installing... Java Runtime Emvironment

Cancel T

11 When the installation process is finished, the message box displayed
in "Windows Install Complete message box" (page 29) appears.
Click Done to complete the installation.

Windows Install Complete message box

& Java Device Manager

Install Complete

= Introductiol Cangratulations! Java Device Manadger has heen successiully

- License Agreement installed to:

~ Choose Install Sets
CAProgram FilestJDM
~ Choose Install Faolder

= Choose Shortcut Folder Press ™Done™ to quit the installer.
= Pre-Installation Summany

= Installing...

m Install Complete

|

—End—
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Installing the JDM in a UNIX Environment
The minimum system requirements for installing the JDM in a UNIX
environment are:

» Operating System Version
— Sun Solaris 2.7.x (or higher), Linux Kernel 2.2 (or higher), or HP-UX
11.x (or higher)
* Memory Requirements
— 128 MB DRAM or better

e Hard Drive Requirements
— 4 MB available in a temporary directory for installation

— 300 MB available in the installation directory

If the UNIX workstation on which you install the JDM uses the Sun Solaris
operating system, see the section "Installing Solaris Patches" (page 35)
before you start the installation. When this procedure is complete, or if Sun
Solaris does not run on the UNIX workstation, install the JDM by performing
the following procedure.

Step Action

1 Close all programs.

2 Locate the downloaded executable file on the local computer.

3 Run the executable file to begin the installation. Depending on the

UNIX operating system in use, the file name takes one of three
forms. "UNIX JDM installation files" (page 30) outlines the form each
file name takes.

UNIX JDM installation files

Operating System File Name

Sun Solaris jdm_XXXX_solaris_sparc.sh

Linux jdm_XXXX_linux.sh

HP-UX jdm_XXXX_hpux_pa-risc.sh

In the downloaded file, substitute XXXX in the table with the version
number of the JDM that you download.

4 The installation program is loaded. When the program is ready
to proceed with the installation, a message box similar to the one
illustrated in "Introductory UNIX installation message box" (page
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31)appears. Follow all instructions on this screen before you proceed
with the installation. Click Next when you are ready.

Introductory UNIX installation message box

& Java Device Manager [le@[il

Introduction

m Intraduction . InstallAnywhere will guide you through the installation of Java Device
lanager.

- g

]

Itis strongly recommended that you guit all programs before

. continuing with this installation.

|}

] Click the 'Mext' button to proceed to the next screen. Ifyou want to

- change something aon a previous screen, click the 'Previous' button.
|}

You may cancel this installation at any time by clicking the '‘Cancel’

Cancel

The next message box requests acceptance of the license
agreement that governs the JDM software. Acceptance of this
software license is mandatory to install the JDM.

5 Read the license agreement fully and indicate acceptance by
selecting | accept the terms of the License Agreement. To
proceed, click Next.

"UNIX License Agreement message box" (page 32) illustrates an
example of this message box.
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UNIX License Agreement message box

Y2 Java Device Manager

License Agreement
= Introduction Installation and Use of Java Device Manager Requires Acceptance
= License Agreement \ of the Following License Agreement:
. 2
Nortel Networks Inc. Software License Agreement
]
C This Software Licensze Agreernent ("License Agreement) iz
O between you, the end-user {"Customer™ and Mortel Metworkes
]
= 1 accept the terms of the License .ﬂgreementé
s ¢~ 1do NOT accept the terms of the License Agreement
Cancel Previous ‘ Mesxt ‘
6 After you accept the license agreement, the next dialog box (see

"UNIX Choose Install Sets dialog box" (page 33)) prompts you
for an installation set. Although four options are available, Nortel
recommends that you select Typical, to ensure that you install
all application components. If you require a more specialized
installation, select one of the other options. The four options are
as follows:

* Typical—Install all software components and online Help.

* Minimal—Install only the software; do not install online Help.

* Help—Install only online Help.

* Custom—Select the software components and online Help that
you want to install.

Click Next to proceed.
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UNIX Choose Install Sets dialog box
2 Java Device Manager
Choose Install Sets
- Introduction ’ﬁ Typical
~ License Agreement = The JOM application and all en-line help fileswill be installed.
m Choose Install Sets I\:"Ili.nin'.l.al
" Only the JD'M application will be installed. This aption is
| ] () Help
™ ——— 1 Only all an-line help files will be installed.
L ﬁ Custom
n ——— 1 Choose this option to customize the features to be installed.
Cancel Previous
7 On the next dialog box (see "UNIX Choose Install Folder dialog box"

(page 33)), type a location on the local file system to install the
JDM, or select a location by clicking Choose. Click Restore Folder
Default to restore the default installation location at any time. Click

Next to proceed.

UNIX Choose Install Folder dialog box

Y2 Java Device Manager

Choose Install Folder

—Intraduction

Where Would You Like to Install?

~ License Agreement
~ Choose Install Sets

m Choose Install Folder

/bnw/home/ylee/Java_Device NManager

Restore Default Folder ‘ Choosze... ‘

Cancel Previous et
8 Confirm the previous selections on the Pre-Installation Summary

message box (shown in "UNIX Pre-Installation Summary message
box" (page 34)). If all selections are accurate, click Install to begin
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installing the JDM on the local computer. If changes are necessary,
click Previous to return to the dialog boxes in question.

UNIX Pre-Installation Summary message box

Y2 Java Device Manager

Pre-Installation Summary

= Introduction . Please Review the Following Before Continuing:

- License Agreerment Product Wame:

Java Device Manager
= Choose Install Sets =

= Choose Install Folder Install Folder:
/buw/home/vlee/Java_Device_Manager
= Choose Shorteut Folder

Link Folder:

Pre-Installation Summa .
a W buwhome/ylee

Disk Space Information (for Installation Target):
[ ] Required: 188139036 bytes
Available: 5,162,299,392 hytes

Cancel Prewvious ‘

9 During the installation, the message box illustrated in "UNIX
Installation Progress message box" (page 34) shows the progress.

UNIX Installation Progress message box

2 Java Device Manager

Installing Java Device Manager

- Introduction

~ License Agreement
; NEQRTEL
~ Choose Install Sets NETWORKS

~ Choose Install Folder
= Choose Shortcut Folder

= Pre-Installation Summary

Unified
Networks

m Installing...

Installing... Java Runtime Environment

Cancel TTT1

10 When the installation finishes, the message box shown in "UNIX
Install Complete message box" (page 35)appears. Click Done to
complete the installation.
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UNIX Install Complete message box

2 Java Device Manager

Install Complete

= Introduction Congratulations! Java Device Manager has been successiully

- License Agreement \ installed to:

~ Choose Install Sets
Ihrwithomelyleefdava_Device_Manager
= Choose Install Folder

Echoose Shottiigelcat Press "™ Done™ to quit the installer.
= Pre-Installation Summary

~ Installing...

= Install Complete

]

—End—

Installing Solaris Patches For SPARC versions 5.7 and 5.8, you must
install operating system patches for Sun Solaris before you install the JDM.
Consult the system administrator or a network technician to determine
whether these patches are installed on the workstation. You need apply
these patches to the workstation only once.

To proceed with patch installation, perform the following procedure.

Step Action

1 Use the uname -a command on the Solaris workstation to
determine the version of Solaris that is installed.

2 Open a Web browser window and type http://sun-
solve.sun.com in the Address area. SunSolve is the Sun
Microsystems technical support Web site. Use the tools on this
Web page to find the patches associated with the version of Solaris
running on the workstation. Read and follow all directions carefully.

—End—
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Starting the Java Device Manager
After the JDM is successfully installed, it is ready to connect to and
administer switches in the network. The procedure to run the JDM depends
on the operating system environment in which it was installed. "JDM
execution options" (page 36) describes how to start the JDM in the two main
operating system environments supported.

JDM execution options

Operating System JDM Execution Options

Microsoft Windows * If you selected the installation defaults from the
Windows taskbar, select Start > Programs >
Nortel > Java Device Manager > DM.

* Otherwise, select the commands that reflect the
icon placement specified during installation.

UNIX * From the installation directory type the command
./JDM.

¢ Create the environment variable JDM_HOME and
include it in the search path. This variable is used
to run the JDM from any directory on the computer.
Consult the operating system documentation for
the steps to complete this process.

After the JDM successfully starts, the JDM main window ("JDM main
window" (page 36)) appears.

JDM main window

I=E]

Device Help

E O Rl
NERTEL

ST
Unified
Networks

There are two ways to access the default properties settings from the JDM
main window.

« Before any device has been accessed, select Device > Properties
> Current.

» After a device has been accessed, select Device > Properties >
Devices.
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Configuring Device Manager properties
Device Manager uses the Simple Network Management Protocol (SNMP) to
configure and manage Ethernet Routing Switch 4500 Series devices. You
can use the Device Manager Properties dialog box to configure important
communication parameters, such as the polling interval, timeout, and retry
count. You can set these parameters at any time before or after you open a
device.

Before you have accessed a device, to set the Device Manager properties:

Step Action
1 From the Device Manager menu bar, choose Device > Properties
> Current.

The Default Properties dialog box appears.
Device Manage |

~Polling
Status Interval: IZD SECS

Hokswap Dekect every: |1 intervals
[+ Enable

~SMMP

Retry Count: ll_ 1.5

Timeout: IS 3,30 secs

[~ Trace

|v Listen for Traps

Max Traps in Log: ISDD 1,.10000
Trap Port: |162

¥ Listen for Syslogs

[~ Confirm row deletion

Drefault Read Community: Ipublic
Drefault Wirite Community: Iprivate

—Application Control

I~ Application launch with ring tone

[~ Save SHMPv3 Devices ko Open Lask

Htkp Port: ISD
Ok I Close | Help. .. I

2 Configure the properties as described in the Default Properties table.
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3 Click OK.

Default Properties fields

Area Item Description
Polling Status Interval Interval at which statistics and status information is gathered.
For a full stack, set this interval from 120 to 300 seconds.
Hotswap Detect The frequency at which Device Manager polls for hot swap
every module information. This value is relative to the Status Interval
value. For example, if the Status Interval is 120, and the value
for Hotswap Detect every is 2, Device Manager polls the hot
swap modules every 240 seconds. If you want less frequent
hot swap polling, set this value to poll every 2 or 3 intervals.
Enable Enables (true) or disables (false) periodic polling of the device
for updated status. If polling is disabled, the chassis status is
updated only when you click Refresh on the Chassis tab.
SNMP Retry Count Number of times Device Manager sends the same polling

request if a response is not returned to Device Manager. You
can set this field to three or four.

Timeout Length of each retry of each polling waiting period. When you
access the device through a slow link, you can increase the
timeout interval and then change the Retransmission Strategy
to superlinear.

Trace The trace field is used to enable and disable SNMP tracing.

When Trace is selected, SNMP protocol data units (PDUs) are
displayed in the Device > Log dialog box.

Listen for traps

When selected (enabled), Device Manager listens for traps
from the device.

Max Traps in
Log

The specified number of traps that can exist in the trap log.
The default is 500.

Trap Port The UDP port that Device Manager uses to listen for SNMP
traps.

Listen for Enable the Device Manager to listen to the syslog.

Syslogs

Confirm row When selected (enabled), Device Manager displays a

deletion confirmation dialog box before you delete a system table row.

Default Read The default Read Community type. Edit this field by highlighting

Community the current value and typing over it.

Default Write The default Write Community type. Edit this field by highlighting

Community the current value and typing over it.
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Area Item Description

Application Application Enabled by default, you can modify this field only when

Control launch with ring configuring the Device Manager default properties. You cannot
tone modify this field when configuring the per device properties.

Save SNMPv3 Disabled by default, if you enable this field you are prompted
Devices to Open | with a security warning message because any user can access
Last the device without entering the SNMPv3 security criteria if

this feature is enabled. If you disable this field, all previously
saved SNMPv3 device data is erased and you are prompted
with a warning message. You can modify this field only when
configuring the Device Manager default properties. You cannot
modify this field when configuring the per device properties.

Http Port Default port is 80. This field specifies the HTTP port for the
application. To access the Device Home Page using the
Web, ensure that the HTTP Port attribute matches the switch
configuration. If you change the port number, the system
prompts you with a warning message.

—End—

To set the Device Manager properties after a device has been accessed:

Step Action
1 From the Device Manager menu bar, choose Device > Properties
> Devices.

The Properties Device List appears.

2 Select Default from the Properties Device List.

3 From the Properties Device List, click Edit.

4 Configure the properties as described in the Default Properties
fields table.

5 Click OK.

—End—

To change the properties settings for a specific device, either before any
devices have been accessed or after a device has been accessed, use
the appropriate procedure and, when the Properties Device List appears,
select an IP address, then click Edit.
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Opening a Switch with the Java Device Manager
To open, or connect, to a switch, you need the following information.

* |P address or DNS name of the desired switch.
*  SNMP community strings that determine access granted to the user.

After you obtain this information from the switch administrator, perform the
following procedure to connect to a switch.

Step Action

1 Start the Java Device Manager as described in the section "Starting
the Java Device Manager" (page 36).

2 Select Open > Device from the JDM menu, or press CTRL+O. The
following dialog box appears.

JDM Open Device dialog box
Drevice Marme: |

Read Community: I ******
‘irite Community: | *******

SMMPw3

[~ w3 Enabled
Lser Marme: I
Context Mame: I (Required far cerbain devices)

Authentication Protacal: INONE VI
Authentication Fassward: I

Privacy: Protocal; INONE vl
Brivacy Passward: I

Open I Fing... | Telnet. .. I Close |

3 Enter the information necessary to connect to the switch. "Open
Device fields" (page 40) describes each field on the Open Device
dialog box.

Open Device fields

Field Description

Device Name Either an IP address or a DNS name for
the device, entered by the user.

Read Community SNMP read community string for the
device. The default value for this field is
public (displayed as ******). The entry is
case-sensitive.

Write Community SNMP write community string for the
device. Default is private (displayed as
*rrxeekk). The entry is case-sensitive.
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e |

Field Description

v3 Enabled When selected, the Open Device dialog
box displays SNMPv3 options.

User Name The name of the user.

Context Name This field does not apply to ERS 4500
devices.

Authentication Protocol The authentication protocol used.

Authentication Password The current authentication password.

Privacy Protocol The privacy protocol used.

Privacy Password The current privacy password.

Not all information is required to connect to a switch. If you do not
select the v3 Enabled check box, only a Device Name, a Read
Community, and a Write Community value are needed. If you
select v3 Enabled, then Device Name, User Name, Authentication
Protocol, Authentication Password, Privacy Protocol, and
Privacy Password are required.

Consult the switch administrator to determine if SNMP version 3 is
used for switch connectivity and administration in the network.

4 Click Open.

—End—

If you enter the correct information, a connection is established with the
switch and a graphical representation is displayed for the switch front panel.
The following figure displays the result of a successful connection to a
Nortel Ethernet Routing Switch 4500 Series 4548-GT-PWR.

4548GT-PWR Front panel view

Device Edk Graph VLAN QoS Rmon Actions Help
EREE® Q| ¢lw Sl
45486;[-EWR
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S el e ] el e e

0 X 8 X o G I [ O [ i 9 o9 9

2 4 13 £ L. - H B ' oW 2 M xE 2m W R M X W40 42 44 46 42 48 42 Comiely

Note: After you successfully connect to a switch, the connection
information is stored. You can make subsequent connections to the
switch from the Device Manager menu. Select Device > Open Last by
SNMPv1/v2 (for connections made using SNMPv1/v2) or Device >
Open Last by SNMPv3 (for connections made using SNMPv3). Select
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the IP address of the switch from the list. Be aware that using Device
> Open Last by SNMPv3 enables any switch user to access SNMPv3
devices.

Device Manager interface components
The Java Device Manager application comprises several user interface
components. This section highlights those components and their use in
the application.

This section contains the following topics:

e "Menu bar" (page 42)

e "Toolbar" (page 43)

« "Device view" (page 44)

e LEDs and ports

e "Shortcut menus" (page 47)

e "Status bar" (page 48)

e "Using the buttons in Device Manager screens" (page 48)
e "Editing objects" (page 49)

¢ "Telnet session to a switch" (page 55)

¢ "Opening an SSH connection to the switch" (page 55)

e "Trap log" (page 55)

« "Accessing the Web-based Management Interface" (page 56)
« "Device Manager Online Help" (page 56)

Menu bar
Use the menu bar to set up and operate Device Manager.

The following table "Menu bar commands" (page 42) describes the Menu
bar commands.

Menu bar commands

Command Description

Device Open a device, refresh the device view, rediscover a
device, and set the polling and SNMP properties. Use this
menu to open and view the Trap Log, SysLog, and Log.
Establish a Telnet or SSH connection to the device that
is currently open.
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Command Description

Edit Open edit dialog boxes for the objects selected in the
device view. Open dialog boxes to manage files and run
diagnostic tests. Configure SNTP, SNMP v3 and related
parameters.

Graph Open statistics dialog boxes for the selected object.

VLAN Open dialog boxes to manage VLANSs, Spanning Tree
Groups, and MultiLink Trunking, and Link Aggregation
Control Protocol.

QoS Open dialog boxes to configure and monitor Quality of
Service or Differentiated Services.

RMON Open dialog boxes to configure RMON: Alarm Manager,
Alarms, and Control.

Actions Open the Home page for the Web-based management
session.

Help Open online Help topics for Device Manager and view a
legend for the port colors in the device view.

See also "Toolbar" (page 43)

Toolbar

The toolbar contains buttons that provide quick access to commonly used
commands and to some additional actions.

"Toolbar buttons" (page 43) The following table describes the toolbar
buttons.

Toolbar buttons

Button Name Description Menu equivalent

=

OpenDevice

Open the Open
Device dialog box.

Device > Open

Refresh Device
Status

Refresh the device
view information.

Device > Refresh
Status

a Web browser.

Telnet Open a Telnet Device > Telnet
—) session.
=) SSH Open a SSH Device > SSH
session. Connection
| @ | Trap Log Open the trap log. Device > Trap Log
®| Help Open online Help in | Help > Device
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Button Name Description Menu equivalent
@l Edit Selected Display configura Edit > Unit
tion data for the Edit > Chassis
selected chassis Edit > Port
object.
m Graph Selected | Open statistics and Graph > Chassis
|_| graphing dialog Graph > Port

boxes for the
selected object.

& Globe Open a Web-based | Actions > Open
e management Home Page
session.
|@| Alarm Open the Rmon Rmon > Alarm
Manager Alarm Manager. Manager
Device view

The device view visually indicates the operating status of the various units
and ports in the hardware configuration. You can also use the device view
to perform management tasks on specific objects.

"Objects in the device view" (page 44) shows an example of a typical device
view.

Objects in the device view
Device  Edk Graph WLAN OoS Rmon  Actions  Help

EREEn o i o=
45486T-EWR

LI A T L - SO N N - - - - S - N - - B T - S - B . ]

I 1 1 R [ R i 63 e e |3 [ 3 3 I

G G [ 1 O 3 o 3 9 9 [ 3 9 o | |

13 £ L. - H B ' 0 2 M ® oM W r M O® W40 42 44 46 42 48 42 Comiely

Selecting objects The types of objects contained in the device view are:

* astand-alone switch (called a unit in the menus and dialog boxes)

e aswitch stack (called a chassis in the menus and dialog boxes)

* aport (in this example, the active port, or port object, is green but the
user can select any port)

See also

"Device view" (page 44)

Selecting a single object To select a single object, click the edge of
the object.
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The yellow outline on the object indicates that you selected it. Subsequent
activities in Device Manager refer to the selected object.

See also
"Device view" (page 44)

Selecting multiple objects To select multiple objects of the same type
(such as ports or switches of the same type), perform one of the following
steps:

» To select a block of contiguous ports, drag the cursor to select the
group of ports.

* To select multiple ports or switches in the stack, Ctrl+click the objects.

To select all the ports in a stand-alone switch or in a switch stack:
e Select Edit.
* Click Select. The Select menu appears.

¢ Select Ports.

To select all the units (switches, but not ports):
* Select Edit.
* Click Select. The Select menu appears.

¢ Select Units.

To select an entire stack:

* Select Edit.

* Click Select. The Select menu appears.
» Select Chassis.

See also
"Device view" (page 44)

LEDs and ports

The color of LEDs in the device view is the same as the colors of the LEDs
on the physical switch. However, the device view does not show blinking
LEDs.

The ports on the device view are colored to show port status.
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The following table "Port color codes" (page 46) shows the status assigned
to each color.

Port color codes

Color Description

Green Port is operating.

Red Port is manually disabled.
Orange Port has no link.

Light Blue Port is in standby mode.

Note: This is not supported on the Nortel Ethernet Routing
Switch 4500 Series.

Dark Blue Port is being tested.

Note: This is not supported on the Nortel Ethernet Routing
Switch 4500 Series.

Gray Port is unmanageable.

Purple Port is in loopback testing mode.

Note: This is not supported on the Nortel Ethernet Routing
Switch 4500 Series.

In addition, the Help menu provides a legend as shown in "Color port
legend" (page 46)that identifies the port colors and their meanings.

Color port legend

*: Device Manager 604b05 - 10.127.232.30 454BGT-PWR

Device Edit Graph YLAN QoS Rmon Actions | Help

SR @ = ol

4548GT-PWR

43 6 N B &
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|

Shortcut menus
Each object in the device view has a shortcut menu that appears when you
right-click the object. The switch shortcut menu provides access to basic
hardware information about the switch and to the graphing dialog boxes for
the switch. An example of this is illustrated in "Switch unit shortcut menu"
(page 47).

Switch unit shortcut menu

= Device Manager 604b05 - 10.127.232.30 454BGT-PWR B

Device Edt Graph YLAN Qo5 Rmon Actions Help

SR ®® Q| Flw Ol

NERTEL

Refresh Port Tooltip
—  Refresh PoE Status

12 H OB B8 20 2 4 ® B8 W RN U

The following table "Switch unit shortcut menu commands" (page 47)
describes the commands on the switch unit shortcut menu.

Switch unit shortcut menu commands

Command Description

Unit # Display the unit number.

Edit Open a read-only dialog box that provides basic hardware
information about the switch.

Show Port Display a pop-up window (tooltip) that contains the name of the

Tooltip port and the port speed when you move the mouse over a port

in the JDM front panel view. By default, Show Port Tooltip is
enabled. Clear the Show Port Tooltip to disable it.

Refresh Port | Refresh the port tooltip information after you assign a new
Tooltip port name to it, or after you reconfigure the port speed. Click
Refresh Port Tooltip to view updated information.

Refresh PoE | Refresh the status of POE ports on the switch (available only on
Status 4500-PWR switches).

The port shortcut menu, as shown in"Port shortcut menu" (page 48)
provides a fast way to edit and graph a single port; however, you can reach
the same options from the menu bar or from the toolbar..
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Port shortcut menu
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The following table "Port shortcut menu commands" (page 48) describes
the commands on the port shortcut menu.

Port shortcut menu commands

Command Descriptions

Edit Open a dialog box that enables you to set operating parameters
for the port.

Graph Open a dialog box that displays statistics for the port; you can
display the statistics as a graph.

Enable Administratively starts a port.

Disable Administratively shuts down a port. The color of the port

changes to red in the device view.

Status bar
The status bar displays errors and messages from the software application.
These messages are not related to the managed device.

Using the buttons in Device Manager screens
The following table "Device Manager buttons" (page 48) describes buttons
in Device Manager screens. Not all buttons appear in all screens.

Device Manager buttons

Button Name Description
Insert Open a dialog box to create a new entry for a
Insert table; and then from the dialog box, insert the
new entry in the table.
_ Copy Copy selected cells from a table.
Paste Paste copied values to a currently selected

EI table cell.
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Button Name Description
Reset Changes Changed (but not applied) fields revert to their
o previous values.
Print Table or Print a table or graph.
& Print Graph
Stop Stop the current action (for example, compiling,
| Stop I saving). If you update or compile a large data

table, the Refresh button changes to a Stop
button while this action takes place. Click the
Stop button to interrupt the polling.

Export Data Export information to a file you specify. You
El can then import this file into a text editor or
spreadsheet for further analysis.

Editing objects
You can edit bjects and values in the Device Manager device view in the
following ways:

* Select an object and, on the toolbar, click the Edit Selected button.

e From a switch or port shortcut menu, choose Edit. The edit screen
appears for that object.

When you change a screen value, the new value is shown in bold. However,
changes are not applied to the running configuration until you click Apply.

Note: Many dialog boxes contain a Refresh button. After you apply
changes to fields, click Refresh to display the new information in the
screen.

Working with statistics and graphs

Device Manager tracks a wide range of statistics for each switch, the stack
(chassis), and each port. You can view and graph statistics for a single
object or multiple objects.

This section describes the available types of statistics and graphs, the graph
dialog boxes, and the procedure to create a graph.

Types of statistics The data tables in the statistics dialog boxes list the
counters, or categories of statistics gathered, for the specified object. For
example, the categories for ports include Interface, Ethernet Errors, Bridge,
and Rmon. Each category can be associated with six types of statistics.
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"Types of statistics" (page 50) The following table describes the types of
statistics shown in the statistics dialog boxes.

Types of statistics

Statistic Description

AbsoluteValue The total count since the last time counters were reset. A
system reboot resets all counters.

Cumulative The total count since the statistics window was first opened.
The elapsed time for the cumulative counter is shown at the
bottom of the graph window.

Average/sec The cumulative count for each polling interval.

Minimum/sec The minimum average for the counter for each polling
interval.

Maximum/sec The maximum average for the counter for each polling
interval.

LastVal/sec The average value for the counter during the previous

polling interval.

Types of graphs With Device Manager, you can create line, area, bar,
and pie graphs. "Line graph" (page 50), "Area graph" (page 51), "Bar graph"
(page 51), and "Pie graph" (page 52) illustrate the various graph styles.

Line graph
%% 134.177.212.24 - Graph Port 1/1 Interfa... [H[=] B4
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Area graph
%a|134.177.212.24 - Graph Port 11 Interfa_.. [H[=] E3
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Bar graph
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Pie graph
"2 134.177.212.24 - Graph Port ... [H[=] B3
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Statistics for single and multiple objects The statistics screens display
statistics for a selected object.

The dialog box for a single object shows all six types of statistics for each
counter (see "Interface statistics for a single port" (page 52)).

Interface statistics for a single port

% 10.127.232.30 - Graph Port 1/1 i | x|
[Tnterface’| Ethernet Errors | Bridge | Rmon | EAPOL Stats | EAPOL Diag | LACP | Misc. |

Absolutevalue | Cumulative | Average/sec | Minimum/sec | Maximum/sec | LastValfsec
InOctets 1,688,111 6,738 192.51 49,73 279.45 222,64
OutOctets 5,035,953 12,269 350.54 103.45 504.82 398.43
InUcastPkks 1,423 13 0.37 0.09 0.55 0.43
OutUcastPkls 37,459 38 1.09 0.73 1.36 1.07
InMulticastPkts 13,310 9 0.26 0.18 0.29 0.29
QutMulticastPkks 35,828 23 0.66 0.57 0.73 0.57
InBroadcastPkts 1,303 0 0 a i} 1]
QutBroadcastPkts 48 1 0.03 i} 0.07 0.07
InDiscards 268 0 0 o i} 0
QutDiscards 28 0 0 i} i} 0
InErrors i} 0 0 i} i} 0
OutErrors 1} 1] 0 0 0 0
InUnknownProtos 1] 0 0 0 0 0

E] @ °| gl @l Clear Countetsl Clusel Help... | Poll Interval: Ilﬂs - Ioday, 00h:00m:35s
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The statistics screen for multiple objects shows a single type of statistics
("Types of statistics" (page 50)) for each selected object. For example,
"Interface statistics for multiple ports" (page 53) shows AbsoluteValue
statistics for the selected ports.

Interface statistics for multiple ports

Irkerface | Ethernet Errors | Bridge | Rmon | EAPOL Stats | EAPOL Disg | LACP | M. |

[ 1mocters | outoctets | nUicastpits | cutiicasties | intuticastpies | OutMaticastpies | InBrosdeastPhts | OutBroadcastPls | inDiscards | outiscards | inErmoes | outErrers [ inUnknowndr
Port: 1)1 | 1,669,...| 3,429,500, 3 47,651 17,381 46,800 2,277 48| 3| 3 0 0
Porti 13 | 9 BLJ 9 of ol 9 of o 0l L ] 9| |
Port: 1/5 | 0 0 0| 0| 0 0 0 0l 0| o, 0 0|
Porti 147 | o 2] 9 i .o 9 9 01 9l ol o 9
Port: 149 | 0 0 0| 0 (]} 0| o 0 0| o o ol

i |
B H] 5] 0]Q] Gl [com] o ot [ oo s o o =

To change the type of statistics displayed, select a different type from the
show list at the bottom right of the screen.

The statistics are updated based on the poll interval shown at the bottom of
the dialog box. You can select a different polling interval.

Buttons for bar, pie, and line graphs are at the bottom of the statistics dialog
box.

You can export statistics to a tab-separated-format file and import the file
into other applications. To export the information, use the Export Data
button below the table.

Viewing statistics as graphs To create a graph for an object:

Step Action
1 Select the object or objects to be graphed.
2 Perform one of the following steps:

* On the toolbar, click Graph Selected.
* From the shortcut menu for the object, choose Graph.

* Select the Graph > Chassis or Graph > Port.command

A statistics dialog box appears with tabs for categories of statistics
for the selected object ("Statistics dialog box for a port" (page 54)).
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Statistics dialog box for a port

inkerface’| Ethernet Errors | Bridge | Rmon | EAPOL Stats | EAPOL Diag | LACP | Misc. |
AbsoluteValue | Cumulative | Averagefsec | Minimumfsec | Maximum/sec | LastVal/sec
InOctets 1,730,590
OutOctets 5,112,697
InUcastPkts 1,49
OutUcastPkts 37,697
InMulticastPkts 13,367
OutMulkicastPkks 35,981
InBroadcastPkts 1,306
OutBroadcastPkts 48
InDiscards 28
OutDiscards 28
InErrors 0
OutErrors 0
InUnknownPratos 1]
m !l El @I Clear Cwntersl Closel Help...l Poll Interval: Ilns vluday, 00h:00m;00s
—

3 Select a tab for the group of statistics to view.

4 On the displayed data table, drag the cursor to select the cells to
graph. (The cells must be in the same row or column.)

5 Click one of the graph buttons at the bottom of the dialog box.
6 To print the graph, click Print.

7 Use the buttons at the top of the graph screen for line, area, and bar
graphs to change the orientation of the graph, to change the scale,
or to change the graph type.

—End—

The following table "Graph dialog box buttons" (page 54) describes the
buttons in the graph dialog boxes.

Graph dialog box buttons

Button Name Description
Stacked Stack data quantities instead of displaying
them side-by-side.

Horizontal Rotate the graph 90 degrees.
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Button Name Description

ml Log Scale Change the scale of the x-axis (of an unrotated
graph) from numeric to logarithmic.

El Line Chart Convert an area graph or bar graph to a line
graph.

Area Chart Convert a line graph or bar graph to an area

ad |
graph.

_” Bar Chart Convert a line graph or area graph to a bar

= graph.

@ Pie Chart Convert a line graph or area graph to a pie
chart.

Telnet session to a switch
From Device Manager, you can initiate a Telnet session to the switch or
stack.

To start a Telnet session to a switch, perform one of the following steps:
¢ From the Device Manager main menu, select Device > Telnet.

* On the toolbar, click Telnet .

Opening an SSH connection to the switch
From the Java Device Manager, you can initiate a Secure Shell (SSH)
connection to the console interface for the switch or stack currently being
accessed.

To open an SSH connection to a switch, perform one of the following steps:
* From the main menu, select Device > SSH Connection.
e On the toolbar, click SSH .

An SSH window to the switch appears.

Note: The SSH connection is established only when the device is
SSH-capable and is enabled.

Trap log
You can configure the Nortel Ethernet Routing Switch 4500 Series to send
SNMP generic traps. When Device Manager runs, the trap log records the
received traps. You can set the maximum number of entries in the trap
log using the Properties screen. The default number of trap log entries is
500. To view the trap log:

e On the toolbar, click Trap Log .

e From the Device Manager Main Menu, select Device > Trap Log.
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Note: When you operate Device Manager from a UNIX platform, log
in as root to receive traps.

Use Export at the bottom of the screen to export trap logs to a file.

Device Manager receives traps on port 162. If another application uses
this port you cannot view the trap log until the other application terminates
and Device Manager restarts.

By default, traps are sent in SNMP V2c format. However, if you use an old
Network Management System (NMS) (one that supports only SNMP v1
traps), traps are sent in v1 format.

Accessing the Web-based Management Interface
You can access the Web-based Management Interface for the Nortel
Ethernet Routing Switch 4500 Series from the Device Manager.

To view the Web-based Management Interface, select Actions > Open
Home Page . The Web browser opens to the Web-based Management
Interface for the switch.

Device Manager Online Help
Online Help in Device Manager is context-sensitive and is displayed in the
default Web browser. The Web browser launches automatically when you
click Help .

The default locations of the Help files are the directories listed in"Help file
locations" (page 56).the following table.

Help file locations

Platform Default path

Windows 95, Windows 98, <JDM Installation directory> /help/
Windows NT, Windows XP botanybay/v500.zip.

and UNIX

After you unzip the file, help.html becomes the
home page for the online Help.

Web-based Management Interface
The Web-based Management Interface is a browser-based application
for switch configuration and management. Unlike the JDM, you need not
install the application because the management interface is an integral
part of the switch.
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To support the Web-based Management Interface, a computer must have
one of the following Web browsers installed:

* Microsoft Internet Explorer 4.0 (or later)

* Netscape Navigator 4.51 (or later)

Accessing the Web-based Management Interface
To access the Web-based Management Interface, first ensure that the
computer and the switch CPU are on the same virtual local area network
(VLAN). Use the CLI and verify the VLAN assignments to confirm that the
VLANS are the same. If the switch and computer are not on the same
VLAN, you cannot access the Web-based Management Interface.

After VLAN verification occurs, you can access the Web-based Management
Interface by performing the following procedure.

Step Action
1 Open a Web browser window.
2 Type the IP address of the switch or stack in the Address field of

the Web browser in the form http://<switch IP address>, and press
Enter. For example, if the switch or stack IP address is 10.30.31.105,
then enter http://10.30.31.105 in the Address field. You can obtain
the IP address of the switch or stack from the switch administrator.

3 If applicable, enter the user name and password to gain access to
the switch or stack. The user name is static and depends on the
type of access required or assigned. For read-only access, the user
name is RO and for read/write access it is RW. These user names
are case-sensitive. You can obtain the password from the switch
administrator.

4 If all information is correct, the main switch page appears. The
following figure displays an example of the main switch page for a
Nortel Ethernet Routing Switch 4500 Series 4548-GT-PWR.

Nortel Ethernet Routing Switch 4500 Series
Overview — System Configuration
NN47205-500 02.01 Standard
5.0 23 February 2007
Copyright © 2007, Nortel Networks Nortel Networks Confidential



58 4500 Series user interfaces

4548-GT-PWR Main Page

NQRTEL Administration > System Information q

Ethernet Routing Switch 4548GT-PWR

Access (RW)

> Summal .. Ethemet Routing Switch 4548GT-PWR HW:0A FW:1.0.0.14
> Co m;gurr:uon sysDescription G2 0 083 B3 (c) Mortel Networks
> Fault sysUpTime 16 Hours 34 Minutes 33 Seconds
> Statistics sysContact
3 Applications sysName  4543GT-PWR
¥ Administration

& System Information sysLocation

@ Guick Start

> Security

#* Logout

/¥ Resst

#¥ Reset To Default
> Support

CopyrghtT 06 Hortel , Inc. Allrights reserved.

—End—

Web-based Management Interface layout
The main page in the Web-based Management Interface and all subsequent
pages have a common layout. Each page is divided into two sections: the
menu and the management page.

Menu

The menu contains the main units of work that you can perform through
the Web-based Management Interface and their corresponding options.
Some options are available only when the switch is part of a stack
configuration; the options are not displayed when the switch is in a
stand-alone configuration. To navigate the menu, click a main header.
The corresponding options appear beneath. Click an option to display the
associated management page.

"Web-based Management Interface menu options" (page 58) lists the
Web-based Management Interface menu options.

Web-based Management Interface menu options

Main Heading Options Description

Summary Stack Information* View information about the
current state of the individual
switch or stack.

* These options are available only when the switch is part of a stacked
configuration.

** These options have additional associated options.

Switch Information
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Main Heading Options Description

Identify Unit Numbers*

Stack Numbering*

Configuration IP Configure aspects of the
System switch or stack operation.
Remote Access
SNMPv1

SNMPv3**

SNMP Trap

MAC Address

Find MAC Address

Port Management

High Speed Flow Control
Software Download
Ascii Config Download
Configuration File

Fault RMON Threshold Configure fault thresholds and
RMON Event Log view event logs.

System Log

Statistics Port View statistics for a variety of
Port Error Summary switch functions.

Interface

Ethernet Errors
Transparent Bridging
RMON Ethernet
RMON History

* These options are available only when the switch is part of a stacked
configuration.
** These options have additional associated options.
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Main Heading Options Description

Applications Port Mirroring Configure and manage a
Rate Limiting variety of switch applications.
EAPOL Security

MAC Address Security**
IGMP**

VLAN**

Spanning Tree**
Multilink Trunk**

Link Aggregation**
QoS

Administration System Information Configure and manage
Quick Start administrative items.

Security**

Logout
Reset

Reset to Default

Support Help Access the various support
facilities, such as Help,
manuals, and switch upgrade
Manuals procedures.

Release Notes

Upgrade

* These options are available only when the switch is part of a stacked
configuration.
** These options have additional associated options.

CAUTION

Nortel recommends that you use the navigation tools in the
interface instead of those in the Web browser, such as page
forward, page back, and page refresh. Web browser functions do
not enhance the use of the interface and can interfere with the
logical navigation of the Web-based Management Interface.
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The menu of the Web-based Management Interface contains several iconic
cues to the type and operation of the menu options. "Menu icons" (page
61) describes the icons that appear in the menu.

Menu icons
Icon Description
> This icon identifies a collapsed menu title. Click the icon to
expand the menu and view all associated options.
This icon identifies an expanded menu title. All options
v associated with the menu title are displayed underneath.

Click the icon to collapse the menu and hide all associated
options.

This icon identifies a menu option. Click the icon to see the
management page associated with this menu option.

This icon identifies a menu option with a hyperlink to
related pages. Click the icon to see the management
page associated with this menu option and any related
hyperlinks.

L]

This icon identifies a menu option associated with an
7 action. Actions have no associated management page and
take place immediately.

This icon is a link to the Nortel corporate home page. Click
 NEYRTEL | this icon to open a new Web browser window and load the
Nortel corporate home page.

Management Page

The Management Page, as illustrated in Web-based Management Interface
layout, is the main work area in the Web-based Management Interface. As
you select various items and options, the associated Management Page
loads. "Quick Start Management page" (page 62) illustrates the Quick Start
Management Page that you access by selecting Administration > Quick
Start.
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Quick Start Management page
Administration > Quick Start

IP
| Configurable ]| _InUse |

In-Band Subnet Mask
Default Gateway

In-Band Stack IP Address | 192.1658.248.206 | 192.168.248.206

255.255.255.0 255.265.255.0

192.168.248.1 192.168.248.1

Community String

Read-Only Community 5tring eesesssssscscse

Read-Write Community String sesesesenecscre

Trap Receiver

IP Address

Index]
;
2

3
4

0.0.0.0
0.0.0.0
0.0.0.0
0.0.0.0

VLAN

Quick Start VLAN

Copyright © 2007, Nortel Networks

Every Management Page comprises one or more of the following elements:

Display Field

Display fields show preexisting values or statistical information. Display
fields have a gray background and are read-only. If the data in the
field is highlighted blue and is underlined, it is a hyperlink to a related
Management Page.

Input Field

Use input fields to enter or change information. Input fields have a white
background and are editable.

Check Box

Use check boxes to change data on the switch that exists in either an on
or off state. When a check box displays a check mark, that data item

is enabled (on); otherwise, it is disabled (off). Click in the check box to
enter a check mark or to remove a check mark.

Icons and Buttons

Icons and buttons on a Management Page represent the actions that
you can perform . Click the icon or button to initiate the associated
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action. "Management Page icons and buttons” (page 63) describes the
main icons and buttons that can appear on a Management Page.

Management Page icons and buttons

Icon / Name Description
Button
Submit Submit entered information to the switch. If
this button is present, ensure that you click it
every time you enter new information on the
Management Page.
Modify Open a modification page for the data row in
[E .
which the button appears.
View Open a read-only statistics page for the data
Je) . .
row in which the button appears.
X Delete Delete the data row in which the button
appears.
a Help Open Help for the current Management Page
in a new Web browser window.
Context-sen Open Help for the current data item in a new
[ . .
sitive Help Web browser window.
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Basic configuration tasks

This chapter outlines basic configuration tasks that you can perform on

a Nortel Ethernet Routing Switch 4500 Series. After you successfully
install a switch, you can perform the following tasks to enable basic switch
functionality.

This chapter contains the following topics:

« "Factory default configuration" (page 65)

e "Setting user access limitations" (page 71)

e "Updating switch software" (page 81)

e "Setting TFTP parameters" (page 89)

*  "Working with configuration files" (page 90)

* "Terminal setup” (page 103)

» Setting the default management interface

e "Setting Telnet access" (page 104)

» "Setting server for Web-based management” (page 106)
» "Setting boot parameters" (page 107)

« "Defaulting to BootP-when-needed" (page 108)

* "Customizing the CLI banner" (page 110)

» "Displaying complete GBIC information" (page 114)
« "Displaying hardware information" (page 114)

* "Shutdown command" (page 114)

e "CLI Help" (page 117)

Factory default configuration
When you initially access a newly installed switch or you reset a switch to
factory defaults, the switch is in a factory default configuration. This factory
default configuration is the base configuration from which you build the
switch configuration.
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"Factory default configuration settings" (page 66) outlines the factory default

configuration settings present in a switch in a factory default state.

Factory default configuration settings

Setting Factory default configuration value
Unit Select switch non-Base
Unit 1

BootP Request Mode

BootP When Needed

In-Band Stack IP Address

0.0.0.0 (no IP address assigned)

In-Band Switch IP
Address

0.0.0.0 (no IP address assigned)

In-Band Subnet Mask

0.0.0.0 (no subnet mask assigned)

Default Gateway

0.0.0.0 (no IP address assigned)

Read-Only Community
String

public

read/write Community
String

private

Trap IP Address

0.0.0.0 (no IP address assigned)

Community String

Zero-length string

Find an Address

Select VLAN ID [1]

Authentication Trap Enabled
Autotopology Enabled
sysContact Zero-length string
sysName Zero-length string
sysLocation Zero-length string
Aging Time 300 seconds

00-00-00-00-00-00 (no MAC address assigned)

Detected:

MAC Address Security Disabled
MAC Address Security .

SNMP-Locked Disabled
Partition Port on Intrusion Disabled

Partition Time

0 seconds (the value 0 indicates forever)

DA Filtering on Intrusion
Detected:

Disabled

Generate SNMP Trap on
Intrusion

Disabled
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Setting Factory default configuration value
Clear by Ports NONE

Learn by Ports NONE

Current Learning Mode Not Learning

Trunk blank field

Security Disabled

Port List blank field

Find an Address blank field

MAC Address 00-00 00-00 -00-00

Allowed Source - (blank field)

Display/Create MAC
Address

00-00-00-00-00-00

Create VLAN 1

Delete VLAN blank field
VLAN Name VLAN #
Management VLAN Yes (VLAN #1)
VLAN Type Port-based
Protocol ID (PID) None
User-Defined PID 0x0000

VLAN State Active (VLAN #1)

Port Membership All ports assigned as members of VLAN 1
Unit 1

Port 1

Filter Untagged Frames No

EirI;enr]eLSJnregistered ves

Port Name Unit 1, Port 1

PVID 1

Port Priority 0

Tagging Untag All

AutoPVID Enabled

Unit 1

Port 1

PVID 1 (read only)

Port Name Unit 1, Port 1 (read only)
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Setting Factory default configuration value
Unit 1

Status Enabled (for all ports)

Linktrap On

Autonegotiation Enabled (for all ports)

Speed/Duplex (Refer to Autonegotiation)

Trunk 1 to 6 (depending on configuration status)
(TL:Lr‘]?t'/‘Pg"rf)mbers Blank field

STP Learning Normal

Trunk Mode Basic

Trunk Status Disabled

Trunk Name Trunk #1 to Trunk #6

Traffic Type Rx and Tx

Port 1

Monitoring Mode Disabled

Monitor/Unit Port

Zero-length string

Unit/Port X Zero-length string

Unit/Port Y Zero-length string

Address A 00-00-00-00-00-00 (no MAC address assigned)
Address B 00-00-00-00-00-00 (no MAC address assigned)
Rate Limit Packet Type Both

Limit None

VLAN 1

Snooping Disabled

Proxy Disabled

Robust Value 2

Query Time

125 seconds

Set Router Ports

Version 1

Static Router Ports

- (for all ports)

Multicast Group
Membership screen

Unit 1
Port 1
Console Port Speed 9600 baud
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Switch Password

Setting Factory default configuration value
Console Switch Password | None
Console Stack Password None
Telnet/Web Stack

None
Password
Telnet/Web Switch

None
Password
Console Read-Only

user

Console Read/Write
Switch Password

Passwords are user/secure for non-SSH SW
images and userpasswd/securepasswd for SSH
SW images.

Console Read-Only Stack

Password user
Console Read/Write secure
Stack Password

Radius password/server secret

New Unit Number

Current stack order

Renumber units with new

setting? No

Group 1

Bridge Priority 8000
Bridge Hello Time 2 seconds
_?irri:é;e Maximum Age 20 seconds
Bridge Forward Delay 15 seconds
Add VLAN Membership 1

Tagged BPDU on tagged
port

STP Group 1--No
Other STP Groups--Yes

STP Group State

STP Group 1--Active
Other STP Groups--InActive

VID used for tagged

4001-4008 for STGs 1-8, respectively

BPDU

STP Group 1

Participation Normal Learning
Priority 128

Path Cost 1

STP Group 1
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Setting Factory default configuration value
STP Group 1

By default, SNMP access is disabled in the SSH
image and enabled in the non-SSH image. Telnet
TELNET Access/SNMP/ and Web are enabled by default in both SSH and
Web non-SSH images.

Use list: Yes

Login Timeout 1 minute
Login Retries 3

Inactivity Timeout 15 minutes
Event Logging All

Allowed Source IP
Address

First field: 0.0.0.0 (no IP address assigned)

(50 user-configurable
fields)

Remaining 49 fields: 255.255.255.255 (any
address is allowed)

Allowed Source Mask(50

user-configurable fields) First field: 0.0.0.0 (no IP address assigned)

Remaining 49 fields: 255.255.255.255 (any
address is allowed)

Image Filename Zero-length string

Diagnostics image
filename

TFTP Server IP Address 0.0.0.0 (no IP address assigned)

Start TFTP Load of New
Image

Zero-length string

No

Configuration Image Zero-length string

Filename
Copy Configuration
No
Image to Server
Retrieve Configuration No

Image from Server

ASCII Configuration
Filename

Zero-length string

Retrieve Configuration

file from Server No
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Setting Factory default configuration value
Auto Configuration on Disabled
Reset

EAPOL Security Disabled
Configuration

High Speed Flow Control
Configuration

VLAN Configuration Strict
Control

Agent Auto Unit Enabled
Replacement

Setting user access limitations
By default, a 4500 Series switch has no access limitations configured. This
section illustrates how to set user access limitations on the switch. User
access limitations are an important facet of switch security that you must be
aware of during the initial configuration .

For more information about switch user interfaces, consult "4500 Series
user interfaces" (page 19).

This section describes the following procedures to set user access
limitations:

e "Setting user access limitations using the CLI" (page 71)

e " Setting user access limitations using the Web-based Management
Interface" (page 75)

Setting user access limitations using the CLI
The administrator can use the CLI to limit user access by creating and
maintaining passwords for Web, Telnet, and Console access. This is a
two-step process that requires that you first create the password and then
enable it.

Ensure that Global Configuration mode is entered in the CLI before you
start these tasks.

Setting the read-only and read/write passwords

The first step to requiring password authentication when the user logs in to
the switch is to edit the password settings. To complete this task, perform
the following steps:
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Step Action

1 Access the CLI through the Telnet protocol or a Console connection.
For detailed information about this subject, see "Accessing the CLI"
(page 19).

2 From the command prompt, use the ¢1i password command to

change the desired password.
cli password {read-only | read-write} <password>

"cli password parameters” (page 72) explains the parameters for
the cli password command.

cli password parameters

Parameter Description

This parameter specifies if the password
{read-only | read-write} change is for read-only access or
read/write access.

If password security is disabled, the
length can be 1-15 chars. If password
security is enabled, the range for length
is 10-15 chars.

<password>

3 Press Enter.

—End—

Enabling and disabling passwords

After you set the read-only and read/write passwords, you can individually
enable or disable them for the various switch-access methods. To enable
passwords, perform the following task.

Step Action

1 Access the CLI through the Telnet protocol or a Console connection.
For detailed information about this subject, see "Accessing the CLI"
(page 19).

2 From the command prompt, use the ¢1i password command to
enable the desired password.
cli password {telnet | serial} {none | local | radius
| tacacs}
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"cli password parameters” (page 73) explains the parameters for
the cli password command.

cli password parameters

Parameter Description

Specify whether the password is enabled
or disabled for Telnet or the console.
Telnet and Web access are connected so
that enabling or disabling passwords for
one enables or disables passwords for
the other.

{telnet | serial}

Specify whether the password is to be
disabled (none), whether the password
to be used is the locally stored password
created in "Setting the read-only and
read-write passwords" (page 71), or
whether RADIUS authentication is used.

{none | local | radius}

3 Press Enter.

—End—

Configuring RADIUS authentication

The Remote Authentication Dial-In User Service (RADIUS) protocol is a
means to authenticate users through a dedicated network resource. This
network resource contains a list of eligible user names and passwords and
their associated access rights. When RADIUS is used to authenticate
access to a switch, the user supplies a user name and password and this
information is checked against the existing list. If the user credentials are
valid they can access the switch.

If you select RADIUS Authentication when you set up passwords through
the CLI, you must specify the RADIUS server settings to complete the
process. Ensure that you enter Global Configuration mode in the CLI
before you start this task.

To enable RADIUS authentication through the CLI, follow these steps.

Step Action

1 Access the CLI through the Telnet protocol or a Console connection.
For detailed information about this subject, see "Accessing the CLI"
(page 19) .

2 From the command prompt, use the radius-server command

to configure the server settings.
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3

radius-server host <address> [secondary-host <address>]
port <num> key <string> [password fallback] timeout

"radius-server parameters" (page 74) explains the parameters for
the radius-server command.

radius-server parameters

Parameter Description

The IP address of the RADIUS server that is
used for authentication.

host <address>

The secondary-host <address> parameter is
[secondary-host optional. If you specify a backup RADIUS
<address>] server, include this parameter with the IP
address of the backup server.

The UDP port number the RADIUS server
uses to listen for requests.

port <num>

A secret text string that is shared between
the switch and the RADIUS server. Enter
the secret string, which is a string up to 16
characters in length.

key <string>

An optional parameter that enables the

[password fallback] password fallback feature on the RADIUS
server. This option is disabled by default.
timeout The RADIUS timeout period.

Press Enter.

—End—

Related RADIUS Commands When you configure RADIUS
authentication, three other CLI commands are useful to the process:

Step

Action

1

show radius-server

The command has no parameters and displays the current RADIUS
server configuration.

no radius-server

This command has no parameters and clears any previously
configured RADIUS server settings.
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3 radius-server password fallback

This command has no parameters and enables the password
fallback RADIUS option if it you did not set the option when you
initially configured the RADIUS server.

—End—

Setting user access limitations using the Web-based Management
Interface
The administrator can use the Web-based Management Interface to limit
user access by creating and maintaining passwords for Web, Telnet, and
Console access. The following sections describe how to perform the
procedures:

e "Setting the Web password" (page 75)

e "Setting the Telnet password" (page 77)

e "Setting the Console password" (page 78)

¢ "Configuring RADIUS authentication" (page 80)

Setting the Web password

To require password authentication when the user logs on to the switch
through the Web-based Management Interface, you must edit the Web

password. To do this, select Administration > Security > Web from the
main menu and perform the following procedure.

Step Action

1 From the Web Switch Password Type list, select the password type.
Three options are available in the Web Switch Password Type list:

* None

Users who access the switch through the Web-based
Management Interface require no password.

CAUTION

Using None means that any user who knows the IP
address of the switch and the appropriate network
access can change the switch configuration.

e Local Password

The user must enter a password that determines their individual
access rights. These passwords are configured in steps 2 and 3
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of this procedure. These passwords must be 1 to 15 characters
in length.

RADIUS Authentication

A RADIUS server on the local area network authenticates
the user. For information about configuring the parameters
for RADIUS server authentication, see "Configuring RADIUS
authentication" (page 80).

2 If you selected the Local Password option in step 1, specify a
password to grant read-only access to the switch in the Read-Only
Switch Password field.

3 If you selected the Local Password option in step 1, specify a
password to grant read/write access to the switch in the read/write
Switch Password field.

Note: A value of None or RADIUS Authentication in the
Web Switch Password Type list always overrides the values
in the Read-Only Switch Password and read/write Switch
Password fields.

4 Click Submit.

Note: You cannot change Web Stack Password settings on this
screen; the settings are for information only. For procedures to
change this password, see "Setting user access limitations using
the CLI" (page 71).

—End—

"Web Password Management page" (page 76) shows an example of
the Web Password Management Page in the Web-based Management

Interface.

Web Password Management page

Becess W)
> Summary
> Configurston
> Faull
> Stalislics
> Agpikcatons
W Agrinigtrabon
& System Information
& Guick Start
¥ Socusity
@ Wb
& Telnet
@ Congole
# RADIUE
* Logout
/F Fesel

Administration > Security > Web

Web Switch Password Setting
Web Switch Password Type
Read Only Switch Password user

Read Write Switch Password secue

Web Stack Password Senting

Web Stack Passwond Type None
Read-Only Stack Password user
Fead Write Stack Password secure

Copyright © 2007, Nortel Networks
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Setting the Telnet password

To require password authentication when the user logs into the switch
through the Telnet protocol, you must edit the Telnet password. Select
Administration > Security > Telnet from the main menu and perform the
following procedure.

Step Action

1 Select the password type from the Telnet Switch Password Type
list. Three options are available in the Telnet Switch Password
Type list:
* None

Users who access the switch through the Telnet protocol require
no password.

CAUTION

Using None means that any user who knows the IP
address of the switch and the appropriate network
access can change the switch configuration.

e Local Password

The user must enter a password that determines their individual
access rights. These passwords are configured in Steps 2 and 3
of this procedure. These passwords must be 1 to 15 characters
in length.

« RADIUS Authentication

A RADIUS server on the local area network authenticates
the user. For information about configuring the parameters
for RADIUS server authentication, see "Configuring RADIUS
authentication" (page 80).

2 If you selected the Local Password option in Step 1, specify a
password to grant read-only access to the switch in the Read-Only
Telnet Password field.

3 If you selected the Local Password option in Step 1, specify a
password to grant read/write access to the switch in the Read/Write
Telnet Password field.

Note: A value of None or RADIUS Authentication in the Telnet
Switch Password Type list always overrides the values in the
Read-Only Telnet Password and Read/Write Telnet Password
fields.
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4 Click Submit.

Note: You cannot change the Telnet Stack Password settings
on this screen; the settings are for information only. For
procedures to change this password, see "Setting user access
limitations using the CLI" (page 71).

—End—

"Telnet Password Management page" (page 78) shows an example of
the Telnet Password Management Page in the Web-based Management
Interface.

Telnet Password Management page

NERTEL Administration > Security > Telnet

Telnet Switch Password Setting
Access (RW)
> Summary
> Configuration Read.Only Switch Password |user
> Fault . .
> Statistics Read-Write Switch Password secure
> applications
¥ Administration
& Systern Infarmation Telnet Stack Password Setting
< Quick Start Telnet Stack Password Type None
¥ Security Read-Only Stack Password  user
4 Web Read Wiite Stack Password secure
@ Telnet
+ Console
& RADIUS " Submit
7+ Logout
¥ Reset

Telnet Switch Password Type | None

Setting the Console password

To require password authentication when the user logs in to the switch
through the Console, you must edit the Console password. Select
Administration > Security > Console from the main menu and perform
the following procedure.

Step Action

1 Select the password type from the Console Switch Password Type
list. Three options are available in the Console Switch Password
Type list:
* None

Users who access the switch through the Console require no
password.
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CAUTION

Using None means that any user with access to a
switch Console connection can change the switch
configuration.

e Local Password

The user must enter a password that determines their individual
access rights. These passwords are configured in steps 2 and
3 of this procedure. These passwords must be from 1 to 15
characters in length.

« RADIUS Authentication

A RADIUS server on the local area network authenticates
the user. For information about configuring the parameters
for RADIUS server authentication, see "Configuring RADIUS
authentication" (page 80).

2 If you selected the Local Password option in step 1, specify a
password to grant read-only access to the switch in the Read-Only
Console Password field.

3 If you selected the Local Password option in step 1, specify a
password to grant read/write access to the switch in the Read/Write
Console Password field.

Note: A value of None or RADIUS Authentication in the
Console Switch Password Type list always overrides the
values in the Read-Only Console Password and Read/Write
Console Password fields.

4 Click Submit.

Note: You cannot change the Console Stack Password
settings on this screen; the settings are for information only. fFor
procedures to change this password, see "Setting user access
limitations using the CLI" (page 71).

—End—

"Console Password Management page" (page 80) shows an example of
the Console Password Management Page in the Web-based Management
Interface.
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Console Password Management page

NERTEL Administration > Security > Console

Console Switch Password Setting
Access (RW)
> Summary
> Configuration Read-Only Switch Password user
> Fault
> Ctatistics Read-Write Switch Password  secure
> ppplications
¥ administration
& System Information Consele Stack Passwond Setiing
<+ Quick Start Consele Stack Password Type None
¥ Security Read-Only Stack Password  user

* Web Read Write Stack Password  secure
& Telnet

+ Console

& RADIUS " submit
7 Logout
7 Rogel

Console Switch Password Type MNone

Configuring RADIUS authentication

The RADIUS protocol provides a way to authenticate users by using a
dedicated network resource. This network resource contains a list of eligible
user names and passwords and their associated access rights. When you
use RADIUS to authenticate access to a switch, the user supplies a user
name and password and this information is checked against the existing list.
If the user credentials are valid, the user can access the switch.

If you selected RADIUS Authentication for any of the switch authentication
options in the previous three sections, you must specify the RADIUS
server settings to complete the process. To set the RADIUS Authentication
parameters, select Administration > Security > RADIUS and perform the
following procedure.

Step Action

1 In the Primary RADIUS Server field, type the IP address of the
primary RADIUS server that is used for user authentication.

2 In the Secondary RADIUS Server field, type the IP address of a
secondary RADIUS server that is used as a backup for the primary
server.

3 In the UDP RADIUS Port field, type the UDP port number the
RADIUS servers that is used to listen for RADIUS authentication
requests.

4 In the RADIUS Timeout Period field, type the number of seconds (1

to 60) to specify the timeout period.

5 In the RADIUS Shared Secret field, type the password that the
RADIUS server requires to authenticate a valid RADIUS request.
This password is 1 to 16 characters in length.
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6

Click Submit.

—End—

"RADIUS Authentication Management page" (page 81) displays the RADIUS
Authentication Management Page in the Web-based Management Interface.

RADIUS Authentication Management page

Administration > Security > RADIUS q

RADIUS Authentication Setting

Primary RADIUS Server 0000
Secondary RADIUS Server [00.00
UDP RADIUS Port 1812

RADIUS Timeout Peried |2 saconds

RADIUS Shared Secret
[Fie-enter fo werly

" Submit_]

Updating switch software
Updating switch software is a necessary part of switch configuration and
maintenance. You can update the version of software running on the switch
through either the Web-based Management Interface, Device Manager
(JDM) or the CLI.

Before you attempt to change the switch software, ensure that the following
prerequisites are in place:

The switch has a valid IP address.

A Trivial File Transfer Protocol (TFTP) server is on the network that is
accessible by the switch and that has the desired software version
loaded.

If you change the switch software on a Nortel Ethernet Routing Switch
4500 Series 4548-GT-PWR using a USB Mass Storage Device, ensure
that the Mass Storage Device has the desired software version and is
inserted into the front panel USB port.

If you use the CLI, ensure that the CLI is in Privileged EXEC mode.
If you use the Device Manager, ensure that SNMP is enabled.

If you use the Web-based Management Interface, ensure that you
useread/write access.
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For details about updating switch software, see the following sections:

* "Changing switch software in the CLI" (page 82)

¢ "Changing switch software in the Java Device Manager" (page 84)

¢ "Changing switch software in the Web-based Management Interface"
(page 87)

e "LED activity during software download" (page 89)

Changing switch software in the CLI
To change the software version that runs on the switch using the CLI,
perform the following procedure.

Step

Action

1

Copyright © 2007, Nortel Networks

Access the CLI through the Telnet protocol or through a Console
connection. For detailed information about this subject, see
"Accessing the CLI" (page 19).

From the command prompt, use the download command with the
following parameters to change the software version:

download [address <ip>] {image <image name> |
image-if-newer <image name> | diag <image name> |
poe module image <image name>} [no-reset] [usb]

"download parameters" (page 82) explains the parameters for the
download command.

download parameters

Parameter Description

The IP address of the TFTP server you use.
The address <ip> parameter is optional
and if you omit it, the switch defaults to the
TFTP server specified by the tftp-server
command unless software download is to
occur using a USB Mass Storage Device.

address <ip>

The name of the software image to be

Image <image name> downloaded from the TFTP server.

This parameter is the name of the software
image-if-newer <image | image to be downloaded from the TFTP
name> server if it is newer than the currently running
image.

The image, image-if-newer, diag, and poe module image
parameters are mutually exclusive; you can execute only one at a time.

The address <ip> and usb parameters are mutually exclusive; you can
execute only one at a time.
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Parameter Description

The name of the diagnostic image to be

diag <image name> downloaded from the TFTP server.

The name of the Power over Ethernet module
image to be downloaded from the TFTP
server. This option is available only for 4500
Series switches that support Power Over
Ethernet.

poe_module_image
<image name>

This parameter forces the switch to not reset
after the software download is complete.

In the Nortel Ethernet Routing Switch 4500
Series switch, this parameter specifies that
usb the software download is performed using
a USB Mass Storage Device and the front
panel USB port.

no-reset

The image, image-if-newer, diag, and poe module image
parameters are mutually exclusive; you can execute only one at a time.

The address <ip> and usb parameters are mutually exclusive; you can
execute only one at a time.

3 Press Enter.

—End—

The software download occurs automatically without user intervention. This
process deletes the contents of the flash memory and replaces it with the
desired software image. Do not interrupt the download. Depending on
network conditions, this process make take up to 10 minutes.

When the download is complete, the switch automatically resets unless you
used the no-reset parameter. The software image initiates a self-test
and returns a message when the process is complete. An example of this
message is illustrated in "Software download message output" (page 83).

Software download message output

Download Image [/]

Saving Image [-]

Finishing Upgrading Image

During the download, the switch is not operational.
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You can track the progress of the download by observing the front panel
LEDs. For more information about this topic, see "LED activity during
software download" (page 89).

Changing switch software in the Java Device Manager
To change the software version running on the switch that uses the Java
Device Manager, perform the following procedure.

Step Action

1 Connect to the switch using the Java Device Manager (JDM). For
specific information about this topic, see "Opening a Switch with the
Java Device Manager" (page 40).

2 From the JDM menu, select Edit > File System.

The File System screen appears, as shown in "Java Device Manager
File System screen” (page 84).

Java Device Manager File System screen

. 192.167.120.43 - FileSystem Xl

Config/Image/Diag file | Asci Confia File | Save Configuration |

LoadServeraddr: |192.16?. 120,13

BinaryConfigFilenarne: |4548c0nFig.txt

ImageFileMame: Ibotanybay_SEle.img

FrFileMamnel Diagniostics): |

UsbTargetUnit: ID_ 0..9 {1-8=ush in stack, 9=ush in standalone unit, 0=tftp server)

(" other = dnldCanfig " upldConfig

" dnldConfigFromUsh ¢ wpldConfigTolsk ¢ dnidImg
Action:
= dnldImgIfewer ~ dnldimgioReset ¢ dnidImaFromllsh

" dnldFw " dnldFwhoReset " dnldFwFromlsb

Status: ather

P'DD|Y| Refreshl Closel Help...l

3 Select the Config/Image/Diag file tab if it is not already selected.

4 Specify the information necessary to perform the download. "File
System screen fields" (page 84) outlines each field on this screen.

File System screen fields

Field Description
The IP address of the TFTP server on which
LoadServerAddr the new software images are stored for
download.
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Field Description

The binary configuration file currently
associated with the switch. Use this field
when you work with configuration files; do not
use this field when you download a software
image. For further information, see "Working
with configuration files" (page 90).

BinaryConfigFileName

The name of the image file currently
associated with the switch. If needed, change
this field to the name of the software image to
be downloaded.

ImageFileName

The name of the diagnostic file currently
FwFileName associated with the switch. If needed, change
(Diagnostics) this field to the name of the diagnostic
software image to be downloaded.

Indicates the unit number of the USB port to

UsbTargetUnit be used to upload or download a file.

Action This group of options represent the actions
taken during this file system operation. The
options applicable to a software download are

* dnldimgFromUsb: Download a new
software image to the switch using
the front panel USB port. This option
replaces the image regardless of whether
itis newer or older than the current image.

* dnldimglfNewer: Download a new
software image to the switch only if it is
newer than the one currently in use.

* dnldFw: Download a new diagnostic
software image to the switch. This option
replaces the image regardless of whether
it is newer or older than the current image.

* dnldConfig: Download a configuration to
the switch.

» dnldConfigFromUsb: Download a
configuration to switch using the front
panel USB port.

* dnldimgNoReset: Download a new
software image to the switch. This option
replaces the software image on the
switch regardless of whether it is newer
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Field Description

or older than the current image. After the
download is complete, the switch is not
reset.

* dnldFwNoReset: Download a new
diagnostic software image to the switch.
This option replaces the image regardless
of whether it is newer or older than the
current image. After the download is
complete, the switch is not reset.

* upldConfig: Upload a configuration to the
switch from a designated location.

* dnldimg: Download a new software
image to the switch. This option replaces
the software image on the switch
regardless of whether it is newer or older
than the current image.

* dnldimgFromUsb: Download a new
software image to the switch using the
front panel USB port.

* dnldFwFromUsb: Download a new
diagnostic software image to the switch
from the front panel USB port. This
option replaces the image regardless
of whether it is newer or older than the
current image.

Note: For information about additional
options, see "Working with configuration files"
(page 90).

Status Display the status of the last action that
occurred since the switch last booted. The
values that are displayed are

» other: No action occurred since the last
boot.

* inProgress: The selected operation is in
progress.

» success: The selected operation
succeeded.

» fail: The selected operation failed.
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5 Click Apply.

—End—

The software download occurs automatically after you click Apply. This
process erases the contents of flash memory and replaces it with the new
software image. Do not interrupt the download. Depending on network
conditions, this process can take up to 10 minutes. When the download
is complete, the switch automatically resets and the new software image
initiates a self-test. During the download, the switch is not operational.

Changing switch software in the Web-based Management Interface
To change the software version running on the switch that uses the
Web-based Management Interface, perform the following procedure.

Step Action

1 Log in to the Web-based Management Interface. For specific
information about this topic, see "Accessing the Web-based
Management Interface" (page 57).

2 Navigate to the Software Download Management page by selecting
Configuration > Software Download .

The Software Download Management page appears, as shown in "
Software Download Management page" (page 87).

Software Download Management page

Configuration > Software Download q

Software Dowmiosd Seting

Current Running Version ¥5.00083

Local Store Version £0.0083
Diagnostcs image Fiersme |
Select Target TFTP Server =

TFIP SorveriP Address  [10.127.125.101 oo oo
St TFTP Losd of New bmage [0 =]

Access (RW)
-

> SNMPVY
@ SHMP Trap
# MAC Addreas

@ Find MAL Address
# Port Management
@ High Speed Flow Cantrol

@ Configurasion File

Nortel Ethernet Routing Switch 4500 Series
Overview — System Configuration
NN47205-500 02.01 Standard
5.0 23 February 2007
Copyright © 2007, Nortel Networks Nortel Networks Confidential



88 Basic configuration tasks

3 Specify the information needed to complete the software download
procedure. "Software download page fields" (page 88) outlines each
field on this page.

Software download page fields

Field Description
Current Running The version of software currently running on
Version the switch.

Local Store Version

The version of software currently stored in
flash memory.

Software Image File
Name

The name of the software image to be
downloaded to the switch. This field is
optional if you perform a diagnostics image
download only. The field is 1 to 30 characters
in length.

Diagnostics Image File
Name

The name of the diagnostics image to be
downloaded on to the switch. This field is
optional if you perform a software image
download only. The field is 1 to 30 characters
in length.

Select Target

The target from which the software images
are downloaded. Select either TFTP Server
or USB as the download target.

TFTP Server IP

The IP address of the TFTP Server to be

Copyright © 2007, Nortel Networks

Address used in the software download.
Start TFTP Load of The type of software download to perform.
New Image Select the appropriate option from the list:

* No: Perform no software download.

» Software Image: Perform a download
of the software image specified in
the Software Image File Name field
regardless of whether it is newer than the
current software image.

» Diagnostics: Perform a download of
the diagnostics image specified in the
Diagnostics Image File Name field.

» Software Image If Newer: Perform a
download of the software image specified
in the Software Image File Name field
only if it is newer than the current image.
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» Download without Reset: Perform
a download of the specified software
images and do not reset the switch at the
end of the process.

4 Click Submit.

—End—

The software download occurs automatically after you click Submit. This
process erases the contents of flash memory and replaces it with the new
software image. Do not interrupt the download. Depending on network
conditions, this process can take up to 10 minutes. When the download
is complete, the switch automatically resets and the new software image
initiates a self-test. During the download, the switch is not operational.

LED activity during software download
During the software download, the port LEDs light one after another in a
chasing pattern, except for ports 35, 36, 47, and 48 on a Nortel Ethernet
Routing Switch 4500 Series 4548GT.

This chasing pattern is initially fast as the software image is downloaded but
gradually slows as the switch erases the flash memory. This pattern speeds
up again as the switch programs the new image into the flash memory.

When the process is complete, the port LEDs are no longer lit and the
switch resets.

Setting TFTP parameters
Many processes in the switch can use a Trivial File Transfer Protocol (TFTP)
server. The following sections describe how to set a default TFTP server for
the switch and how to clear these defaults through the CLI:

e "Setting a default TFTP server" (page 89)
« "Displaying the default TFTP server" (page 90)
¢ "Clearing the default TFTP server" (page 90)

Setting a default TFTP server
The switch processes that use a TFTP server often give the switch
administrator the option to specify the IP address of a TFTP server to use.
Instead of entering this address every time, the switch can store a default
IP address.
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Specify a default TFTP server for the switch with the tftp-server
command. The syntax of this command is

tftp-server <XXX.XXX.XXX.XXX>

To complete the command, replace the <XXX.XXX.XXX.XXX> with the IP
address of the default TFTP server. You must run this command in Global
Configuration command mode.

Displaying the default TFTP server
You can display the default TFTP server configured for the switch in the CLI
at any time by using the show tftp-server command. This command
has no parameters and you run it in Privileged EXEC mode.

Clearing the default TFTP server
You can clear the default TFTP server from the switch and reset it to 0.0.0.0
with the following two commands:

¢ mno tftp-server

This command has no parameters and you run it in Global Configuration
command mode.
¢ default tftp-server

This command has no parameters and you run it in Global Configuration
command mode.

Working with configuration files
This section details working with configuration files through the various
switch interfaces. The administrator uses ASCII-text configuration files to
quickly change the configuration of a switch.

This section contains the following topics:

"Configuration files in the CLI" (page 90)

"Configuration files in the JDM" (page 93)

"Configuration files in the Web-based Management Interface" (page 97)

"Automatically downloading a configuration file" (page 101)

Configuration files in the CLI
The CLI provides many options for working with configuration files. Through
the CLI, you can display, store, and retrieve configuration files.

For details, see the following sections:
« "Displaying the current configuration" (page 91)
e "Storing the current configuration" (page 91)

* "Restoring a system configuration" (page 91)
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T

e "Saving the current configuration" (page 92)

Displaying the current configuration

To display the current configuration of switch or a stack, use the show
running-config command, with the following syntax, in Privileged EXEC
command mode with no parameters:

e show running-config

Storing the current configuration

To copy the contents of the current configuration file to another location for
storage, use the copy running-config command, with the following
syntax, in Privileged EXEC command mode:

e« copy running-config {tftp | (usb)} address
<XXX . XXX .XXX.XXX> filename <name>

For all switches in the 4500 Series, you can save the configuration file to
a TFTP server. On the Nortel Ethernet Routing Switch 4500 Series, you
can save the configuration file to a USB Mass Storage Device through the
front panel USB drive.

"copy running-config parameters" (page 91) outlines the parameters for
using this command.

copy running-config parameters

Parameter Description

{tftp | usb} Specify a location to save the configuration file.

address If you use a TFTP server, specify the IP address.

XXX XXX XXX XXX>

filename <name> The name of the file that is created when you save
the configuration to the TFTP server or to a USB
Mass Storage Device.

Restoring a system configuration
The CLI provides three commands for restoring a system configuration
to a switch:

e« copy tftp config

Use this command to restore a configuration file from a TFTP server.
The syntax is

— copy tftp config address <XXX.XXX.XXX.XXX>
filename <name>

Nortel Ethernet Routing Switch 4500 Series
Overview — System Configuration
NN47205-500 02.01 Standard
5.0 23 February 2007
Copyright © 2007, Nortel Networks Nortel Networks Confidential



92 Basic configuration tasks
e

"copy tftp config parameters” (page 92) outlines the parameters for
this command.

copy tftp config parameters

Parameter Description

address The IP address of the TFTP server.
XXX XXX XXX XXX >

filename <name> The name of the file to be retrieved.

e« copy usb config

Use this command to restore a configuration file from a USB Mass
Storage Device. The syntax is

— copy usb config filename <name>

The only parameter for this command is the name of the file to be
retrieved from the USB device.

e« copy tftp config

Use this command to copy the configuration of a switch in a stack to a
stand-alone switch and to replace units in the stack. The syntax is

— copy tftp config address <XXX.XXX.XXX.XXX>
filename <name> unit <unit number>

"copy tftp config parameters” (page 92) outlines the parameters for
this command.

copy tftp config parameters

Parameter Description

address The IP address of the TFTP server.
XXX XXX XXX XXX >

filename <name> The name of the file.

unit <unit number> The number of the stack unit.

Saving the current configuration

The configuration currently in use on a switch is regularly saved to the flash
memory automatically. However, you can manually initiate this process
using the copy config nvram command. This command takes no
parameters and you must run it in Privileged EXEC mode. If you have
disabled the AutosaveToNvramEnabled function by removing the default
check in the AutosaveToNvRamEnNabled field, the configuration is not
automatically saved to the flash memory.
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Configuration files in the JDM
The Java Device Manager (JDM) provides tools to store and retrieve
configuration files.

For details, see the following topics:

e "Storing the current ASCII configuration" (page 93)
« "Retrieving an ASCII configuration file" (page 94)

e "Storing a binary configuration file" (page 95)

* "Retrieving a binary configuration file" (page 96)
Storing the current ASCII configuration

To store the current ASCII switch configuration file to a TFTP server or USB
storage device, perform the following procedure.

Step Action

1 Open the JDM FileSystem screen by selecting Edit > File System
from the JDM menu.

2 Select the Ascii Config File tab. This tab is displayed in
"AsciiConfigFile tab" (page 93).

AsciiConfigFile tab

. 10.127.232.30 - FileSystem J x|

......... st

Config/Image/Diag file Ascii Config File ’l Save Configuration |

LoadServeraddr: [10.127.125.101
AsciiConfigFilename: I
UsbTargetUnit: IG_ 0..9 {1-8=usb in stack, 9=usb in standalone unit, O=tftp server)

AsciiConfighutoDownload: | { disabled (" useBootp ( useConfig

AsciiConfighutoDldStatus: passed

AsciiConfigManualDownload: ‘(" downloadMow downloatfrolesb‘

AsciiConfigManualDldStatus: passed

AsciiConfigManualUpload: ‘(" uploadhow uplcadToUsbl

AsciiConfigManualUpldStatus: passed

Apply | Refreshl Closel Help...l
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3 In the LoadServer Addr field, type the IP address of the desired
TFTP server. If the configuration file is saved to a USB storage
device, skip this step.

4 In the AsciiConfigFilename field, type the name under which to
store the configuration file.

5 If you save the configuration file to a USB storage device, enter
the stack unit number in which the USB device is inserted in the
UsbTargetUnit field.

6 Select uploadNow in the AsciiConfigManualUpload field to
transfer the file to a TFTP server; or, select uploadToUsb in the
AsciiConfigManualUpload field to transfer the file to a USB mass
storage device.

7 Click Apply.

8 Check the AsciiConfigManualUpldStatus field for the file transfer
status. If the status of the file upload is s inProgress, wait for up to 2
minutes, and then click Refresh to see any new status applied to
the upload. The file upload is complete when the status displays
either Passed or Failed.

—End—

Retrieving an ASCII configuration file
To retrieve an ASCII configuration file from a TFTP server or from a USB
storage device and apply it to the switch, perform the following procedures.

Step Action

1 Open the JDM FileSystem screen by selecting Edit > File System
from the JDM menu.

2 Select the Ascii Config File tab. This tab is displayed in
"AsciiConfigFile tab" (page 93).

3 If you retrieve the configuration file from a USB storage device, skip
this step. Otherwise, in the LoadServer Addr field, type the IP
address of the desired TFTP server.

4 In the AsciiConfigFilename field, type the name under which to
store the configuration file.

5 If you retrieve the configuration file from a USB storage device,
enter the stack unit number in which the USB device is inserted in
the UsbTargetUnit field.
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6 Select downloadNow in the AsciiConfigManualDownload field to
transfer the file from a TFTP server; or, select downloadFromUsb
in the AsciiConfigManualDownload field to transfer the file from a
USB mass storage device.

7 Click Apply.

8 Check AsciiConfigManualDldStatus field for the file transfer status.
If the status of the file download is inProgress, wait for up to 2
minutes, and then click Refresh to see any new status applied to the
download. The file download is complete when the status displays
either Passed or Failed.

—End—

Storing a binary configuration file
To store the current binary configuration file to a TFTP server or a USB
storage device, perform the following procedure.

Step Action

1 Open the FileSystem screen by selecting Edit > File System from
the JDM menu.

2 Select the Config/Image/Diag file tab. This tab is illustrated in "Java
Device Manager File System screen" (page 84).

3 If the file is stored on a USB storage device, skip this step; otherwise,
if a default TFTP server is not already specified (or another TFTP
server is to be used), enter the IP address of the TFTP server to
use in the LoadServerAddr field.

4 In the BinaryConfigFilename field, enter the name to assign to
the configuration file.

5 If the configuration file to be stored is part of a stack, enter the
stack unit number in the BinaryConfigUnitNumber field. If it is a
stand-alone unit, specify 0.

6 If you save the configuration file to a USB storage device, enter
the stack unit number in which the USB device is inserted in the
UsbTargetUnit field.

7 In the Action field, select upldConfig to upload the file to a TFTP
server or upldConfigtoUsb to upload the configuration file to a USB
storage device.

8 Click Apply.
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—End—

Retrieving a binary configuration file
To retrieve a binary configuration file from a TFTP server, perform the
following procedure.

Step Action

1 Open the FileSystem screen by selecting Edit > File System from
the JDM menu.

2 Select the Config/Image/Diag file tab. This tab is illustrated in "Java
Device Manager File System screen" (page 84).

3 If you retrieve the file from a USB storage device, skip this step;
otherwise, if a default TFTP server is not already specified (or
another TFTP server is to be used), enter the IP address of the
TFTP server to use in the LoadServerAddr field.

4 In the BinaryConfigFilename field, enter the name of the
configuration file to retrieve.

5 If the configuration file to be retrieved to a member of a stack, enter
the stack unit number in the BinaryConfigUnitNumber field. If it
is a stand-alone unit, specify O.

6 If you retrieve the configuration file from a USB storage device,
enter the stack unit number in which the USB device is inserted in
the UsbTargetUnit field.

7 In the Action field, select dnldConfig to download the file from a
TFTP server or dnldConfigFromUsb to download the file from a
USB storage device.

8 Click Apply.

—End—

Saving the current configuration

The configuration currently in use on a switch is regularly saved to the flash
memory automatically. However, you can manually initiate this process
using the Save Configuration tab.
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If you have disabled the AutosaveToNvramEnabled function by removing
the default check in the AutosaveToNvRamEnabled field on the Save
Configuration tab, the configuration is not automatically saved to the flash
memory.

To save the current configuration manually:

Step Action

1 From the JDM menu, select Edit > File System Open by .

the FileSystem dialog box appears with the Config/Image/Diag
file tab displayed.

2 Choose the Save Configuration tab.
The Save Configuration tab appears.

x

[v AutosaveTohvramEnabled

Action: | otfier  copyConfigTohlvram
Status: other

Ay | R@Freshl Clnsel Helpl

3 In the Action field, select copyConfigToNvram.
4 Click Apply.

5 Click Refresh
The Status field displays the file copy progress.

—End—

Configuration files in the Web-based Management Interface
The Web-based Management Interface provides tools to store and retrieve
configuration files.

For details, see the following topics:

e "Storing and retrieving a configuration file through TFTP or USB" (page
98)

« "Retrieving a configuration file through HTTP or USB" (page 100)
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Storing and retrieving a configuration file through TFTP or USB
Use the Configuration File Download/Upload page in the Web-based
Management Interface to store or retrieve a configuration file. This page is
illustrated in "Configuration File page" (page 98).

Configuration > Configuration File q

Configuration File page

Configuration File Setting
Access (RW) Configuration Image Filename I4548r;0nﬁg.txl
> Summary Select Target ITFTP Server 'l
¥ Configuration
s IP TFTP Server IP Address I‘IQZ.‘IS?.‘IED.'B (OO IO IO 3000
# System Copy Configuration Image to Target No =
<+ Remote Access
3 SMMPw1 Retrieve Configuration Image from TargetINo vl
> SMMPv3
< SMMP Trap

<+ MAC Address
<+ Find MAC Addrass

<+ Port Management

<+ High Speed Flow Control
<+ Software Download

< Ascii Config Downlosd

<+ Configuration File

To upload (store) a configuration file from this page, complete the following

procedure:
Step Action
1 Open the page by selecting Configuration > Configuration File

from the Web-based Management Interface.

2 Complete the fields on this page to upload the file. "File upload
fields" (page 98) outlines the relevant fields.

File upload fields

Field Description

Configuration Image The name of the file create during the
Filename upload.

Select Target The location of the uploaded file. This can

be either TFTP (TFTP Server) or USB
(USB Mass Storage Device).

TFTP Server IP Address The IP address of the TFTP server if
applicable.
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Field Description
Copy Configuration Image | To perform a file upload, selectYES from
To Target this list.

Retrieve Configuration
Image From Target

To perform a file upload, select NO from
this list.

3 Click Submit.

—End—

To download (retrieve) a configuration file from this page, complete the

following procedure:

Step Action

1 Open the page by selecting Configuration > Configuration File
from the Web-based Management Interface.

2 Complete the fields on this page to download the file. "File download
fields" (page 99) outlines the relevant fields.

File download fields

Field Description

Configuration Image The name of the file to retrieve during the
Filename download process.

Select Target The location of the file to download. This

can be either TFTP (TFTP Server) or
USB (USB Mass Storage Device).

TFTP Server IP Address

The IP address of the TFTP server to use
if applicable.

Copy Configuration Image
To Target

To perform a file download, selectNO
from this list.

Retrieve Configuration
Image From Target

To perform a file upload, select YES from
this list.

Target Unit For Retrieve

This field is available only in stand-alone
switches. Instead of downloading a fixed
configuration file, you can download

the configuration from another switch

in stack when you replace a particular
stack unit. Select a number from this list
if this is the desired type of file download.
The configuration of the selected unit is
downloaded to the current switch.
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3 Click Submit.

—End—

Retrieving a configuration file through HTTP or USB
"Ascii Configuration File Download page" (page 100) illustrates the Ascii
Configuration File download page.

Ascii Configuration File Download page

Configuration > Ascii Configuration File Download q

Ascii Configuration File Download Setting
Access (RW) Ascll Configuration File | Browse...

> Summary Last Manual Configuration Status Passed
¥ Configuration

<+ P

o Sysem [ Submit ]

<+ Remaote Access

<+ SNMPv1 Ascii Configuration File USB Download Setting

t ::nz\;ﬁap Select Target use 'I

& MAC Address Ascii Configuration File

<+ Find MAC Address

@ PortManagement Retrieve Configuration File from Target [No

< High Speed Flow Control Last Manual Configuration Status Passed

< Software Download

< Ascii Config Dewnload m

<+ Configuration File

You can download an ASCII configuration file either from a computer or
through the switch USB port.

To download an ASCII configuration file from a computer, use the following

procedure.
Step Action
1 Select Configuration > Ascii Config Download to open the page

from the Web-based Management Interface.

2 In the Ascii Configuration File Download Setting table, type
the name of the file, including the full local path, in the Ascii
Configuration File field. Alternatively, click Browse and select the
file from the dialog window.

3 Click Submit.

—End—

The Last Manual Configuration Status field displays the outcome of the
operation.
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To download the configuration file through the USB port, perform the
following procedure.

Step Action

1 Select Configuration > Ascii Config Download to open the page
from the Web-based Management Interface.

2 In the Ascii Configuration USB File Download Setting table,
type the name of the file, and supply the necessary information to
complete the file download. "Ascii USB file download fields" (page
101) outlines the available fields.

Ascii USB file download fields

Field Description

Select Target The target from which the file is
downloaded. The only option in this case
is USB.

Ascii Configuration File The name of the configuration file to

download to the switch.

Retrieve Configuration File | To proceed with the file transfer, change
from Target the value in the list from NO to YES.

3 Click Submit.

—End—

The Last Manual Configuration Status field displays the outcome of the
operation.

Automatically downloading a configuration file
You can configure the switch to automatically download a configuration
when it boots. This section describes how to configure a switch to perform
this task:

* "Using the CLI" (page 101)
* "Using the JDM" (page 102)

Using the CLI

Enable this feature through the CLI by using the configure network
command. Use this command to immediately load and run a script and to
configure parameters to automatically download a configuration file when
the switch or stack is booted.
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The syntax for the configure network command is

configure network load-on-boot {disable | use-bootp |
use-config} address <XXX.XXX.XXX.XXX> filename <name>
"configure network parameters" (page 102) outlines the parameters for
this command.

configure network parameters

Parameter Description
load-on-boot {disable | The settings to automatically load a
use-bootp | use-config} configuration file when the system boots:

« disable: disable the automatic loading of
config file

e use-bootp: load the ASCII configuration
file at boot and use BootP to obtain values
for the TFTP address and file name

* use-config: load the ASCII configuration
file at boot and use the locally configured
values for the TFTP address and file name

Note: If you omit this parameter, the system
immediately downloads and runs the ASCII
configuration file.

address The IP address of the TFTP server.
XXX XXX XXX XXX >
filename <name> The name of the configuration file to use in

this process

You must run this command in the Privileged EXEC mode.

You can view the current switch settings for this process using the show
config-network command. This command takes no parameters.

Using the JDM

Enable this feature through the Java Device Manager (JDM) by using the
File System screen. To automatically download a configuration file, perform
the following procedure.

Step Action

1 Open the File System screen by selecting Edit > File System from
the JDM menu.
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2 Select the AsciiConfigFile tab. This tab is illustrated in
"AsciiConfigFile tab" (page 93).

3 In the LoadServerAddr field, type the IP address of the desired
TFTP server.

4 In the AsciiConfigFilename field, type the name of the configuration
file to use.

5 From the AsciiConfigAutoDownload field, select the option to

specify how to download the configuration file:
* disabled: Disable automatic downloading.

* useBootp: Obtain the settings needed to connect to the TFTP
server that contains the configuration file. Using this option
overrides the value in the LoadServerAddr field.

» useConfig: Use the TFTP settings on the screen to connect to
the TFTP server.

6 Click Apply.

7 Click Refresh to check AsciiConfigAutoDIdStatus field for automatic
download configuration file status.

The automatic download configuration file status can be one of the
following:

* passed
e in progress

e failed

—End—

Terminal setup
You can customize switch terminal settings to suit the preferences of a
switch administrator. You must perform this operation in the Command
Line Interface.

The terminal command configures terminal settings. These settings
include terminal length and terminal width.

The syntax of the terminal command is

terminal length <0-132> width <1-132>
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Run the terminal command in User EXEC command mode. "terminal
parameters" (page 104) describes the parameters and variables for the
terminal command.

terminal parameters

Parameter Description

length Set the length of the terminal display in lines;
the default is 23.

Note: If you set the terminal length to 0, the
pagination is disabled and the display scrolls
continuously.

width Set the width of the terminal display in
characters; the default is 79.

You can use the show terminal command at any time to display the
current terminal settings. This command takes no parameters and you must
run it in the EXEC command mode.

Setting Telnet access

You can access the CLI through a Telnet session. To access the CLI
remotely, the management port must have an assigned IP address and
remote access must be enabled.

Note: Multiple users can simultaneously access the CLI system through
the serial port, a Telnet session, and modems. The maximum number of
simultaneous users is 4, plus 1 each at the serial port for a total of 12
users on the stack. All users can configure the switch simultaneously.

For details about viewing and changing the Telnet-allowed IP addresses and
settings, see the following sections:

* "telnet-access command" (page 104)

* "no telnet-access command" (page 105)

« ‘"default telnet-access command" (page 106)

telnet-access command

The telnet-access command configures the Telnet connection that you
use to manage the switch. Run the telnet-access command through the
console serial connection.

The syntax for the telnet-access command is

telnet-access [enable | disable] [login-timeout <1-10>]
[retry <1-100>] [inactive-timeout <0-60>] [logging {none
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| access | failures | all}] [source-ip <1-50>
<XXX.XXX.XXX.XXX> [mask <XXX.XXX.XXX.XXX>]

Run the telnet-access command in Global Configuration command
mode.

"telnet-access parameters” (page 105) describes the parameters for the
telnet-access command.

telnet-access parameters

Parameters Description
enable | disable Enable or disable Telnet connection.
login-timeout <1-10> Specify in minutes the time for the Telnet connection to be

established after the user connects to the switch. Enter
an integer from 1 to 10.

retry <1-100> Specify the number of times the user can enter an
incorrect password before the connection closes. Enter
an integer from 1 to 100.

inactive-timeout <0-60> Specify in minutes the duration before an inactive session
terminates.

logging {none | access | failures | all} Specify the events for which you want to store details in
the event log:

none: Do not save access events in the log.
access: Save only successful access events in the log.
failure: Save failed access events in the log.

all: Save all access events in the log.

[source-ip <1-50> Specify the source IP address from which connections can
XXX XXX XXX XXX> [mask occur. Enter the IP address in dotted-decimal notation.
XXXXXX XXX XXX >] Mask specifies the subnet mask from which connections

can occur; enter IP mask in dotted-decimal notation.

no telnet-access command
The no telnet-access command disables the Telnet connection. The
no telnet-access command is accessed through the console serial
connection.

The syntax for the no telnet-access command is

no telnet-access [source-ip [<1-50>]]
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Run the no telnet-access command in Global Configuration command
mode.

"no telnet-access parameters" (page 106) describes the parameters and
variables for the no telnet-access command.

no telnet-access parameters

Parameters and

. Description
variables P

source-ip [<1-50>] Disable the Telnet access.

When you do not use the optional parameter, the
source-ip list is cleared, which means the first index is
0.0.0.0./0.0.0.0. and the second to fiftieth indexes are
255.255.255.255/255.255.255.255.

When you specify a source-ip address, the specified
pair is 255.255.255.255/255.255.255.255.

Note: These same source IP addresses are in the
IP Manager list. For more information about the IP
Manager list, see Chapter 3.

default telnet-access command
The default telnet-access command sets the Telnet settings to the
default values.

The syntax for the default telnet-access command is

default telnet-access

Run the default telnet-access command in Global Configuration
command mode.

Setting server for Web-based management
You can use the CLI to enable or disable a Web server for use with the
Web-based Management Interface. For details, see the following sections.

e "Web-server command" (page 106)
* "no Web-server command" (page 107)
web-server command

The web-server command enables or disables the Web server used for
Web-based management.
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The syntax for the web-server command is

Web-server {enable | disable}

Run the web-server command in Global Configuration command mode.

"Web-server parameters" (page 107) describes the parameters and
variables for the web-server command.

web-server parameters

Parameters
and variables Description

enable | disable | Enable or disable the Web server.

no web-server command

The no web-server command disables the Web server used for
Web-based management.

The syntax for the no web-server command is

no Web-server

Run the no web-server command in Global Configuration command
mode.

Setting boot parameters

The command described in this section is used to boot the switch or stack
and to set boot parameters.

boot command
The boot command performs a soft-boot of the switch or stack.

The syntax for the boot command is

boot [default] [unit <unitno>]

Run the boot command in Privileged EXEC command mode.
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The table "boot parameters” (page 108) describes the parameters for the
boot command.

boot parameters

Parameters and

variables Description

Restore switch or stack to factory-default settings after
default :

rebooting.
unit <unitno> Specify which unit of the stack is rebooted. This command

is available only in stack mode. Enter the unit number of
the switch you want to reboot.

Note: When you reset to factory defaults, the switch or stack retains the
stack operational mode, the last reset count, and the reason for the last
reset; these three parameters are not reset to factory defaults.

Defaulting to BootP-when-needed
The BootP default value is BootP-when-needed. The switch can boot and
the system can automatically seek a BootP server for the IP address.

If the device has an assigned IP address and the BootP process times out,
the BootP mode remains in the default mode BootP-when-needed.

However, if the device has no assigned IP address and the BootP process
times out, the BootP mode automatically changes to BootP disabled. This
change to BootP disabled is not stored, and the BootP reverts to the default
value of BootP-when-needed after the device reboots.

When you upgrade the syste, the switch retains the previous BootP value.
When the switch resets to default after an upgrade, the system moves to the
default value of BootP-when-needed.

Configuring with the command line interface
This section covers the CLI commands needed to configure BootP
parameters:

e "ip bootp server command" (page 108)
* "no ip bootp server command" (page 109)

e "default ip bootp server command" (page 109)

ip bootp server command

The ip bootp server command configures BootP on the current
instance of the switch or server. Use this command to change the value of
BootP from the default value, which is BootP-when-needed.
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The syntax for the ip bootp server command is

ip bootp server {always | disable | last | needed}

Run the ip bootp server command in Global Configuration command
mode.

"ip bootp server parameters" (page 109) describes the parameters for the
ip bootp server command.

ip bootp server parameters

Parameters and

. Description
variables P

always | disable | last | Specify when to use BootP:
| needed
« always: Always use BootP.
+ disable: Never use BootP.
¢ last: Use BootP or the last known address.

* needed: Use BootP only when needed.

Note: The default value is to use BootP when needed.

no ip bootp server command
The no ip bootp server command disables the BootP server.

The syntax for the no ip bootp server command is

no ip bootp server

Run the no ip bootp server command in Global Configuration
command mode.

default ip bootp server command
The default ip bootp server command uses BootP when needed.

The syntax for the default ip bootp server command is

default ip bootp server

Run the default ip bootp server command in Global Configuration
command mode.
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Customizing the CLI banner
You can configure the banner that is presented when a user logs in to the
switch through the CLI to a user-defined value. The banner cannot exceed
1539 bytes, or 19 rows by 80 columns plus line termination characters.

The banner control setting is saved to NVRAM, and both the banner file and
control setting are distributed to all units within a stack.

To customize the CLI banner using the CLI, see the following commands:
¢ "show banner command" (page 110)
e "banner command" (page 110)

e "no banner command" (page 111)

To customize the CLI banner using Java Device Manager, see the following:
¢ "Banner tab" (page 111)
e "Custom Banner tab" (page 113)

show banner command
The show banner command displays the banner.

The syntax for the show banner command is

show banner [static | custom]

Run the show banner command in Privileged EXEC command mode.

"show banner parameters" (page 110) describes the parameters for the
show banner command.

show banner parameters

Parameters and .
. Description
variables
static | custom Specify which banner is currently set to be displayed:
» static
e custom

banner command
The banner command specifies the banner that is displayed at startup;
either static or custom.

The syntax for the banner command is

banner {static | custom} <line number> "<LINE>"<disabled>
T
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"banner parameters" (page 111) describes the parameters for this
command.

banner parameters

Parameters and o
. Description

variables

static | custom Set the display banner as
e static
e custom

line number Enter the banner line number you are setting. The
range is 1 to 19.

LINE Specify the characters in the line number.

disabled Disable the banner display.

Run the banner command in Global Configuration command mode.

no banner command
The no banner command clears all lines of a previously stored custom
banner. This command sets the banner type to the default setting (STATIC).

The syntax for the no banner command is

no banner

Run the no banner command in Global Configuration command mode.
Banner tab

The Banner tab controls the CLI banner display.

To configure the Banner Control, perform the following procedure.

Step Action

1 Open the Edit Chassis screen in the manner detailed at the
beginning of this section.

2 Select the Banner tab, as illustrated in " Edit Chassis screen --
Banner tab" (page 112).
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Edit Chassis screen--Banner tab
=l

System | Base Uit Info | Agent | SNMP | Trap Recetvars | PowerSupply | Fan [B3nner | Custom Banner |

BannerControl: | (% static ( custom  disabled

o Jrtea] o] |

—End—

The following table "Banner tab items" (page 112) describes the Banner
tab items.

Banner tab items

Field Description

BannerControl Specify the banner to be displayed as soon as you
connect to a Nortel Ethernet Routing Switch 4500
Series device. BannerControl has the following three
options:

¢ The static option uses the predefined static banner.

e The custom option uses the previously set custom
banner.

* The disabled option prevents the display of any
banner.

See also:

e "System tab" (page 216)

* "Base Unit Info tab" (page 219)
e "Stack Info tab" (page 221)

* "Agent tab" (page 224)

« SNMP tab

e Trap Receivers tab

e " Power Supply tab" (page 226)
* " Fan tab" (page 227)

e "Custom Banner tab" (page 113)

Nortel Ethernet Routing Switch 4500 Series
Overview — System Configuration
NN47205-500 02.01 Standard
5.0 23 February 2007
Copyright © 2007, Nortel Networks Nortel Networks Confidential



Customizing the CLI banner 113

Custom Banner tab
Use the Custom Banner tab to customize the CLI banner display.

To customize the banner display, perform the following procedure.

Step Action

1 Open the Edit Chassis screen in the manner detailed at the
beginning of this section.

2 Select the Custom Banner tab, as shown in " Edit Chassis screen --
Custom Banner tab" (page 113).

—End—

Edit Chassis screen--Custom Banner tab
|

System | Base Unit Info | Agent | SNMP | Trap Recewvers | Powersupply | Fan | Banner [Custom Banner |

o) | etresh| 12| (B8] @] 3| (B ciose | .|

19 row(s)

The following table "Custom Banner tab" (page 113) describes the Custom
Banner tab fields.

Custom Banner tab

Field Description

Type Identify the banner type. Two banner types are
available: one type is used in switch or stand-alone
mode while the other is used in the stack mode.

Id Identify the line of text within a custom banner

Line Display one line of a 19-line banner. If the line contains
non printable ASCII characters, then the line is rejected
and an error message is returned.
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Displaying complete GBIC information
You can obtain complete information for a GBIC port using the following
command:

show interfaces gbic-info <port-list>

Substitute <port-1list> with the GBIC ports for which to display
information. If no GBIC is detected, this command shows no information.

This command is available in all command modes.

Displaying hardware information
To display a complete listing of information about the status of switch
hardware in the CLI, use the following command:

show system [verbosel

The [verbose] option displays additional information about fan status,
power status, and switch serial number.

Switch hardware information is displayed in a variety of locations in the
Web-based Management Interface and Java Device Manager. You need no
special options in these interfaces to display the additional information.

Shutdown command
The switch administrator can use this feature to safely shut down the switch
without interrupting a process or corrupting the software image.

After you issue the command, the configuration is saved and blocking is
performed, and the user is notified that it is safe to power off the switch. This
notification is supplied every second until the switch is shut down manually
or the command automatically resets the switch.

The syntax for the shutdown command is

shutdown [<minutes to wait>]

Substitute <minutes to wait> with the number of minutes to wait for
user intervention before the switch resets. If this parameter is not specified,
the switch waits for 10 minutes before resetting.

Use the shutdown command to safely shut down and power off the switch.
After you initiate the shutdown command, the switch saves the current
configuration which allows users to power off the switch within the specified
time period (1 to 60 minutes); otherwise, the switch performs a reset.

When you initiate the shutdown command in the CLI, the following message
appears: Shutdown (y/n) ?
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Enter yes at this prompt to shut down the switch.

The following warning message appears:

Warning the switch/stack has been set to reboot in <xx>
minutes. Current configuration has been saved, no
further configuration changes can be saved until reboot
occurs or ’'shutdown cancel’ command is issued.

The syntax for the shutdown command is

shutdown [force]l [minutes-to-wait <1-60> [cancell

After you initiate the shutdown command, all existing and subsequent
sessions display the following message:

Stack will reset in <xxxxX> seconds.

While existing CLI sessions do not receive a warning message, all
subsequent CLI sessions display the following message:

The shutdown process is in progress. It is safe to
poweroff the stack. Configuration changes will not be
saved. Shutdown has blocked the flash. Autoreset in
<xXXxXx> seconds.

Neither Web-based management nor Device Manager receives any
shutdown warning messages.

The following table describes the parameters and variables for the
shutdown command.

Shutdown command parameters and variables

Parameters and Description

variables

force Instruct the switch to skip the shutdown confirmation prompt.
minutes-to-wait Specify the number of minutes that pass before the switch resets
<1-60> itself The default wait time is 10 minutes.

cancel

Cancel all scheduled switch shutdowns.

Note: Any configurations or logins performed on the switch after you
initiate the shutdown command are not saved to NVRAM and are lost
after the reset.

Run the shutdown command inprivExec command mode.
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Reload command

The reload CLI command provides you with a configuration rollback
mechanism to prevent loss of connectivity to a switch, typically for remote
configurations.

Use the reload command to temporarily disable the autosave feature for
a specified time period (1 to 60 minutes), so you can make configuration
changes on remote switches without affecting the currently saved
configuration.

During the interval in which the autosave feature is disabled by the reload
command, you must use the copy config nvram command to manually
save your configurations.

Initiate the reload command before you start the switch configuration
commands. After you initiate the command in the CLI, the following
message appears:

Reload (y/n) 2
Enter yes at this prompt to set the switch reload.
The following warning message appears:

Warning the switch/stack has been set to reload in <xx>
minutes. Current configuration has NOT been saved.
Configuration must be explicitly saved.

After the reload timer expires, the switch resets, reloads the last saved
configuration, and re-enables the autosave feature.

The syntax for the reload command is
reload [force] [minutes-to-wait <1-60>] [cancell

The following table describes the parameters and variables for the reload
command.

Reload command parameters and variables

Parameters and Description

variables

force Instruct the switch to skip the reload confirmation prompt.
minutes-to-wait Specify the number of minutes that pass before the switch resets
<1-60> itself. The default wait time is 10 minutes.

cancel

Cancel all scheduled switch reloads.

To abort the switch reload before the timer expires, you must enter the
reload cancel command.
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The reload command provides you with a safeguard against any
misconfigurations when you perform dynamic configuration changes on
a remote switch.

The following example describes how you can use the reload command
to prevent connectivity loss to a remote switch:

* Enterthe CLI command reload force 30. Thisinstructs the switch to
reboot in 30 minutes and load the configuration from NVRAM. During the
30-minute period, autosave of the configuration to NVRAM is disabled.

* Execute dynamic switch configuration commands, which take effect
immediately. These configurations are not saved to NVRAM.

* If the configurations cause no problems and switch connectivity is
maintained, you can perform one of the following tasks:

» Save the current running configuration using the copy config nvram,
command.

e Cancel the reload using the reload cancel command.

If you make an error while executing the dynamic switch configuration
commands that results in loss of switch connectivity (for example, if you
make an error in the IP address mask, in the MLT configuration, or in VLAN
trunking), the reload command provides you with a safeguard. When the
reload timer expires, the switch reboots to the last saved configuration, and
connectivity is re-established. Consequently, you need not travel to the
remote site to reconfigure the switch.

CLI Help
To obtain help on the navigation and use of the Command Line Interface
(CLI), use the following command:

help {commands | modes}

Use help commands to obtain information about the commands available
in the CLI organized by command mode. A short explanation of each
command is also included.

Use help modes to obtain information about the command modes
available and the CLI commands used to access them.

These commands are available in any command mode.
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About the Nortel Ethernet Routing
Switch 4500 Series

This chapter provides a general overview of the functionality and capabilities
of the Nortel Ethernet Routing Switch 4500 Series. This chapter contains
information the following topics:

e "Hardware features" (page 119)

e "Auto Unit Replacement" (page 121)

¢ "Features of the Nortel Ethernet Routing Switch 4500 Series" (page 131)
e "Supported standards and RFCs" (page 144)

Hardware features
This section provides information about the hardware features of the Nortel
Ethernet Routing Switch 4500 Series switch platforms.

Hardware description by model

Model Key Features

4526FX 24 100BaseFX ports (MTRJ connector) plus 2 10/100/1000 SFP combo ports
Redundant power slot for DC/DC converter installation

4550T 48 10/100BaseTX RJ-45 ports plus 2 10/100/1000 combo ports
Redundant power slot for DC/DC converter installation

4550T-PWR 48 10/100BaseTX RJ-45 ports with PoE plus 2 10/100/1000 SFP combo ports

4548GT 48 10/100/1000BaseTX RJ-45 ports and 4 shared SFP ports
Redundant power slot for DC/DC converter installation

4548GT-PWR 48 10/100/1000BaseTX RJ-45 ports with Power over Ethernet and 4 shared
SFP ports

Cooling fans
When you install the switch, always allow enough space on both sides for
adequate air flow.

See Nortel Ethernet Routing Switch 4500 Series Installation (NN47205-300)
for detailed information about installation.
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Redundant power supply
The Nortel Ethernet Routing Switch 4500 Series Power over Ethernet
(PoE) switches, ERS 4548GT-PWR, and ERS 4550T-PWR, can use an
optional 470-Watt (W) Nortel Ethernet Routing Switch RPS 15 redundant
power supply. The RPS 15 power supply chassis is two units high and
can accommodate up to three RPS modules, each supporting up to four
devices, to provide redundant power and uninterrupted operation in the
event of power failure. One RPS module connected to a PoE switch can
provide up to 15.4 W for each port on all 48 ports. The RPS modules fit into
the rear of the RPS 15 chassis. The UPS and associated battery pack
module fit into the front of the chassis.

The non-PoE switches, ERS 4548GT, 4550T, and 4526FX, can use an
optional 150W Nortel Ethernet Switch Power Supply Unit 10 and require
the DC-DC Converter Module. The Nortel Ethernet Switch Power Supply
Unit 10 provides scalable power redundancy and protection to low-wattage
networking equipment. The PSU modules slide into the front of the Nortel
Ethernet Routing Switch RPS 15 chassis.

DC-DC Converter Module
The DC-DC Converter Module for the non-PoE switches operates with the
optional Nortel Ethernet Switch Power Supply Unit 10. The PoE switches do
not require a DC-DC Converter Module.

The 100 W DC-DC Converter Module provides a Plug and Play redundant
power supply unit for the Ethernet Routing Switch Series 4500 non-PoE
switches. Contact your Nortel sales representative to order the converter
module.

For further information about the DC-DC converter module, see DC-DC
Converter Module for the BayStack 5000 Series Switch (215081-A).

Stacking capabilities
You can use the Nortel Ethernet Routing Switch 4500 Series switches in
either of the following configurations:

* stand-alone

* stack

The Nortel Ethernet Routing Switch 4500 Series switches have a built-in
cascade port to stack up to eight units. The cascade port provides an
40-Gigabit (Gb) cascading mechanism for the stacks.

A stack can consist of any combination of Nortel Ethernet Routing Switch
4500 Series switches.

Note: All units in the stack must use the same software version.
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To set up a stack, perform the following procedure.

Step Action

1 Power down all switches.

2 Set the Unit Select switch in the back of the non base units to the
off position.

3 Set the Unit Select switch in the back of the base unit to base
position.

4 Ensure all cascade modules are properly seated.

5 Ensure all the cascade cables are properly connected and screwed
into the unit.

6 Power up the stack.

Note: In a mixed stack, any switch can act as the base unit.

—End—

Auto Unit Replacement
You can use the Auto Unit Replacement (AUR) feature to replace a unit from
a stack while retaining the configuration of the unit. This feature requires the
stack power to be on during the unit replacement.

The main feature of the AUR is the ability to retain the configuration (CFG)
image of a unit in a stack during a unit replacement. The retained CFG
image from the old unit is restored to the new unit. Because retained CFG
images are kept in the DRAM of the stack, the stack power must be on
during the procedure.

Note 1: For Auto Unit Replacement to function properly, the new unit
and the existing units in the stack must all run the same version of
software.

Note 2: Auto Unit Replacement does not work on a stack of two units
only. In this configuration, if a unit fails, the remaining unit becomes

a stand-alone switch and Auto Unit Replacement does not load the
configuration of the failed unit if it is replaced.

The following information also relates to this feature:

e The new unit must be the same hardware configuration as the old,
including the same number of ports.
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* |If the administrator adds a new unit with a different hardware
configuration, the configuration of this unit is used.

* If the administrator adds a new unit with the same hardware
configuration, the previous configuration of the new unit is lost. The
configuration is overwritten with the restored configuration from the
stack.

* You can enable or disable this feature at any time using the CLI. The
default mode is ENABLE.

e Customer log messages are provided.

Note: After booting a stack, use the CLI command show stack
auto-unit-replacement from a unit console to find out if that unit
is ready for replacement.

AUR function
The CFG mirror image is a duplicate CFG image (stored in the flash drive)
of a unit in a stack. The mirror image does not reside in the same unit
with the CFG image. The unit that contains the CFG image is called the
Associated Unit (AU) of the CFG mirror image. The MAC Address of the AU
is called the Associated Mac Address (AMA) of the CFG mirror image.

An active CFG Mirror Image is a CFG mirror image that has its AU in the
stack. An INACTIVE CFG Mirror Image is a CFG mirror image for which
the associated AU is removed from the stack. When a CFG mirror image
becomes INACTIVE, the INACTIVE CFG mirror image is copied to another
unit.

The stack always keeps two copies of an INACTIVE CFG mirror image in
the stack in case one unit is removed—the other unit can still provide the
backup INACTIVE CFG mirror image.

CFG mirror image process
The CFG mirror image process is triggered by specific events.

Power Cycle After a power cycle, all the CFG images in a stack are
mirrored.

"CFG mirror process in stack” (page 123) illustrates the CFG mirror images
in a three-unit stack after the stack is powered on. Unit 1 is the Based Unit
(BU) and all other units are Non-Based Units (NBU).

e Unit 1 (BU) contains mirror images for unit 2 (CFG 2) and unit 3 (CFG3).

e Unit 2 (NBU), is the TEMP-BU. It contains a mirror image of unit 1
(CFG1), in case the BU (unit 1) is removed from the stack.

e All three mirror images (CFG 1, CFG 2, and CFG 3) are active.
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e Unit 2 is the AU of the CFG 2 mirror image.
e The Mac Address 2 is the AMA of the CFG2 mirror image.

CFG mirror process in stack

Unit 1 (BU) in stack Unit 2 (NBU) in stack Unit 3 (NBU) in stack
MAC Address 1 MAC Address 2 MAC Address 3
Flash Flash Flash
CFG 1 CFG2 CFG3
Image Image Image
DRAM DRAM DRAM
CFG 2 CFG 1
Mirror Image Image
CFG3
Mirror Image

Adding a unit In a stack that has no any INACTIVE CFG mirror images,
a new unit causes the CFG image of the new unit to be mirrored in the
stack. For example, in "CFG mirror images in the stack after adding unit 4"

(page 124), after you add unit 4 to the stack, the CFG 4 mirror image is
created in the BU (unit 1).
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CFG mirror images in the stack after adding unit 4

Unit 1 (BU) in stack Unit 2 (NBU) in stack  Unit 3 (NBU) in stack  Unit 4 (NBU) in stack
MAC Address 1 MAC Address 2 MAC Address 3 MAC Address 4
Flash Flash Flash Flash
CFG 1 CFG2 CFG3 CFG4
Image Image Image Image
DRAM DRAM DRAM DRAM
CFG 2 CFG 1
Mirror Image Mirror Image

CFG3
Mirror Image

CFG 4
Mirror Image

Removing an NBU When you remove an NBU from a stack, the related
CFG mirror image in the stack becomes INACTIVE.

The AUR feature ensures that the stack always has two copies of an
INACTIVE CFG mirror image. These two copies must not reside in the
same unit in the stack.

For example, after you remove unit 4 from the stack shown in "CFG mirror
images in the stack after adding unit 4" (page 124), the CFG 4 mirror image
becomes INACTIVE (see "CFG mirror images after removing unit 4" (page
125)). Another copy of the INACTIVE CFG 4 mirror image is also created
in unit 2.
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CFG mirror images after removing unit 4

Unit 1 (BU) in stack Unit 2 (NBU) in stack Unit 3 (NBU) in stack
MAC Address 1 MAC Address 2 MAC Address 3
Flash Flash Flash
CFG 1 CFG2 CFG3
Image Image Image
DRAM DRAM DRAM
CFG 2 CFG 1
Mirror Image Mirror Image

CFG 3 T
Mirror Image CFG4
; Mirror Image
CFG 4
Mirror Image

Removing a BU When you remove a BU, the TEMP-BU assumes the

role of the BU. Because all the CFG mirror images of the NBUs reside in
the removed BU, the TEMP-BU mirrors all the CFG image of the NBUs

in the stack.

After you remove the BU from the stack shown in "CFG mirror images in
the stack after adding unit 4" (page 124), the TEMP-BU (unit 2) must mirror
all the CFG images in the stack (see "CFG mirror images in the stack after
removing the BU (unit 1)" (page 126)). The feature also ensures that the
stack always has two copies of an INACTIVE CFG mirror image.
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CFG mirror images in the stack after removing the BU (unit 1)

Unit 2 (TEMP-BU) Unit 3 (NBU) in stack Unit 4 (NBU) in stack
in stack MAC Address 3 MAC Address 4
MAC Address 2
Flash Flash Flash
CFG2 CFG3 CFG4
Image Image Image
DRAM DRAM DRAM
INACTIVE CFG2
CrFG 1 Mirror Image
Mirror Image -~
CFG 3 CFG1
Mirror Image Mirror Image
CFG 4

Mirror Image

As shown in "CFG mirror images in the stack after removing the BU (unit 1)"
(page 126)

* Unit 2 becomes the TEMP-BU.
* The CFG 1 mirror image (residing in unit 2) becomes INACTIVE.
* A second copy of the INACTIVE CFG 1 mirror image is created in unit 3.

* The TEMP-BU (unit 2) contains all CFG mirror images of the NBUs
in the stack.

* The CFG 2 mirror image is created in unit 3. Unit 3 becomes the next
TEMP-BU in case you remove the current TEMP-BU.

Restoring a CFG image
Restoring a CFG image overwrites the CFG image of a new unit in a stack
with an INACTIVE mirror image stored in the stack.

Note: Restore a CFG image to a new unit happens only if you meet the
following conditions.

* The AUR feature is enabled.
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e Atleast one INACTIVE CFG mirror image exists in the stack.

* The MAC Address of the new unit is different from all the AMA of the
INACTIVE CFG mirror images in the stack.

The image restore process consists of the following steps.

Step Action

1 Add a new unit to a stack:

a. If more than one INACTIVE CFG mirror image is in the stack,
select the one with the smallest unit ID for restoration.

b. Send the INACTIVE CFG mirror image in the stack to the new
unit. The INACTIVE CFG mirror image becomes ACTIVE.

c. The new unit saves the received CFG image to the flash drive.

d. The new unit resets itself.

—End—

For example, if you add a unit 5 (MAC Address 5) to the stack shown in
"CFG mirror images in the stack after removing the BU (unit 1)" (page 126),
the following occurs (see "CFG mirror images in the stack after adding unit
5" (page 128)):

e The INACTIVE CFG 1 mirror image is copied to the CFG 5 image. Unit5
now has the configuration of unit 1, which is no longer in the stack.

* The INACTIVE CFG 1 mirror image in unit 2 becomes ACTIVE.
* The INACTIVE CFG 1 mirror image in unit 3 is removed.

« The MAC Address 5 of the unit 5 becomes the new AMA of the CFG1
mirror image.
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CFG mirror images in the stack after adding unit 5

Unit 2 (TEMP- BU) Unit 3 (NBU) in stack Unit 4 (NBU) in stack Unit § (NBU) in stack
in stack MAC Address 3 MAC Address 4 MAC Address 5
MAC Address 2

Flash Flash Flash Flash

CFG 2 CFG3 CFG4 CFG1
Image Image Image Image
DRAM DRAM DRAM DRAM
CFG 1 CFG2

Mirror Image Mirror Image
CFG3

Mirror Image
CFG 4

Mirror Image

Synchronizing the CFG mirror images with CFG images
A CFG mirror image is updated whenever a CFG flash drive synchronization
occurs in the AU.

Configuring AUR using the CLI
This section describes the CLI commands used in AUR configuration.

show stack auto-unit-replacement command
The show stack auto-unit-replacement command displays the
current AUR settings.

The syntax for this command is

show stack auto-unit-replacement

The stack auto-unit-replacement enable command is in all
command modes.

No parameters or variables are available for the show stack auto-unit
replacement command.
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stack auto-unit-replacement enable command
The stack auto-unit-replacement enable command enables AUR
on the switch.

The syntax for this command is

stack auto-unit-replacement enable

Run the stack auto-unit-replacement enable command in Global
Configuration mode.

No parameters or variables are available for the stack auto-unit-
replacement enable command.

no stack auto-unit-replacement enable command
The no stack auto-unit-replacement enable command disables
AUR on the switch.

The syntax for this command is

no stack auto-unit-replacement enable

Run the no stack auto-unit-replacement enable command in
Global Configuration mode.

No parameters or variables are available for the no stack
auto-unit-replacement enable command.

default stack auto-unit-replacement enable command
The default stack auto-unit-replacement enable command
restores the default AUR settings.

The syntax for this command is

default stack auto-unit-replacement enable

Run the default stack auto-unit-replacement enable
command in Global Configuration mode.

No parameters or variables are available for the default stack
auto-unit-replacement enable command.

Configuring AUR using Device Manager
Click in the AutoUnitReplacementEnabled field to enable or disable AUR
using Device Manager in the System tab (see "System tab" (page 216)).
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Agent Auto Unit Replacement
Use the enhancement to the Auto Unit Replacement functionality, known
as Agent Auto Unit Replacement (AAUR), to ensure that all units in a stack
have the same software image by inspecting units joining a stack and
downloading the stack software image to any unit that has a dissimilar
image. AAUR is enabled by default.

Agent Auto Unit Replacement functions in the following manner:

1. When a stand-alone switch joins an AAUR-enabled stack, the switch
software image is inspected.

2. If the switch software image differs from the stack software image, the
AAUR functionality downloads the stack software image to the joining
unit.

3. The joining unit is then reset and becomes a member of the stack upon
a reboot.

Use the CLI commands in the following sections to manage and configure
AAUR. You can currently manage this functionality only through the CLI.

stack auto-unit-replacement-image enable command

Use the stack auto-unit-replacement-image enable command
to enable AAUR. Because AAUR is enabled by default, use this command
only if this functionality was previously disabled.

The syntax for this command is

stack auto-unit-replacement-image enable

Run the stack auto-unit-replacement-image enable command in
Global Configuration command mode.

no stack auto-unit-replacement-image-enable command

Use the no stack auto-unit-replacement-image enable
command to disable AAUR. Because AAUR is enabled by default, you must
run this command if you do not want AAUR functionality on a switch.

The syntax for this command is

no stack auto-unit-replacement-image enable

The no stack auto-unit-replacement-image enable command is
executed in the Global Configuration command mode.

default stack auto-unit-replacement-image enable command
Use the default stack auto-unit-replacement-image enable
command to set the AAUR functionality to the factory default of enabled.
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The syntax of this command is

default stack auto-unit-replacement-image enable

Run the default stack auto-unit-replacement-image enable
command in Global Configuration command mode.

show stack auto-unit-replacement-image command
Use the show stack auto-unit-replacement-image command to
view the current status of the AAUR functionality.

The syntax of this command is

show stack auto-unit-replacement-image

Run the show stack auto-unit-replacement-image command in
User EXEC command mode.

Features of the Nortel Ethernet Routing Switch 4500 Series
The Nortel Ethernet Routing Switch 4500 Series provides wire-speed
switching that enables high-performance and low-cost connections to
full-duplex 10/100/100 and half-duplex 10/100 Mb/s Ethernet Local Area
Networks (LAN).

This section describes the general features of the Nortel Ethernet Routing
Switch 4500 Series.

Flash memory storage
Switch software image storage
The Nortel Ethernet Routing Switch 4500 Series uses flash memory to store
the switch software image.

You can update the software image with a new version from flash memory.

You must have an in-band connection between the switch and the TFTP
load host to the software image.

Configuration parameter storage
All configuration parameters in the Nortel Ethernet Routing Switch 4500
Series are stored in flash memory.

These parameters are updated every 60 seconds if a change occurs, or
upon execution of a reset command.

Note: Do not power off the switch within 60 seconds of changing any
configuration parameters.
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If you power down down the switch within 60 seconds you can lose the
changed configuration parameters.

Policy-enabled networking
With the Nortel Ethernet Routing Switch 4500 Series, you can implement
classes of services and assign priority levels to different types of traffic. You
can also configure policies to monitor the characteristics of traffic.

For example, in the Nortel Ethernet Routing Switch 4500 Series, you can
determine the sources, destinations, and protocols used by the traffic. You
can also perform a controlling action on the traffic when certain user-defined
characteristics match.

The Nortel Ethernet Routing Switch 4500 Series supports Differentiated
Services (DiffServ). DiffServ is a network architecture through which service
providers and enterprise network environments can offer various levels of
services for different types of data traffic.

You can use DiffServ Quality of Service (QoS) to designhate a specific level
of performance on a packet-by-packet basis. If you have applications that
require high performance and reliable service, such as voice and video
over IP, you can use DiffServ to give preferential treatment to this data over
other traffic.

Power over Ethernet
The Nortel Ethernet Routing Switch 4500 Series 4548-GT-PWR and the
4550T-PWR (PoE switches) provide IEEE 802.3af-compliant power or POE
on all 10/100/1000 RJ-45 ports.

PoE refers to the ability of the switch to power network devices over an
Ethernet cable. Some of these devices include IP Phones, Wireless LAN
Access Points, security cameras, and access control paints.

The PoE switches automatically detect the network device requirements
and dynamically supply the required DC voltage at a set current to each
appliance.

To configure and manage the PoE features, you must use either the CLI, the
Web-based management system, or the Java Device Manager.

Note: You must use a four-pair Category 5 UTP cable for PoE. A
standard two-pair UTP Cable does not support PoE.

Virtual Local Area Networks
Virtual Local Area Network (VLAN) provides a mechanism to fine-tune
broadcast domains.
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The Nortel Ethernet Routing Switch 4500 Series can create two types of
VLANS:

* |EEE 802.1Q port-based VLANs

Port-based VLANS filter on the 802.1Q value of the packet. Tagged
packets enter the device that contains an 802.1Q value. Untagged
packets assume the PVID value assigned to the inbound port as the
802.1Q value. The packets are forwarded only to those ports with VLAN
membership lists that contain the same 802.1Q value as the packet.

Automatic PVID (AutoPVID) automatically sets the PVID when you
configure a port-based VLAN. When you add the port to the VLAN, the
PVID value is the same value as the last port-based VLAN ID that you
associated with this port. You can also manually change the PVID value.

The default global setting for AutoPVID is On.
* Protocol-based VLANSs

A protocol-based VLAN is a VLAN in which you assign the switch ports
as members of a broadcast domain based on the protocol information
within the packet.

Protocol-based VLANs can localize broadcast traffic and ensure that
only the protocol-based VLAN ports are flooded with the specified
protocol type packets. The maximum number of available protocols is
14, including the User Defined Protocols option.

VLANS are classified based on the following information:
1. Is the packet tagged?
2. Does the packet belong to a protocol-based VLAN?

If none of the criteria apply, the packet belongs to the VLAN identified by
the PVID of the ingress port.

The Nortel Ethernet Routing Switch 4500 Series supports up to 256 VLANS,
including VLAN #1, which is always port-based. The 256 VLANs can be
on a stand-alone Nortel Ethernet Routing Switch 4500 Series or across

a stack of switches.

Spanning Tree Protocol groups
The Nortel Ethernet Routing Switch 4500 Series supports the Spanning
Tree Protocol (STP) as defined in IEEE 802.1D.

STP detects and eliminates logical loops in a bridged or switched network.
When multiple paths exist, the spanning tree algorithm configures the
network to use only the most efficient path. If that path fails, the protocol
automatically reconfigures the topology to select a new active path.
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The Spanning Tree Groups (STG) forms a loop-free topology that includes
one or more VLANSs. The Nortel Ethernet Routing Switch 4500 Series
supports a maximum of eight STGs running simultaneously.

The Nortel Ethernet Routing Switch 4500 Series supports a maximum of
256 VLANS. Therefore each STG may have 32 VLANS.

Rapid Spanning Tree Protocol
The standard spanning tree implementation in 4500 Series switches is
based on IEEE 802.1d, which is slow to respond to a topology change in the
network (for example, a dysfunctional link in a network).

The Rapid Spanning Tree Protocol (RSTP or IEEE 802.1w) reduces

the recovery time after a network breakdown. RSTP also maintains a
backward compatibility with the IEEE 802.1d. In certain configurations, the
recovery time of RSTP is less than 1 second. You can maintain backward
compatibility by configuring a port to be in STP-compatible mode. A port
that operates in the STP-compatible mode transmits and receives only STP
BPDUs and drops any RSTP BPDUs.

RSTP also reduces the amount of flooding in the network by enhancing the
way Topology Change Notification (TCN) packet is generated.

Multiple Spanning Tree Protocol
With Multiple Spanning Tree Protocol (MSTP or IEEE 802.1s), you can
configure multiple instances of RSTP on the same switch. Each RSTP
instance can include one or more VLANs. The operation of the MSTP is
similar to the current Nortel proprietary STP.

The 4500 Series switch can use RSTP and MSTP to achieve the following:

* Reduce converging time from 30 seconds to less than 1 second when
topology changes in the network (that is, the port goes up or down).

* Eliminate unnecessary flushing of the MAC database and flooding of
traffic to the network with a new Topology Change mechanism.

* Provide backward compatibility with other switches that run legacy
802.1d STP or Nortel MSTG (STP group 1 only).

* Provide simultaneous support for eight instances of RSTP under MSTP
mode. Instance 0 or CIST is the default group, which includes default
VLAN 1. Instances 1 to 7 are called MSTIs 1-7.

* You can configure the switch to run Nortel STPG (IEEE 802.1d), RSTP
(IEEE 802.1w), or MSTP (IEEE 802.15s).
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Trunk groups
The Nortel Ethernet Routing Switch 4500 Series supports two types of
trunk groups:

e Link Aggregation Group (LAG): Trunk groups that are formed by Link
Aggregation are referred to as Link Aggregation Groups (LAG).

e Multilink Trunk (MLT): Trunk groups that are formed by Nortel Ethernet
Routing Switch 4500 Series Multilink Trunking are referred to as Multilink
Trunks (MLT).

Link Aggregation

Link Aggregation (LA) provides a mechanism to create and manage trunk
groups. You can control and automatically configure a trunk group with the
Link Aggregation Control Protocol (LACP).

As defined by IEEE 802.3ad standard, the switch uses LACP the switch to
"learn" the presence and capabilities of a remote switch by exchanging
relevant information with the remote switch. Either switch can accept or
reject the aggregation request. A link that does not join a trunk group
operates as an individual link.

By default, Link Aggregation is set to off on all ports.

MultiLink Trunking

With MultiLink Trunking (MLT) you can group multiple ports, two to eight
together, when you link ports to another switch or server. This grouping
increases the aggregate throughput of the interconnection between two
devices by 8 Gb in full-duplex mode.

You can configure the Nortel Ethernet Routing Switch 4500 Series with up
to 6 multilink trunks.

You can configure the trunk members within a single unit in the stack. You
can distribute trunk members between any of the units within the stack
configuration. This is referred to as distributed trunking.

Security
The following table describes the types of security supported by the
Ethernet Routing Switch 4500 Series.

Security Type Description

RADIUS-based security | Limit administrative access to the switch through user authentication.
MAC address-based Limit access to the switch based on allowed source and destination
security MAC addresses.
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Security Type Description

EAPOL-based security Enable the exchange of authentication information between any end
(IEEE 802.1X) station or server connected to the switch and authentication server,
such as a RADIUS server.

IP manager list Limit access to management features of the switch based on the
management station IP address.

SNMPV3 Enable access to the various services by using password authentication
(MD5), secure-hash algorithm, and encryption using the Data
Encryption Standard.

SSL Provide a secure Web management interface.

SSH Replace telnet and provide a secure access to the CLI.

For more information about specific security features, see Configuring
and Managing Security for Nortel Ethernet Routing Switch 4500 Series,
Software Release 5.0 (NN47205-505).

Port mirroring
with port mirroring, also referred to as conversation steering, you can
designate a single switch port as a traffic monitor for a specified port.

You can specify port-based monitoring for ingress and egress at a specific
port. You also can attach a probe device, such as a Nortel StackProbe*, or
equivalent, to the designated monitor port.

Note: Use the CLI or the Web-based Management Interface to
configure port mirroring.

Auto-MDI/X
The term auto-MDI/X refers to automatic detection of transmit and receive
twisted pairs.

When auto-MDI/X is active, any straight or crossover category 5 cable can
provide connection to a port. If autonegotiation is disabled, then auto-MDI/X
is not active.

Auto-polarity
Auto-polarity refers to the ability of the port to compensate for positive and
negative signals being reversed on the receive cables.

The Nortel Ethernet Routing Switch 4500 Series support auto-polarity. With
autonegotiation enabled, auto-polarity automatically reverses the polarity
of a pair of pins from positive to negative or negative to positive. This
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corrects the polarity of the received data, if the port detects that the polarity
of the data is reversed due to a wiring error. If autonegotiation is disabled,
auto-polarity is not active.

Autosensing and autonegotiation
The Nortel Ethernet Routing Switch 4500 Series are autosensing and
autonegotiating devices:

e The term autosense refers to the ability of a port to sense the speed of
an attached device.

e The term autonegotiation refers to a standard protocol (IEEE 802.3u
or 802.3z or 802.3ab) that exists between two IEEE-capable devices.
Autonegotiation enables the switch to select the best speed and duplex
modes.

Autosensing occurs when the attached device cannot autonegotiate or
uses a form of autonegotiation that is not compatible with the IEEE 802.3z
autonegotiation standard. If it is not possible to sense the duplex mode of
the attached device, the Nortel Ethernet Routing Switch 4500 Series reverts
to half-duplex mode.

When autonegotiation-capable devices are attached to the Nortel Ethernet
Routing Switch 4500 Series, the ports negotiate down from 1000 Mb/s
and full-duplex mode until the attached device acknowledges a supported
speed and duplex mode.

Custom Autonegotiation Advertisements

In the Nortel Ethernet Routing Switch 4500 Series, you can use the Custom
Autonegotiation Advertisements (CANA) feature to control the speed and
duplex settings that each Ethernet port of the device advertises as part of
the autonegotiation process.

Without CANA, a port with autonegotiation enabled advertises all speed
and duplex modes supported by the switch and attempts to establish a link
at the highest common speed and duplex setting. By using CANA, you
can configure the port to advertise only certain speed and duplex settings,
thereby establishing links only at these settings, regardless of the highest
commonly supported operating mode.

CANA provides control over the IEEE802.3x flow control settings advertised
by the port, as part of the autonegotiation process. You can set flow control
advertisements to Symmetric, Asymmetric, or Disabled.

You may not want a port to advertise all supported speed and duplex modes
in the following situations:

* If a network can support only a 10 Mb/s connection, you can configure
a port to advertise only 10 Mb/s capabilities. Devices that uses
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autonegotiation to connect to this port connect at 10 Mb/s, even if both
devices are capable of higher speeds.

* If you configure a port to advertise only 100 Mb/s full-duplex capability,
the link becomes active only if the link partner can autonegotiate a 100
Mb/s full-duplex connection. This prevents mismatched speed or duplex
settings if autonegotiation is disabled on the link partner.

« For testing or network troubleshooting, you can configure a link to
autonegotiate at a particular speed or duplex mode.

Configuring CANA using the CLI Use the auto-negotiation-
advertisements command to configure CANA.

To configure port 5 to advertise the operational mode of 10 Mb/s and full
duplex, enter the following command:

auto-negotiation-advertisements port 5 10-full

The following example displays sample output for the auto-negotiation-
advertisements command to set port 5 to 10 Mb/s and full duplex.

auto-negotiation-advertisements command sample output
4548GT-PWR<config>#interface fastethernet 5
4548GT-PWR<config-if>#auto-negotiation-advertisements port
5 10-full

4548GT-PWR<config-if>#

Viewing current autonegotiation advertisements To view the
autonegotiation advertisements for the device, enter the following command:

show auto-negotiation-advertisements [port <portlist>]

The following example displays sample output for the show
auto-negotiation-advertisements command after port 5 is set to 10 Mb/s
and full duplex.

show auto-negotiation-advertisements command sample output
4548GT-PWR#show auto-negotiation-advertisements port 5
Unit/Port Autonegotiation Advertised Capabilities

1/5 10Full

Viewing hardware capabilities To view the operational capabilities of the
device, enter the following command:

show auto-negotiation-capabilities [port <portlist>]

The following example displays sample output for the show
auto-negotiation-capabilities command for port 5.

show auto-negotiation-capabilities command sample output
4548GT-PWR#show auto-negotiation-capabilities port 1/5
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Unit/Port Autonegotiation Capabilities

1/5 10Full 10Half 100Full 100Half 1000Full
4548GT-PWR#

Setting default advertisements To set default autonegotiation
advertisements for the device, enter the following command in the Interface
Configuration command mode:

default auto-negotiation-advertisements [port <portlist>]

To set default advertisements for port 5 of the device, enter the following
command:

default auto-negotiation-advertisements port 5

The following example displays sample output for the default
auto-negotiation-advertisements command to return port 5 to default
auto-negotiation-advertisements status.

default auto-negotiation-advertisements command sample output
4548GT-PWR<config>interface fastethernet all
4548GT-PWR<config-if>#default-auto-negotiation-advertiseme
nts port 1/5

4548GT-PWR (config-if>#

Silencing advertisements To set a port transmit no autonegotiation
advertisements, enter the following command in the Interface Configuration
command mode:

no auto-negotiation-advertisements [port <portlist>]

To silence the autonegotiation advertisements for port 5 of the device, enter
the following command:

no auto-negotiation-advertisements port 5

The following example displays sample output for the no
auto-negotiation-advertisements command to silence the
auto-negotiation-advertisements for port 5.

no auto-negotiation-advertisements command sample output
4548GT-PWR<config-if>#no auto-negotiation-advertisements
port 1/5

4548GT-PWR<config-if>#

ASCII configuration file
With the Nortel Ethernet Routing Switch 4500 Series you can download a
user-editable ASCII configuration file from a TFTP server.

Load the ASCII configuration file automatically at boot time or on demand
by using the CLI.
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After you download the file, the configuration file automatically configures
the switch or stack according to the CLI commands in the file.

With this feature, you can generate command configuration files that can be
used by several switches or stacks with minor modifications.

The maximum size for an ASCII configuration file is 500 KB; split large
configuration files into multiple files.

Use a text editor to edit the ASCII configuration. The command format is
the same as that of the CLI.

Download the ASCII configuration file to the base unit by using CLI
commands. The ASCII configuration script completes the process.

Sample ASCII configuration file

This section shows a sample ASCII configuration file. This file is an example
only and shows a basic configuration for a stand-alone switch that includes
multilink trunking, VLANS, port speed and duplex, and SNMP configurations.

The following text represents a sample ASCII configuration file:

| example script to configure different features from CLI

enable

mlt 3 name seg3 enable member 13-14
mlt 4 name seg4 enable member 15-16
mlt 5 name seg5 enable member 17-18

! create vlan portbased
vlan create 100 name v1lanl00 type port
!
! add Mlts created above to this VLAN
vlan members add 100 17
!
| create vlan ip protocol based
vlan create 150 name vlanl50 type protocol-ipEther2
T
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|

! add ports to this VLAN

! in this case all ports

vlan members add 150 ALL

vlan ports ALL priority 3

|

I igmp

! you could disable proxy on vlan 100
vlan igmp 100 proxy disable

! Examples of changing interface parameters

! change speed of port 3
interface Fastethernet 3

speed 10
duplex half
exit

|

! change speed of port 4
interface Fastethernet 4
speed auto

duplex auto

exit

! SNMP configuration

snmp-server host 192.168.100.125 private
snmp-server community private

Note: To add comments to the ASCII configuration file, add an
exclamation point (!) to the beginning of the line.

Displaying unit uptime
You can display the uptime for each unit in a stack. Unit stack uptime
collects the stack uptime for each unit in a stack and reports this information
when requested. You can determine how long each unit is connected to the
stack. You can use the CLI commands to display the unit uptimes.
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Port naming
You can name or specify a text string for each port. This feature provides
easy identification of the connected users.

Use the CLI, DM, or the Web-based management system to name ports.

Port error summary
You can view all ports that have errors in an entire stack.

If a particular port has no errors, it is not displayed in the port error summary.

This feature is available only through the Web-based management system.

IP address for each unit in a stack
You can assign an IP address to each unit in a stack. Use the CLI to
configure the IP addresses for each unit within a stack.

BootP mode
The Nortel Ethernet Routing Switch 4500 Series supports the Bootstrap
protocol (BootP).

You can use BootP to retrieve an ASCII configuration file name and
configuration server address.

With a properly configured BootP server, the switch automatically learn its
assigned IP address, subnet mask, and the IP address of the default router
(default gateway).

The Nortel Ethernet Routing Switch 4500 Series has a unique 48-bit
hardware address, or MAC address, that is printed on a label on the back
panel. Use this MAC address when you configure the network BootP
server to recognize the Nortel Ethernet Routing Switch 4500 Series BootP
requests.

The BootP modes supported by the Nortel Ethernet Routing Switch 4500
Series are

* BootP or Last Address mode
¢ BootP-When-Needed

e BootP Always

* BootP Disabled

Note: The default BootP mode is BootP-When-Needed.
Web Quick Start

You can use the Web Quick Start feature to enter the setup mode through
a single screen.
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This feature is supported only by the Web interface.

During the initial setup mode, all ports in the switch or stack are assigned
to the default VLAN.

You can use the Web Quick Start screen to configure the following
information:

e switch or stack IP address

* subnet mask

* default gateway

*  SNMP Read community

*  SNMP Write community

* SNMP Trap IP addresses and communities (up to four4)
¢ Quick Start VLAN

Simple Network Time Protocol
The Simple Network Time Protocol (SNTP) is a subset of the Network Time
Protocol. It provides a simple mechanism for time synchronization.

Clocks use NTP to synchronize to a few milliseconds, depending on the
clock source and local clock hardware.

SNTP synchronizes the Universal Coordinated Time (UTC) to accuracy
within 1 second.

This feature adheres to the RFC 2030 (MIB is the sbagent). With this
feature, the system can obtain the time from any RFC 2030-compliant NTP
or SNTP server.

The SNTP client implementation for this feature is unicast. The SNTP
client operates typically in a unicast mode but can use the broadcast and
multicast modes.

SNTP accuracy is typically in the order of significant fractions of a second.
This accuracy correlates to the latencies between the SNTP client device

and the NTP server. In a low-latency network, the SNTP accuracy can be
reduced to less than a 100 millisecond range and, to further increase the

accuracy, you can use a simple latency measurement algorithm.

The intended accuracy for this implementation is 1 second, which is
sufficient for logs and time displays on Uls.

The system retries connecting with the NTP server a maximum of three
times, with 5 minutes between each retry.
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When SNTP is enabled (the default value is Disabled), the system
synchronizes with the configured NTP server at boot-up (after network
connectivity is established) and at user-configurable periods thereatfter (the
default synchronization interval is 24 hours). The synchronization also can
happen upon manual request.

The SNTP feature supports both primary and secondary NTP servers. It
attempts to contact the secondary NTP server only if the primary NTP
server is unresponsive. When a server connection fails, SNTP retries for a
maximum of three times, with 5 minutes between each retry.

Ping enhancement
Using the CLI you can specify additional ping parameters, including the
number of ICMP packets to be sent, the packet size, the interval between
packets, and the timeout. You can also set ping to continuous, or you can
set a debug flag to obtain extra debug information.

See "ping command" (page 190).

Supported standards and RFCs
This section lists the standards and RFCs supported by the Nortel Ethernet
Routing Switch 4500 Series.

Standards
The following IEEE Standards contain information pertinent to the Nortel
Ethernet Routing Switch 4500 Series:

* |EEE 802.1D (Standard for Spanning Tree Protocol)
* |EEE 802.3 (Ethernet)

* |EEE 802.1Q (VLAN Tagging)

e |EEE 802.1p (Prioritizing)

« IEEE 802.1X (EAPOL)

e |EEE 802.3u (Fast Ethernet)

* |EEE 802.3z (Gigabit Ethernet)

* |EEE 802.3ab (Gigabit Ethernet over Copper)

* |EEE 802.3x (Flow Control)

* |EEE 802.3ad (Link Aggregation)

RFCs
For more information about networking concepts, protocols, and topologies,
consult the following RFCs:

« RFC 791 (IP)
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« RFC 894 (IP over Ethernet)

« RFC 792 (ICMP)

* RFC 793 (TCP)

* RFC 1350 (TFTP)

+ RFC 826 (ARP)

* RFC 768 (UDP)

* RFC 854 (Telnet)

+ RFC 951 (BootP)

* RFC 1213 (MIB-II)

* RFC 1493 (Bridge MIB)

* RFC 2863 (Interfaces Group MIB)
* RFC 2665 (Ethernet MIB)

* RFC 2737 (Entity MIBv2)

+ RFC 2819 (RMON MIB)

« RFC 1757 (RMON)

* RFC 1271 (RMON)

+ RFC 1157 (SNMP)

« RFC 1112 (IGMPv1)

* RFC 2236 (IGMPv2)

e RFC 1945 (HTTP v1.0)

* RFC 2865 (RADIUS)

* RFC 2674 (Q-BRIDGE-MIB)

« RFC 3410 (SNMPV3)

* RFC 3411 (SNMP Frameworks)

*  RFC 3413 (SNMPv3 Applications)
+ RFC 3414 (SNMPv3 USM)

+ RFC 3415 (SNMPv3 VACM)

* RFC 3412 (SNMP Message Processing)
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Power over Ethernet

The Nortel Ethernet Routing Switch 4500 Series 4550T-PWR and
4548-GT-PWR are Power Sourcing Equipment (PSE). They support Power
over Ethernet (PoE) on all 10/100/1000 ports.

PoE is based on the IEEE 802.3af standard.

PoE is the ability of the 4550T-PWR and the 4548-GT-PWR to power
network devices over the Ethernet cable. These devices include IP Phones,
wireless LAN access points, security cameras, and access control points.

The PoE features supported by the 4550T-PWR and the 4548-GT-PWR
switches are as follows:

« DTE power
« powered device (PD) discovery and classification

e capacitive detection to support legacy PD devices, including the Nortel
and Cisco Legacy IP Phones

e per-port power management and monitoring
* AC and DC disconnection
* load under voltage/current and over voltage/current detection

* atleast 320 watts (W) power available for PSE ports from the internal
power supply

* upto 6.6 W for each port on all 48 ports

* atotal of 740 W power available for PSE ports using both the internal
and external power supply

* 15.4 W (Max) for each port on a 48 port unit
* per-port PoE status LED
e port prioritizing to guarantee DTE power available on high-priority ports

e port pruning to prevent system failure
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You can configure PoE from the CLI, SNMP, and Web interfaces. For details,
see the following sections.

* "PoE overview" (page 148)

« "Port power priority" (page 149)

« "External power source" (page 150)

» "Stacking" (page 150)

* "Power pairs" (page 150)

¢ "Power availability" (page 151)

« "Diagnosing and correcting PoE problems" (page 155)
* "Power management" (page 157)

e "Configuring PoE using the CLI" (page 158)

* "Viewing PoE ports using the JDM" (page 162)
e "Configuring PoE using the JDM" (page 163)

e "Configuring PoE using the Web-based Management Interface" (page
163)

POE overview
The Nortel Ethernet Routing Switch 4500 Series 4550T-PWR and the
4548-GT-PWR are ideal to use with Nortel Business Communication
Manager system, IP phones, hubs, and wireless access points. You can
use these switches with all network devices.

By using the Nortel Ethernet Routing Switch 4500 Series 4550T-PWR or the
4548-GT-PWR, you can plug any IEEE802.3af-compliant powered device
into a front-panel port and receive power in that port. Data also can pass
simultaneously on that port. This capability is called PoE.

The IEEE 802.3af draft standard regulates a maximum of 15.4 W of power
for each port; that is, a power device cannot request more than 15.4 W

of power. As different network devices require different levels of power,

the overall available power budget of the Ethernet Routing Switch 4500
depends on your power configuration and the particular connected network
devices. If you connect an IP device that requires more than 16 W of power,
you see an error on that port notifying you of an overload.

The Nortel Ethernet Routing Switch 4500 Series 4550T-PWR and the
4548-GT-PWR automatically detect each IEEE 802.3af-draft-compliant
powered device attached to each front-panel port and immediately sends
power to that appliance. The switches also automatically detect how much
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power each device requires and supply the required DC voltage at a set
current based on the load conditions and current availability. The switches
support both PoE and standard LAN devices.

The power detection function of the Nortel Ethernet Routing Switch 4500
Series 4550T-PWR and the 4548-GT-PWR operate independently of the
data link status. A device that is already operating the link for data or a
device that is not yet operational can request power. That is, the switches
provide power to a requesting device even if the data link for that port is
disabled. The switches monitor the connection and automatically disconnect
power from a port when you remove or change the device, as well as when
a short occurs.

The switches automatically detect devices that require no power connections
from them, such as laptop computers or other switching devices, and send
no power to those devices. You control the supply of power to specific ports
by setting the maximum allowed power to each port in 1 W increments,
from 3 W to 16 W.

Note: Allow 30 seconds between unplugging and replugging an IP
device to the switch to enable the IP device to discharge. If you attempt
to connect earlier, the switch may not detect the IP device.

Port power priority
You can configure the power priority of each port by choosing low, high, or
critical power priority settings.

The switch automatically drops low-priority ports when the power
requirements exceed the available power budget. When the power
requirements becomes lower than the switch power budget, the power
returns to the dropped port. When several ports have the same priority,
one of them must be dropped. In this case, the port with the highest port
number is dropped.

For example, assume the following scenario:

e Ports 1 to 40 are configured as low priority.

» Port 41 is configured as high priority.

e Ports 1 to 40 are connected to powered devices.

The devices connected to the ports consume the available Nortel Ethernet
Routing Switch 4500 Series 4550T-PWR and 4548-GT-PWR switch power.

The device connected to port 41 requests power from the 4550T-PWR or
the 4548-GT-PWR. The switch provides the required power as port 41 is
configured as high priority. However, to maintain the power budget, the
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switch drops one of the ports configured as low priority. In this case, the
switch drops power to port 40 and provides power to port 41. If another port
drops power, the system automatically reinstates power to port 40.

External power source

Stacking

Power pairs

The Nortel Ethernet Redundant Power Supply 15 is available as an optional
external power source. Contact your Nortel representative for more
information about the Nortel Ethernet Redundant Power Supply Unit 15.

The following are the available options to power the Nortel Ethernet Routing
Switch 4500 Series 4550T-PWR or the 4548-GT-PWR switch:

e internal power source only
» external power source only
— Nortel Ethernet Redundant Power Supply 15

e internal power source plus external power source
— Nortel Ethernet Redundant Power Supply 15

In a stack configuration, each unit can have its own external power source.

You can stack the PoE switches up to eight units high. You can configure
these stacks for redundancy.

The PoE switches support wiring as mentioned in the IEEE 802.3af draft
standard.

The PoE switches support power to Signal pair only.

Note: The RJ-45 ports 45, 46, 47, and 48 in the 4548-GT-PWR can still
supply PoE power to the attached devices, even if the corresponding
SFP ports are used for data connectivity.

"Signal power pair RJ-45 port connector pin assignments" (page 150)
shows the RJ-45 connector pin assignments for configuring a power pair for
the signal pair. When you choose the signal power pair, the data and the
power are transmitted from the same pins.

Signal power pair RJ-45 port connector pin assignments

Pin Signal Description
1 RX+/power+ Receive Data +/power+
2 RX-/power+ Receive Data -/power+
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Pin Signal Description

3 TX+/power- Transmit Data +/power-
4 Not applicable Not applicable

5 Not applicable Not applicable

6 TX-/power- Transmit Data -/power-
7 Not applicable Not applicable

8 Not applicable Not applicable

Power availability
You can use the Nortel Ethernet Redundant Power Supply Unit 15 as an
external power source for the 4550T-PWR and the 4548-GT-PWR switches.

The following are the three options to power the switch:
e internal power source only
» external power source only

— Nortel Ethernet Redundant Power Supply Unit 15

e internal power source plus external power source
— Nortel Ethernet Redundant Power Supply Unit 15

You can add an external power source to the 4550T-PWR and the
4548-GT-PWR. You can use an optional power and control cable for this
purpose and plug it in the back of the switch.

You can allocate a maximum of 16 W of power for each port to the PoE
devices connected to the 4550T-PWR or the 4548-GT-PWR. You can
allocate power by using the physical power sources.

The power sources are physically attached to the switch. You can have only
the internal power or you can attach an optional Nortel Ethernet Redundant
Power Supply Unit 15. Ensure that you know the actual physical power
sources for your 4550T-PWR or your 4548-GT-PWR.

Internal power source only option
Using the 4550T-PWR or the 4548-GT-PWR switch and its internal power
source only option, you have a total of 320 W of available power. You can
power up to 48 ports at 6.6 W for each port with this configuration or 20
ports at a maximum power of 15.4 W for each port.

The following figure illustrates the switch operating on internal power source
only.
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Nortel Ethernet Routing Switch 4548GT-PWR operating on internal power
source only
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Up to 20 ports at 15.4 watts/port

"Power source and available power for powered devices" (page 152)
describes the power source and available power by using only the internal
power source option.

Power source and available power for powered devices

Power Source Available Power for Powered Devices
AC Connection 320 W

External power source only option
Using the Nortel Ethernet Routing Switch 4500 Series 4550T-PWR and the
4548-GT-PWR switches and their external power source, your only option
(Nortel Ethernet Redundant Power Supply Unit 15) is a total of 320W of
available power. You can power up to 48 ports at 6.6W for each port with
this configuration or 20 ports at the maximum power of 15.4W for each port.

The following figure illustrates the Nortel Ethernet Routing Switch
4548GT-PWR operating only on the external power source.
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Nortel Ethernet Routing Switch 4548GT-PWR operating on Nortel Ethernet
RPS 15 as an external power source only

Nortel Ethernet RPS 15
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"Power source and available power for powered devices" (page 153)
describes the power source and available power by only using the external
power source option.

Power source and available power for powered devices

Power Source Available Power for Powered Devices
Nortel Ethernet RPS 320 W
15

Power sharing option
"Power-sharing with the Nortel Ethernet Routing Switch 4548GT-PWR and
the Nortel Ethernet RPS 15" (page 154) shows the use of the 4548-GT-PWR
with the Nortel Ethernet 15 RPS as an external power source with the
power-sharing configuration.

In this case, the internal power (AC) source is connected along with the
Nortel Ethernet 10 PSU (DC) source. This power-sharing configuration
supplies 740 W to the 4548-GT-PWR. This enables all 48 ports to supply
the maximum power of 15.4 W for each port.
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Power-sharing with the Nortel Ethernet Routing Switch 4548GT-PWR and
the Nortel Ethernet RPS 15

Nortel Ethernet RPS 15
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Up to 48 ports at 15.4 watts/port

"Power availability for power sharing with external power source" (page 154)
shows the available POE power when you configure an Nortel Ethernet
Routing Switch 4548GT-PWR or 4550T-PWR for power sharing along with
an external power source.

Power availability for power sharing with external power source

Power Source Available Power for Powered Devices
AC 320 W
Nortel Ethernet RPS 15 320 W
Total Power (Power Sharing) 740 W

With the addition of the Nortel Ethernet RPS 15, you have a total of 740 W
of PoOE non redundant power, which provides up to 48 ports to be powered
at 15.4 W.

Power Supply Unit (PSU) option
An external power source (Nortel Ethernet RPS 15) can provide redundant
power to the Nortel Ethernet Routing Switch 4548GT-PWR or to the
4550T-PWR. That is, the power fails over to the Nortel Ethernet RPS 15 in
case a problem occurs with the switch internal power.

The following figure illustrates the use of the4548-GT-PWR switch with the
Nortel Ethernet RPS 15 as an external power source with RPS configuration.
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Nortel Ethernet Routing Switch 4548GT-PWR and the Nortel Ethernet RPS 15
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If the Nortel Ethernet Routing Switch 4548GT-PWR supplies 320 W of
power to a powered device and the supply to the internal power source is
interrupted, the power to all powered devices is uninterrupted due to failover
to the Nortel Ethernet RPS 15.

"Power availability with the PSU option" (page 155) shows the available PoE
power when you configure a Nortel Ethernet Routing Switch 4548GT-PWR
for RPS with an external power source.

Power availability with the PSU option

Power Source Available Power for Powered Devices
AC 320 W
Nortel Ethernet RPS 15 320 W
Total Power (RPS) 320 W

By using the Nortel Ethernet RPS 15, you have a total of 320 W of PoE
redundant power, which provides 6.6 W of power to up to 48 ports..

Diagnosing and correcting PoE problems
This section discusses some common problems that you can encounter
while using the PoE features of the Nortel Ethernet Routing Switch
4548GT-PWR and the 4550T-PWR.
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Messages
"Error messages displayed by PoE ports" (page 156) describes the error
messages displayed by a port that supports PoE.

Error messages displayed by PoE ports

Error Message Descriptions

Detecting The port detects an IP device that is requesting
power.

Delivering power The port delivers the requested power to the
IP device.

Disabled The port power state is disabled.

Invalid PD The port detects a device that is not authorized
to request for power.

Deny low priority Power is disabled from the port because of
port setting and demands on power budget.

Overload Power is disabled from the port because the
port is overloaded.

Test The port is in testing mode. This was set by
using SNMP.

Error An unspecified error condition occurred.

Connecting the PSU
Perform the following steps in the order specified to connect the PSU to the
Nortel Ethernet Routing Switch 4548GT-PWR or the 4550T-PWR.

Step Action

1 Plug the external power source into the DC connector receptacle on
the back of the switch by using the 2-pin power connector and the
10-pin control connector.

2 Attach the ground lug on a cable to a grounding point.
3 Plug the power cord from the Nortel Ethernet RPS 15 into the wall
outlet.
4 Plug the power cord from switch into the wall outlet.
—End—

The following figure illustrates three Nortel Ethernet RPS 15s connected to
the back of a stack of three Nortel Ethernet Routing Switch 4548GT-PWR
switches.
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Note: A screw connects the ground wire, and a star washer is on the
base of the Nortel Ethernet Routing Switch 4548GT-PWR.

External power source connected to back of the Nortel Ethernet Routing Switch 4548GT-PWR

1°]

1°]

Power management
The Nortel Ethernet Routing Switch 4548GT-PWR and the 4550T-PWR use
several device-management systems, such as the Web-based Management
Interface, the CLI, and Device Manager (DM), as well as Enterprise for
network-level management services.

By using the CLI, Web, or DM, you can configure the level of power to
specific ports, and enable or disable power to each port. You can set the
maximum power level for each port by increments of 1 W—in the range of 3
W to 16 W. The default power level for each port is 16 W.

You can configure the power priority of each port by choosing low, high, or
critical power priority settings. The switch automatically drops low-priority
ports when the power requirements exceed the available power budget. If
the power requirements are lower than the switch power budget, the power
returns to the dropped port.

For example, assume the following scenario:

e ports 1 to 40 are configured as low priority

* port 41 is configured as high priority

e ports 1 to 40 are connected to powered devices

* devices on ports are consuming all the available switch power
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* adevice is connected to port 41 and requests power

In this scenario, the Nortel Ethernet Routing Switch 4548GT-PWR provides
power to the device on port 41 because that port is configured as high
priority. However, to maintain the power budget, the switch drops one of
the ports configured as low priority. As all the other ports (1 to 40) are
configured with a low priority, the switch drops power to the highest port
number. In this case, the switch drops power to port 40 and provides power
to port 41. If another port drops power, the switch automatically reinstates
power to port 40.

You configure the autodiscovery power process as either IEEE
802.3af-compliant or IEEE 802.3af-draft-compliant and legacy:

* 802.3af: detection method described in the IEEE 802.3af draft standard

* legacy: detection standard in use prior to the IEEE 802.3af draft
standard

The default value is IEEE 802.3af-draft-compliant. You can set this
parameter for the entire switch; you cannot set the discovery mode for each
port.

You can obtain power usage information from the management systems.
Statistics do not accumulate. The system automatically disconnects the port
from power when it detects an overload on any port, and the remainder of
the ports remain functional.

Note: Ensure that you set the switch for the power- detection mode used
by the connected powered device. Consult the device documentation
for this information.

Configuring PoE using the CLI
The following section describes the commands necessary to configure PoE
using the CLI:

e "Set port power enable or disable" (page 159)
* "Set port power priority" (page 159)

* "Set power limit for channels” (page 159)

« "Set traps control" (page 160)

e "Show main power status" (page 160)

* "Set power usage threshold" (page 160)

¢ "Setting PoE detection method" (page 161)

e "Show port power status" (page 161)

* "Show port power measurement” (page 161)
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Set port power enable or disable
Use the poe-shutdown command to disable PoE to a port.

The syntax for the poe-shutdown command is

poe poe-shutdown [port <portlist>]

Use the no poe-shutdown command to enable PoE to a port.
The syntax for the no poe-shutdown command is

no poe-shutdown [port <portlist>]

In either command, substitute <portlist> with the ports on which PoE is
enabled or disabled.

Run the poe-shutdown and no poe-shutdown commands in Interface
Configuration command mode.

Set port power priority
The poe-priority command sets the port power priority.

The syntax for the poe-priority command is

poe poe-priority [port <portlist>] {critical | high | low}

"poe-priority parameters” (page 159) outlines the parameters for this
command.

poe-priority parameters

Parameter Description
port <portlist> The ports to set priority for
{low | high | critical} The PoE priority for the port

Run the poe-priority command in Interface Configuration command
mode.

Set power limit for channels
The poe-1limit command sets the power limit for channels.

The syntax for the poe-1imit command is

poe poe-limit [port <portlist>] <3-16>
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"poe-limit parameters" (page 160) outlines the parameters for this command.

poe-limit parameters

Parameter Description
port <portlist> The ports to set the limit on
<3 -16> The power range to limit at from 3 to 16 W

Run the poe-1imit command in Interface Configuration command mode.

Set traps control
The poe-trap command enables PoE-related traps for POE-enabled ports.

The syntax for the poe-trap command is

poe poe-trap [unit <1-8>]

Substitute <1-8> with the number of the unit on which to enable traps.

Show main power status
The show poe-main-configuration command displays the power
configuration.

The syntax for the show poe-main-configuration command is

show poe-main-status [unit <1-8>]

Substitute <1-8> with the number of the unit for which to display the
configuration.

Run the show poe-main-status command in Privileged EXEC
command mode.

Set power usage threshold
The poe-power-usage-threshold command sets the power usage
threshold in percentage on individual units.

The syntax for the poe-power-usage-threshold command is

poe poe-power-usage-threshold [unit <1-8>] <1-99>
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"poe-power-usage-threshold parameters" (page 161) outlines the
parameters for this command.

poe-power-usage-threshold parameters

Parameter Description
unit <1 - 8> The unit for which to set the power threshold.
<1-99> 1—99 percent

Run the show poe-main-configure command in Global Configuration
command mode.

Setting PoE detection method

The poe-pd-detect-type command enables either 802.3af or Legacy
compliant PD detection methods.

The syntax for the poe-pd-detect-type 802dot3af and legacy
command is

poe poe-pd-detect-type [unit <1-8>] {802dot3af |
802dot3af and legacy}

Run the poe-pd-detect-type 802dot3af and legacy command in
Global Configuration command mode.

Show port power status

The show port power status command displays the power
configuration.

The syntax for the show port power status command is

show poe-port-status [<portlist>]

Substitute <portlist> with the ports for which to display configuration.

Run the show poe-port-status command in Global Configuration
command mode.

Show port power measurement

The show port power measurement command displays the power
configuration.

The syntax for the show port power measurement command is

show poe-power-measurement [<portlist>]

Substitute <port1ist> with the ports for which to display configuration.
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Run the show poe-power-measurement command in Global
Configuration command mode.

Viewing PoE ports using the JDM
The front panel view of the Java Device Manager provides additional
information for PoE ports on the Nortel Ethernet Routing Switch
4548GT-PWR. This additional information is in the form of a colored P
that appears inside the graphic representation of the port. This colored P
represents the current power aspect of the PoE port.

"Nortel Ethernet Routing Switch 4548GT-PWR" (page 162) displays an
example of the front panel view of a Nortel Ethernet Routing Switch
4548GT-PWR.

Nortel Ethernet Routing Switch 4548GT-PWR
Device Edt Graph WLAN Qo5 Rmon Actions Help

EROEEERIEFEE

454BGT PWR

2 22 B ¥ 2 ¥ 3} W W ¥ 4 8 K 4
nUze

L i
Q el ﬂﬂﬂﬂ H.JJEADQ ELJQ

B O® B 20 2 24 26 28 I 3} M B I/ 40 42 M 46 48

"Power Aspect color codes" (page 162) explains the different colors
displayed by the power aspect.

Power Aspect color codes

Color Description
Green The port is currently delivering power.
Red The power and detection mechanism for the

port is disabled.

Orange The power and detection mechanism for the
port is enabled. The port is not currently
delivering power.

White/Gray The power and detection mechanism for the
port is unknown.

Note: The data and power aspect coloring schemes are independent
of each other. You can view the initial status for both data and power
aspect for the port. To refresh the power status, right-click the unit, and
select Refresh PoE Status from the shortcut menu.
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Configuring PoE using the JDM
For information about configuring Power over Ethernet (PoE) using the
Java Device Manager, see "Editing and viewing switch PoE configurations"
(page 237).

Configuring PoE using the Web-based Management Interface
The following sections describe PoE configuration and management using
the Web-based Management Interface:

* "Configuring power management on the switch" (page 163)

¢ "Configuring power management for the ports" (page 165)

Configuring power management on the switch
Use the Global Power Management screen to configure and view power
settings for the switch.

To configure power management, complete the following procedure.

Step Action

1 Open the Global Power Management screen by selecting
Configuration > POE Management > Global Power Management.
The following figure illustrates the Global Power Management dialog
box.

r
Configuration > Power Management > Global Power Management

Unit
Global Power Management
Available DTE Power 320 Watt
DTE Power Status MNarmal
DTE Power Consumption 0 WWatt

DTE Power Usage Threshold |50 % 1..83)

Power Pair Signal
Traps Control Enable =
PD Detect Type 802 3af and Legacy
Power Source Present AC Only
AC Power Status Present
DC Power Status Mat present
" Submit_J
2 Enter the required settings.

3 Click Submit.
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—End—

"Global Power Management fields" (page 164) describes the items on the
Global Power Management dialog box.

Global Power Management fields

Item Description

Available DTE Power The power provided by the Ethernet Routing
Switch 4500 to the devices. The range of
power that is available from internal power
supply is 320 W to 740 W.

DTE Power Status The status of the PoE feature. The values that
maybe displayed are Normal or Error.

DTE Power Consumption The total power usage.

Power Pair The Power Pair (part of the RJ-45 pin
connectors) that you chose to supply power.

DTE Power Usage Threshold | The power usage threshold, inserted by user.

Traps Control The status of the traps control. You can enable
or disable this feature.

PD Detect Type The standard that you use for power detection.
The standard that you select can be one of the
following:

+ |EEE 802.3af
* |EEE 802.3af and legacy.

Power Source Present The mode of power supply that the Ethernet
Routing Switch 4500 currently uses. The mode
of power supply can be one of the following
values:

e AC only: signifies that the switch uses
internal power supply.

* DC only: signifies that the switch uses
external power supply.

* AC and DC: signifies that the switch uses
both external and internal

This is a read-only field.
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T

Item Description
AC Power Status The status of the AC power supply.
DC Power Status The status of the DC power supply.

Configuring power management for the ports
Configuring power management for the ports involves setting a priority for
the ports on the switch.

To configure power management for the ports, complete the following

procedure.
Step Action
1 Open the Port Property page by selecting Configuration > PoE

Management > Port Property. The following figure illustrates the
Port Property dialog box..

| & Tk oz, 2hirs, help 2d format

Configuration » Power Management = Port Property q
Part Prowear Satfting

Unit n

1 Frabled |  Detactng n [1h [law =] 0n 1 nmn
2 ‘Enablad |  Detsctng 0 [16 low =] 03 O 0.010
J Cnobled =|  Detectng 0 [16 [Low =] nD 0 0,030
4 ‘Enabled =]  Detectng 0 [16 low =] 00 0 0.000
5 ‘Enablad |  Detsctng 0 [16 [low =] 00 0 0.010
6 Cnobled =] Detectng 0 [15 lew =] 00 0O 0,030
T ‘Enabled =]  Detectng 0 [16 [Low =] 0o 0 0.000
g ‘Ensblad |  Detsctng 0 [16 low = 03 O 0.010
g ‘Enahled =]  Detectng 0 [15 [low =] nD O 0,030
0 [Enabled x|  Detectng 0 [16 [low =] oo 0 0.000
1 [Enabled x| Detectng 0 [16 [low =] 00 0 0.010
12 [Enchled ~]  Detectng 0 [15 [low =] nD O 0,030
Swtch |Enabled ] 6 Juw =l

Sack | Enabled | [ il r Low x|

unit [
[ submt ]

2 Enter the required settings.
3 Click Submit .
—End—
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"Port Property fields" (page 166) describes the items on the Port Property
fields.

Port Property fields

Item Description

Port The port number.

Admin. Status Set the power status to one of the following:
* Enabled
* Disabled

The default value is Enabled.

Current Status The current status of the port, which is one of the
following values:

+ Disable
« Detecting
* Detected

* Delivering Power

e Error
¢ Invalid PD
e Test

* Deny Low Priority

* Overload
Classification The operational status of the port PD classification.
Limit (W) Set the maximum power that the switch can supply to

a port. The default value is 16W.

Priority Set the priority of a port. The Priority of a port is used
to detect the ports that can be dropped when the power
requirements exceed the available power budget.

The priority that can be assigned to a port can be one
of the following:

e Low
e High
e Critical
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Item Description

Power to the dropped ports is restored when the power
requirement becomes lower than the power budget.
When several ports have the same priority, the port
with the higher port number is dropped.

Volt (v) The voltage supplied by the port.
Current (mA) The current supplied by the port.
Power (W) The power supplied by the port.
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Switch administration tasks

This chapter describes basic switch administration tasks that apply to no
specific switch application. For complete information about administration
tasks specific to a switch application, consult the appropriate book.

This chapter contains the following topics:
e "General switch administration using the CLI" (page 169)

e "General Switch Administration using the Web-based Management
Interface" (page 194)

e "General Switch Administration using the JDM" (page 207)

General switch administration using the Command Line Interface
This section describes the Command Line Interface (CLI) commands used
in general switch administration. This section contains the following topics:

e "Multiple switch configurations" (page 170)

¢ New Unit Quick Configuration

* |IP blocking

e "Assigning and clearing IP addresses" (page 171)

« "Assigning and clearing IP addresses for specific units" (page 174)
* "Displaying Interfaces" (page 175)

» "Setting port speed" (page 176)

* "Enabling Autotopology" (page 179)

* "Enabling rate-limiting" (page 183)

* "Using Simple Network Time Protocol" (page 185)

e "Clock configuration" (page 189)

» "Custom Autonegotiation Advertisements" (page 189)

* "Connecting to Another Switch" (page 190)

e "Domain Name Server (DNS) Configuration" (page 192)
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Multiple switch configurations
The Nortel Ethernet Routing Switch 4500 Series supports the storage
of two switch configurations in flash memory. The switch can use either
configuration and must be reset for the configuration change to take effect.

A regular reset of the switch synchronizes configuration changes to the
active configuration, whereas a reset to defaults sets configuration to factory
defaults. The inactive block is not affected.

In stack configurations, all units in the stack must use the same active
configuration. If a unit joins a stack, a check is performed between the unit
active configuration and the stack active configuration. If the two differ, the
new stack unit resets and loads the stack active configuration.

Use the following CLI commands to configure and use multiple switch
configuration:

¢ "show nvram block command" (page 170)

¢ "copy config nvram block command" (page 170)

» "copy nvram config block command" (page 171)

show nvram block command

This command shows the configurations currently stored on the switch. The
syntax for this command is

show nvram block

Run this command in Global Configuration command mode.

copy config nvram block command

This command copies the current configuration to one of the flash memory
locations. The syntax for this command is

copy config nvram block <1-2> name <block name>

"copy config nvram block parameters" (page 170) outlines the parameters

for this command.

copy config nvram block parameters

Parameter Description

block <1—2> The flash memory location to store the configuration.

name <block_name> | Name to attach to this block. Names can be up to 40
characters in length with no spaces.

Run this command in Global Configuration command mode.
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copy nvram config block command

This command copies the configuration stored in flash memory at the
specified location and makes it the active configuration. The syntax for
this command is

copy nvram config block <1-2>

Substitute <1-2> with the configuration file to load.
This command resets the switch to reset so that the new configuration load.

Run this command in Global Configuration command mode.

Assigning and clearing IP addresses
Use the CLI, to assign, clear, and view IP addresses and gateway
addresses. For details, see the following sections:

¢ "ip address command" (page 171)

e "no ip address command" (page 172)

e "ip default-gateway command" (page 172)

* "no ip default-gateway command" (page 173)
* "show ip command" (page 173)

ip address command

The ip address command sets the IP address and subnet mask for the
switch or a stack.

The syntax for the ip address command is

ip address [stack | switch | unit] <XXX.XXX.XXX.XXX> [netmask
<XXX.XXX.XXX.XXX>

Run the ip address command in Global Configuration command mode.

If the stack or switch parameter is not specified, the system automatically
modifies the stack IP address when in stack mode and modifies the switch
IP address when in stand-alone mode.
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"ip address parameters" (page 172) describes the parameters for the ip
address command.

ip address parameters

Parameters Description

Set the IP address and netmask of the stack or the

stack | switch | unit switch, or another unit in at a stack..

XXX XXX XXX XXX Enter the IP address in dotted-decimal notation;
netmask is optional.

netmask The IP subnet mask for the stack or switch.

Note: When you change the IP address or subnet mask, connectivity to
Telnet and the Web can be lost.

no ip address command

The no ip address command clears the IP address and subnet mask for
a switch or a stack. This command sets the IP address and subnet mask for
a switch or a stack to all zeros (0).

The syntax for the no ip address command is

no ip address {stack | switch | unit}

Run the no ip address command in Global Configuration command
mode.

"no ip address parameters" (page 172) describes the parameters for this
command.

no ip address parameters

Parameters Description

stack | switch Zeroes out the stack IP address and subnet mask or
the switch IP address and subnet mask.

unit Zeroes out the IP address for the specified unit.

Note: When you change the IP address or subnet mask, connectivity to
Telnet and the Web Interface can be lost. Any new Telnet connection
can be disabled and must connect to the serial console port to configure
a new IP address.

ip default-gateway command
The ip default-gateway command sets the default IP gateway address
for a switch or a stack to use.

The syntax for the ip default-gateway command is
e

Nortel Ethernet Routing Switch 4500 Series
Overview — System Configuration
NN47205-500 02.01 Standard
5.0 23 February 2007
Copyright © 2007, Nortel Networks Nortel Networks Confidential



General switch administration using the Command Line Interface 173
T

ip default-gateway <XXX.XXX.XXX.XXX>

Run the ip default-gateway command in Global Configuration
command mode.

"ip default-gateway parameters” (page 173) describes the parameters for
the ip default-gateway command.

ip default-gateway parameters

Parameters Description
XX XXX XXX XXX Enter the dotted-decimal IP address of the default IP
gateway.

Note: When you change the IP gateway, connectivity to Telnet and the
Web Interface can be lost.

no ip default-gateway command
The no ip default-gateway command sets the IP default gateway
address to zero (0).

The syntax for the no ip default-gateway command is

no ip default-gateway

Run the no ip default-gateway command in Global Configuration
command mode.

Note: When you change the IP gateway, connectivity to Telnet and the
Web Interface can be lost.

show ip command

The show ip command displays the IP configurations, BootP mode,
stack address, switch address, subnet mask, and gateway address. This
command displays these parameters for what is configured, what is in use,
and the last BootP. The sub command, Display DNS configuration,
provides information about the DNS configuration.

The syntax for the show ip command is

show ip [bootp] [default-gateway] [address]

Run the show ip command in User EXEC or Privileged EXEC command
mode.

If you do not enter any parameters, this command displays all IP-related
configuration information.

Nortel Ethernet Routing Switch 4500 Series
Overview — System Configuration
NN47205-500 02.01 Standard
5.0 23 February 2007
Copyright © 2007, Nortel Networks Nortel Networks Confidential



174 Switch administration tasks
B |

"show ip parameters" (page 174) describes the parameters and variables
for the show ip command.

show ip parameters

Parameters and i

. Description
variables
bootp BootP-related IP information.
default-gateway The IP address of the default gateway.
address The current IP address.

Assigning and clearing IP addresses for specific units
You can use the CLI to assign and clear IP addresses for a specific unit in
a stack. For details, see the following sections:

¢ "ip address unit command" (page 174)

e "no ip address unit command" (page 174)
» "default ip address command" (page 175)
ip address unit command

The ip address unit command sets the IP address and subnet mask of
a specific unit in the stack.

The syntax for the ip address unit command is

ip address unit <1-8> [A.B.C.D]

Run the ip address unit command in Global Configuration command
mode.

"ip address unit parameters" (page 174) describes the parameters this
command.

ip address unit parameters

Parameters and .
. Description
variables
unit <1—8> Sets the unit you are assigning an IP address.
A.B.C.D Enter IP address in dotted-decimal notation.

Note: When the IP address or subnet mask changes, connectivity to
Telnet and the Internet can be lost.

no ip address unit command
The no ip address unit command sets the IP address for the specified
unit in a stack to zeros (0).
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The syntax for the no ip address unit command is

no ip address unit <1-8>

Run the no ip address unit command in Global Configuration
command mode.

"no ip address parameters" (page 175) describes the parameters this
command.

no ip address parameters

Parameters and

. Description
variables P

unit <1—8> Zeroes out the IP address for the specified unit.

Note: When you change the IP address or subnet mask, connectivity to
Telnet and the Internet can be lost.

default ip address command
The default ip address command sets the IP address for the specified
unit in a stack to all zeros (0).

The syntax for the default ip address command is

default ip address

Run the default ip address command in Global Configuration
command mode.

Note: When the IP gateway changes, connectivity to Telnet and the
Internet can be lost.

Displaying Interfaces
You can view the status of all interfaces on the switch or stackd, including
MultiLink Trunk membership, link status, autonegotiation, and speed.

show interfaces command
The show interfaces command displays the current configuration and
status of all interfaces.

The syntax for the show interfaces command is

show interfaces [names] [<portlist>] [gbic-info]

Run the show interfaces command in User EXEC command mode.
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"show interfaces parameters" (page 176) describes the parameters and
variables for the show interfaces command.

show interfaces parameters

Parameters and o
. Description

variables

names <portlist> Display interface names; enter specific ports to see
only those ports .

ghic-info Display GBIC details.

LINE Display a list of existing ports with names (displays
interface names).

Setting port speed
To set port speed and duplexing using the CLlI, see the following sections:

e ‘"speed command" (page 176)
« "default speed command" (page 177)
e "duplex command" (page 177)
» "default duplex command" (page 178)

speed command
The speed command sets the port speed.

The syntax for the speed command is

speed [port <portlist>] {10 | 100 | 1000 | auto}

Run the speed command in Interface Configuration command mode.

"speed parameters” (page 176) describes the parameters and variables for
the speed command.

speed parameters

Parameters and

. Description
variables P

port <portlist> Specify the port numbers to configure the speed. Enter
the port numbers you want to configure.
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Parameters and

variables Description
Note: If you omit this parameter, the system uses the
port number you specified in the interface command.
10|100|1000]auto Set the speed to

e 10: 10 Mb/s
e 100: 100 Mb/s
e« 1000: 1000 Mb/s or 1 GB/s

e auto: autonegotiation

Note: Enabling or disabling autonegotiation for speed also enables
or disables it for duplex operation.

When you set the port speed for autonegotiation, ensure that the other
side of the link is also set for autonegotiation.

default speed command
The default speed command sets the port speed to the factory default
speed.

The syntax for the default speed command is

default speed [port <portlist>]

Run the default speed command in Interface Configuration command
mode.

"Default speed parameters" (page 177) describes the parameters for this
command.

Default speed parameters

Parameters and

. Description
variables P

port <portlist> Specify the port numbers for which to set the speed to
factory default. Enter the port numbers to set.

Note: If you omit this parameter, the system uses the
port number you specified in the interface command.

duplex command
The duplex command specifies the duplex operation for a port.
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The syntax for the duplex command is

duplex [port <portlist>] {full | half | auto}

Run the duplex command in Interface Configuration command mode.

"Duplex parameters" (page 178) describes the parameters for this
command.

Duplex parameters

Parameters and

. Description
variables P

port <portlist> Specify the port numbers to reset the duplex mode
to factory default values. Enter the port number to
configure. The default value is autonegotiation.

Note: If you omit this parameter, the system uses the
ports you specified in the interface command.

full | half | auto Set duplex to

e full: full-duplex mode
e half: half-duplex mode

e auto: autonegotiation

Note: Enabling or disabling autonegotiation for speed also enables
or disables it for duplex operation.

When you set the duplex mode for autonegotiation, ensure that the other
side of the link is also set for autonegotiation.

default duplex command
The default duplex command sets the duplex operation for a port to the
factory default duplex value.

The syntax for the default duplex command is

default duplex [port <portlist>]

Run the default duplex command in Interface Configuration command
mode.
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"Default duplex parameters" (page 179) describes the parameters for this
command.

Default duplex parameters

Parameters and

. Description
variables P

port <portlist> Specify the port numbers for which to reset the duplex
mode to factory default values. Enter the port numbers
to configure. The default value is autonegotiation.

Note: If you omit this parameter, the system uses the
ports you specified in the interface command.

Enabling Autotopology
Use CLI to configure the Enterprise Autotopology protocol.

For more information about Autotopology, see http://www.nortel.com/support.
(The product family for Enterprise and Autotopology is Data and Internet.)

To enable autotopology using the CLI, see the following sections:
« "autotopology command" (page 179)

¢ "no autotopology command" (page 179)

» "default autotopology command" (page 180)

¢ "show autotopology settings command" (page 180)

e "show autotoplogy nmm-table command" (page 180)

autotopology command
The autotopology command enables the Autotopology protocol.

The syntax for the autotopology command is

autotopology
Run the autotopology command in Global Configuration command mode.

no autotopology command
The no autotopology command disables the Autotopology protocol.

The syntax for the no autotopology command is

no autotopology

Run the no autotopology command in Global Configuration command
mode.
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default autotopology command
The default autotopology command enables the Autotopology
protocol.

The syntax for the default autotopology command is

default autotopology

Run the default autotopology command in Global Configuration
command mode.

The default autotopology command has no parameters or values.

show autotopology settings command
The show autotopology settings command displays the global
autotopology settings.

The syntax for the show autotopology settings command is

show autotopology settings

Run the show autotopology settings command in Privileged EXEC
command mode.

The show autotopology settings command has no parameters or
values.

show autotoplogy nmm-table command
The show autotopology nmm-table displays the Autotopology network
management module (NMM) table.

The syntax for the show autotopology nmm-table command is

show autotopology nmm-table

Run the show autotopology nmm-table command in Privileged EXEC
command mode.

The show autotopology nmm-table command has no parameters or
values.

Enabling flow control
Gigabit Ethernet, when used with the Nortel Ethernet Routing Switch 4500
Series, can control traffic on this port using the £lowcontrol command.

Note: Due to Quality of Service (QoS) interaction, the Ethernet Routing
Switch 4500 cannot send pause-frames.
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To enable flow control using the CLI, see the following sections:
e "flowcontrol command" (page 181)

¢ "no flowcontrol command" (page 181)

« "default flowcontrol command" (page 182)

flowcontrol command

Use the flowcontrol command only on Gigabit Ethernet ports to control
the traffic rates during congestion.

The syntax for the £lowcontrol command is

flowcontrol [port <portlist>] {asymmetric | symmetric | auto
| disable}

Run the flowcontrol command in Interface Configuration mode.

"Flowcontrol parameters" (page 181) describes the parameters for this
command.

Flowcontrol parameters

Parameters and

variables Description

port <portlist> Specify the port numbers to configure for flow control.
Note: If you omit this parameter, the system uses the
ports you specified in the interface command but
only those ports that have speed set to 1000/full.

asymmetric | Set the mode for flow control:

symmetric | auto |

disable

e asymmetric: PAUSE frames can flow only in one
direction.

« symmetric: PAUSE frames can flow in either
direction.

e auto: Set the port to automatically determine the
flow control mode (default).

« disable: Disable flow control on the port.

no flowcontrol command
Use the no flowcontrol command only on Gigabit Ethernet ports to
disable flow control.

The syntax for the no flowcontrol command is
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no flowcontrol [port <portlist>]

Run the no flowcontrol command in Interface Configuration mode.

"No flowcontrol parameters" (page 182) describes the parameters for this
command.

No flowcontrol parameters

Parameters and

variables Description
port <portlist> Specify the port numbers for which to disable flow
control.

Note: If you omit this parameter, the system uses the
ports you specified in the interface command, but
only those ports that have speed set to 1000/full.

default flowcontrol command

Use the default flowcontrol command only on Gigabit Ethernet
ports to set the flow control to automatic, which automatically detects the
flow control.

The syntax for the default flowcontrol command is

default flowcontrol [port <portlist>]

Run the default flowcontrol command in Interface Configuration
mode.

"Default flowcontrol parameters" (page 182) describes the parameters for
the command.

Default flowcontrol parameters

Parameters and

variables Description
port <portlist> Specify the port numbers to default to automatic flow
control.

Note: If you omit this parameter, the system uses the
port number you specified in the interface command.
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Enabling rate-limiting
The percentage of multicast traffic, or broadcast traffic, or both, can be
limited using the CLI. For details, see the following sections:

» "show rate-limit command" (page 183)
¢ rate-limit command" (page 183)

¢ "no rate-limit command" (page 184)

» "default rate-limit command" (page 184)
show rate-limit command

The show rate-limit command displays the rate-limiting settings and
statistics.

The syntax for the show rate-limit command is

show rate-limit

Run the show rate-limit command in Privileged EXEC command
mode.

rate-limit command
The rate-1imit command configures rate-limiting on the port.

The syntax for the rate-1imit command is

rate-limit [port <portlist>] {multicast <pct> | broadcast
<pct> | both <pct>}

Run the rate-1imit command in Interface Configuration command mode.

"Rate-limit parameters" (page 183) describes the parameters for this
command.

Rate-limit parameters

Parameters and i
Description
values
port <portlist> Specify the port numbers to configure for rate-limiting.
Enter the port numbers to configure.
Note: If you omit this parameter, the system uses the
port number you specified in the interface command.
multicast <pct> | Apply rate-limiting to the type of traffic. Enter an integer
broadcast <pct> | from 1 to 10 to set the rate-limiting percentage:
both <pct>
* multicast: Apply rate-limiting to multicast packets.
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Parameters and

Description
values

* broadcast: Apply rate-limiting to broadcast
packets.

* both: Apply rate-limiting to both multicast and
broadcast packets.

no rate-limit command
The no rate-limit command disables rate-limiting on the port.

The syntax for the no rate-limit command is:

no rate-limit [port <portlist>]

Run the no rate-limit command in Interface Configuration command
mode.

"No rate-limit parameters" (page 184) describes the parameters for this
command.

No rate-limit parameters

Parameters Description

port <portlist> Specify the port numbers to disable for rate-limiting.
Enter the port numbers to disable.

Note: If you omit this parameter, the system uses the
port number you specified in the interface command.

default rate-limit command
The default rate-limit command restores the rate-limiting value for
the specified port to the default setting.

The syntax for the default rate-limit command is

default rate-limit [port <portlist>]

Run the default rate-limit command in Interface Configuration
command mode.
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"Default rate-limit parameters” (page 185) describes the parameters for
this command.

Default rate-limit parameters

Parameters Description

port <portlist> Specify the port numbers to reset rate-limiting to factory
default. Enter the port numbers to set rate-limiting to
default.

Note: If you omit this parameter, the system uses the
port number you specified in the interface command.

Using Simple Network Time Protocol
The Simple Network Time Protocol (SNTP) feature synchronizes the
Universal Coordinated Time (UTC) to an accuracy within 1 second. This
feature adheres to the IEEE RFC 2030 (MIB is the s5agent). With this
feature, the system can obtain the time from any RFC 2030-compliant
NTP/SNTP server.

Note: If problems occur when you use this feature, try various NTP
servers. Some NTP servers can be overloaded or currently inoperable.

The system retries connecting with the NTP server a maximum of three
times, with 5 minutes between each retry.
Use SNTP to provide a real-time timestamp for the software, shown as
Greenwich Mean Time (GMT).

If you run SNTP, the system synchronizes with the configured NTP
server at boot-up and at user-configurable periods thereafter (the default
synchronization interval is 24 hours). The first synchronization does not
occur until network connectivity is established.

SNTP supports primary and secondary NTP servers. The system tries the
secondary NTP server only if the primary NTP server is unresponsive.

To configure SNTP, see the following commands:

e "Show SNTP command" (page 186)

* "show sys-info command" (page 186)

¢ "SNTP enable command" (page 186)

¢ "No SNTP enable command" (page 186)

* "SNTP server primary address command" (page 186)

¢ "SNTP server secondary address command" (page 187)

¢ "No SNTP server command" (page 187)
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* "SNTP sync-now command" (page 188)
¢ "SNTP sync-interval command" (page 188)
Show SNTP command

The show SNTP command displays the SNTP information, as well as the
configured NTP servers.

The syntax for the show SNTP command is

show sntp

Run the show SNTP command in Privileged EXEC command mode.

show sys-info command
The show sys-info command displays the current system characteristics.

The syntax for the show sys-info command is

show sys-info

Run the show sys-info command in Privileged EXEC command mode.

Note: You must have SNTP enabled and configured to display GMT
time.

SNTP enable command
The SNTP enable command enables SNTP.

The syntax for the SNTP enable command is

sntp enable

Run the SNTP enable command in Global Configuration command mode.
Note: The default setting for SNTP is Disabled.

No SNTP enable command
The no SNTP enable command disables SNTP.

The syntax for the no SNTP enable command is

no sntp enable

Run the no SNTP enable command in Global Configuration command
mode.

SNTP server primary address command
The SNTP server primary address command specifies the IP
addresses of the primary NTP server.
e
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The syntax for the SNTP server primary address command is

sntp server primary address <A.B.C.D>

Run the SNTP server primary address command in Global
Configuration command mode.

"SNTP server primary address parameters" (page 187) describes the
parameters for this command.

SNTP server primary address parameters

Parameters and

Variables Description

<A.B.C.D> Enter the IP address of the primary NTP server in
dotted-decimal notation.

SNTP server secondary address command
The SNTP server secondary address command specifies the IP
addresses of the secondary NTP server.

The syntax for the SNTP server secondary address command is

sntp server secondary address <A.B.C.D>

Run the SNTP server secondary address command in Global
Configuration command mode.

"SNTP server secondary address parameters" (page 187) describes the
parameters for this command.

SNTP server secondary address parameters

Parameters Description

<A.B.C.D> Enter the IP address of the secondary NTP server in
dotted-decimal notation.

No SNTP server command
The no SNTP server command clears the NTP server IP addresses. The
command clears the primary and secondary server addresses.

The syntax for the no SNTP server command is

no sntp server {primary | secondary}

Run the no SNTP server command in Global Configuration command
mode.
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"no SNTP server parameters” (page 188) describes the parameters for
this command.

no SNTP server parameters

Parameters Description
primary Clear the primary SNTP server address.
secondary Clear the secondary SNTP server address.

SNTP sync-now command
The SNTP sync-now command forces a manual synchronization with the
NTP server.

The syntax for the SNTP sync-now command is

sntp sync-now

Run the SNTP sync-now command in Global Configuration command
mode.

Note: SNTP must be enabled before this command can take effect.
SNTP sync-interval command
The SNTP sync-interval command specifies recurring synchronization
with the secondary NTP server in hours relative to initial synchronization.

The syntax for the SNTP sync-interval command is

sntp sync-interval <0-168>

Run the SNTP sync-interval command in Global Configuration
command mode.

"SNTP sync-interval parameters" (page 188) describes the for this
command.

SNTP sync-interval parameters

Parameters and

Variables Description

<0-168> Enter the number of hours for periodic synchronization
with the NTP server.

Note: 0 is boot-time only, and 168 is once a week.
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Clock configuration
In addition to SNTP time configuration, a clock provides the switch with time
information. This clock provides the switch information in the instance that
SNTP time is not available.

Use the following commands to view and configure the clock:
» "Clock source command" (page 189)
» default clock source

Clock source command
This command sets the default clock source for the switch.

The syntax for this command is

clock source {sntp | sysUpTime}

Substitute {sntp | sysUpTime} with the clock source selection.

Run this command in Global Configuration command mode.

Custom Autonegotiation Advertisements
Custom Autonegotiation Advertisement (CANA) customizes the capabilities
that are advertised. It also controls the capabilities that the Nortel Ethernet
Routing Switch 4500 Series advertises as part of the auto negotiation
process.

The following sections describe configuring CANA using the CLI:
e "Configuring CANA" (page 189)
e "Viewing current autonegotiation advertisements" (page 189)

* "Viewing hardware capabilities" (page 190)

"Setting default auto-negotiation-advertisements" (page 190)

¢ "no auto-negotiation-advertisements command" (page 190)

Configuring CANA
Use the auto-negotiation-advertisements command to configure
CANA.

To configure port 5 to advertise the operational mode of 10 Mb/s and full
duplex enter the following command:

auto-negotiation-advertisements port 5 10-full

Viewing current autonegotiation advertisements
To view the autonegotiation advertisements for the device, enter the
following command:
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show auto-negotiation-advertisements [port <portlist>]

Viewing hardware capabilities
To view the available operational modes for the device, enter the following
command:

show auto-negotiation-capabilities [port <portlist>]

Setting default auto-negotiation-advertisements
The default auto-negotiation-advertisements command makes
a port advertise all auto negotiation capabilities.

The syntax for the default auto-negotiation-advertisements
command is

default auto-negotiation-advertisements [port <portlist>]

To set default advertisements for port 5 of the device, enter the following
command:

default auto-negotiation-advertisements port 5

Run the default auto-negotiation-advertisements command in
Interface Configuration mode.

no auto-negotiation-advertisements command
The no auto-negotiation-advertisements command makes a port
silent.

The syntax for the no auto-negotiation-advertisements command
is

no auto-negotiation-advertisements [port <portlist>]

Run the no auto-negotiation-advertisements command in
Interface Configuration mode.

Connecting to Another Switch
Use the CLI to communicate with another switch while maintaining the
current switch connection, by running the ping and telnet commands.

ping command
Use the ping command to determine whether communication with another
switch can be established.

The ping command tests the network connection to another network device
by sending an Internet Control Message Protocol (ICMP) packet from the
switch to the target device.
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Note: You must set the local IP address before you issue the ping
command.

The syntax for this command is

ping <ip address | dns host name> [datasize <64-4096>]
[{count <1-9999>} | continuous] [{timeout | -t} <1-120>]
[interval <1-60>] [debug]

Substitute <ip address | dns_host name> with either the IP address
or the DNS host name of the unit to test.

Run this command in User EXEC command mode or any of the other
command modes.

ping parameters

Parameter Description

ip_address | dns_host_name IP address or DNS host name of the unit to
test.

datasize <64-4096> Specify the size of the ICMP packet to be sent.

The data size range is from 64 to 4096 bytes.

count <1-9999> | continuous Set the number of ICMP packets to be sent.
The continuous mode sets the ping running
until the user interrupts it by entering Ctrl+C.

timeout | -t | <1-120> Set the timeout using either the timeout with
the -t parameter followed by the number of
seconds the switch must wait before timing
out.

interval <1-60> Specify the number of seconds between
transmitted packets.

debug Provide additional output information such as
the ICMP sequence number and the trip time.

telnet command

Use the telnet command to establish communications with another switch
during the current CLI session. Communication can be established to only
one external switch at a time using the telnet command.

The syntax for this command is

telnet <ip address | dns_host name>

Substitute <ip address | dns_host name> with either the IP address
or the DNS host name of the unit with which to communicate.

Run this command in User EXEC command mode.
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Domain Name Server (DNS) Configuration
Use domain name servers when the switch needs to resolve a domain
name (such as nortel.com) to an IP address. Use the following commands
to configure the switch domain name servers:

* "show ip dns command" (page 192)

¢ "ip domain-name command" (page 192)

¢ "no ip domain-name command" (page 192)

» "default ip domain-name command" (page 193)

e "ip name-server command" (page 193)

¢ "no ip name-server command" (page 193)

show ip dns command

Use the show ip dns command to display DNS-related information. This

information includes the default switch domain name and any configured
DNS servers.

The syntax for this command is

show ip dns

Run this command in User EXEC command mode.

ip domain-name command

Use the ip domain-name command to set the default DNS domain name
for the switch. This default domain name is appended to all DNS queries or
commands that do not already contain a DNS domain name.

The syntax for this command is

ip domain-name <domain name>

Substitute <domain name> with the default domain name. A domain
name is deemed valid if it contains alphanumeric characters and at least
one period (.).

Run this command in Global Configuration command mode.

no ip domain-name command
Use the no ip domain-name command to clear a previously configured
default DNS domain name for the switch.

The syntax for this command is

no ip domain-name

Run this command in Global Configuration command mode.
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default ip domain-name command

Use the default ip domain-name command to set the system default
switch domain hame. Because this default is an empty string, this command
has the same effect as the no ip domain-name command.

The syntax for this command is:

default ip domain-name

Run this command in Global Configuration command mode.

ip name-server command

Use the ip name-server command to set the domain name servers the
switch uses to resolve a domain name to an IP address. A switch can have
up to three domain name servers specified for this purpose.

The syntax of this command is

ip name-server <ip address 1>
ip name-server [<ip address 2>]
ip name-server [<ip address 3>]

Note: To enter all three server addresses, you must enter the command
three times, each with a different server address.

"ip name-server parameters" (page 193) outlines the parameters for this
command.

i p name-server parameters

Parameter Description

<ip_address_1> The IP address of the domain name server
used by the switch.

<ip_address_2> Optional. The IP address of a domain name
server to add to the list of servers used by the
switch.

<ip_address_3> Optional. The IP address of a domain name
server to add to the list of servers used by the
switch.

Run this command in Global Configuration command mode.

no ip name-server command

Use the no ip name-server command to remove domain name servers
from the list of servers used by the switch to resolve domain names to an
IP address.

The syntax for this command is
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no ip name-server <ip address 1>
no ip name-server [<ip address 2>]
no ip name-server [<ip address 3>]

Note: To remove all three server addresses, you must enter the
command three times, each with a different server address.

"no ip name-server parameters" (page 194) outlines the parameters for
this command.

no ip name-server parameters

Parameter Description

<ip_address_1> The IP address of the domain name server to
remove.

<ip_address_2> Optional. The IP address of a domain name

server to remove from the list of servers used
by the switch.

<ip_address_3> Optional. The IP address of a domain name
server to remove from the list of servers used
by the switch.

Run this command in Global Configuration command mode.

General Switch Administration using the Web-based Management

Interface
This section contains the following topics:

* "Viewing stack information” (page 194)

* "Viewing summary switch information" (page 196)

¢ "Changing stack numbering" (page 197)

e "Identifying unit numbers" (page 199)

e "Configuring BootP, IP, and gateway settings" (page 200)
¢ "Modifying system settings" (page 203)

* "Managing remote access by IP address" (page 205)

e Configuring the Real-Time Clock

Viewing stack information

Note: The Embedded Web Server automatically detects the operational
mode of your system. If the system is in stand-alone mode, the Stack
Information page option is not listed in the menu.
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Step Action

1 Open the Stack Information screen by selecting Summary >
Stack Information from the menu. The following message box is
displayed.
4

Summary > Stack Information

Stack Information

System Description Ethernet Routing Switch 4548GT-PWR
Software Version va.0.0.103

MAC Address 00-16-CA-DA-C4-01

IP Address 192.167.120.43

Manufacturing Date Code 03312006

Serial # SDLIT001G

Operational State Normal

Stack Inventory

Br Pluggable|Pluggable|Pluggable|Pluggable| Software |Operational
(45) None (46) None (47) None (48) Mone
Ethernet Routing Switch 4548GT-PWR

48 ports 10/100/1000 BaseT with PoE v5.0.0.103 Mormal
and 4 shared SFP ports

|—

(49) None  (50) None

Ethernet Routing Switch 4550T 48
ports 10/100BaseT plus 2 v5.0.0.103 Normal
10/100/1000/SFP combo ports

I

—

—End—

The following table "Stack Information screen fields" (page 195) describes
the fields on the Stack Information and Stack Inventory sections of the Stack
Information screen.

Stack Information screen fields

Section Fields Description
Stack System Description The name created in the configuration process to identify
Information the stack.

Software Version The version of the running software.

MAC Address The MAC address of the stack.

IP Address The IP address of the stack.
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Section Fields Description
Manufacturing Date The date of manufacture of the board in ASCII format:
Code YYYYMMDD.
Serial Number The serial number of the base unit.
Operational State The current operational state of the device. The

operational states are Other, Not Available, Removed,
Disabled, Normal, Reset in Progress, Testing, Warning,
Non Fatal Errors, Fatal Error, and Not Configured.

Stack Unit The unit number assigned to the device by the network
Inventory manager. For more information about stack numbering,
see "Changing stack numbering" (page 197).
Description The description of the device or its subcomponent.
Pluggable port The SFP GBICs connected to the switch.
Software Version The current running software version.
Operational State The current operational state of the stack. The operational

states are Other, Not Available, Removed, Disabled,
Normal, Reset in Progress, Testing, Warning, Non Fatal
Errors, Fatal Error, and Not Configured.

Viewing summary switch information

Step Action

1 Open the Switch Information screen by selecting Summary >
Switch Information from the menu. The following message box is
displayed.

Summary > Switch Information q

Switch Information

Accras (RW) Etharmedt B Switeh 45480T-PWR 45 ports. 10510051000 BaseT wih PeE and & shared SFP ports
¥ Summary Pluggabie Port 45 Mone
& Swikch Infarmation Pluggatie Port 46 Mo
> Configueation Pluggabie Port 47 Hone
> Foull Pluggable Port 48 Mone:

> Smdstics

> Applications
> Administration
> Suppont

P Addreas 1012723230
Power Status. Primary Power. RPSU not present
Fan1# FaaZ R Fand A Fans il
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The following table "Switch Information page fields" (page 197)
describes the fields on the Switch Information screen.

Switch Information page fields

Item Description
Unit, if in a stack Select the number of the device on which to view summary
configuration information. The page is updated with information about the selected

switch. For more information about stack numbering, see "Changing
stack numbering" (page 197).

Pluggable Port Indicates the presence of an SFP. Fields are present and numbered
as appropriate to the switch model.

Module Description The factory set description of the policy switch.

Firmware Version The version of the running firmware.

Software Version The version of the running software.

Manufacturing Date Code The date of manufacture of the board in ASCII format.

Hardware Version The hardware version of the switch.
Serial Number The serial number of the policy switch.
Operational State The current operational state of the device. The operational states

are Other, Not Available, Removed, Disabled, Normal, Reset in
Progress, Testing, Warning, Non Fatal Errors, Fatal Error, and Not
Configured.

Power Status The current power status of the device

e Primary Power. RPS not present

e Primary Power. RPS present

e Redundant Power. Primary power failed

¢ Unavailable

Fans Status The current status of switch cooling fans.

2 In stacked configurations, click the number of the device to view in
the upper-left corner of the screen.

—End—

Changing stack numbering
If the system is in a stack, you can view and renumber existing stack
numbering information.

Note: The unit number does not affect the base unit designation.
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To view or renumber devices within the stack framework, perform the
following procedure.

Step Action

1 To open the Stack Numbering screen, select Summary > Stack
Numbering, as illustrated in the Stack Numbering dialog box.

Summary > Stack Numbering

Stack Numbering Setting

Current Unit Number] MAC Address |New Unit Number|

1 00-16-CA-DA-C4-00 [T=]
2 00-16-CA-DI-40-00 [2=]
L Submi

Target Replacement Setting
Target Unit to Replace I 'l

The following table "Stack Numbering screen fields" (page 198)
describes the fields on the Stack Numbering screen.

Stack Numbering screen fields

Field Item Range Description

Stack Current Unit 1—8 Unit number previously assigned to the
Numbering Number policy switch. The entries in this column
Setting are displayed in order of their current

physical cabling with respect to the base
unit and can show non consecutive unit
numbering if one or more units were
previously moved or modified. The
entries can include unit numbers of units
that are no longer active.

MAC Address XXXX XX XX XXX MAC address of the corresponding unit

X listed in the Current Unit Number field.
New Unit 1—8, None Choose a new number to assign to your
Number selected policy switch.

Nortel Ethernet Routing Switch 4500 Series
Overview — System Configuration
NN47205-500 02.01 Standard
5.0 23 February 2007
Copyright © 2007, Nortel Networks Nortel Networks Confidential



General Switch Administration using the Web-based Management Interface 199
e

Field Item Range Description
Note: If you leave the field blank, the
system automatically selects the next
available number.
Target Rep | Target Unit to 1—8 Choose the unit number to replace. You
lacement Replace use this field when you replace a failed
Setting unit with a new switch.

2 Choose the new number to assign to the switch.
3 Click Submit. A message prompts you to confirm the request.

4 Click Yes.

—End—

Identifying unit numbers
Identify the unit numbers of the switches participating in a stack configuration
by viewing the LEDs on the front panel of each switch.

To identify unit numbers in your configuration, perform the following

procedure.
Step Action
1 To open the Identify Unit Numbers screen select Summary >

Identify Unit Numbers, as illustrated below.

Port LEDs lit on the front panel of the
switch correspond to its unit number

ks

2 To continue viewing summary information or to start the configuration
process, choose another command.

Nortel Ethernet Routing Switch 4500 Series
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—End—

Configuring BootP, IP, and gateway settings
You can configure and modify BootP mode settings for in-band stack and
in-band switch IP addresses, in-band subnet mask parameters, and the
IP address of your default gateway.

Note: Settings take effect immediately after you click Submit.

To configure BootP, IP, and gateway settings, perform the following

procedure.
Step Action
1 To open the IP screen, select Configuration > IP , as illustrated

in"IP page for a stand-alone Nortel Ethernet Routing Switch 4500
Series" (page 200) and "IP page for a stack” (page 201).

IP page for a stand-alone Nortel Ethernet Routing Switch 4500 Series

Configuration = IP q -

IP Setting

rccens — [ use st

» Summny R TREaRl [GooF WhenNnoded 5]
v?',’:’"""" In-Band Stack IP Address [1000 LITT so08

4 Sysam In-Band Switch IP Address 10127 232 30 10.427.232.30 8.0.00

+ Remote Access

@ SNMP In-Band Subnet Mask [255 255.255.0 285245 2620 0.0.0.0

> SNMPvD [[rZci.

S T Detault Gateveay 101272321 f012m2m21 8000

& MAC Addreas

@ Find MAC Address [ Submit

@ Port Management
# High Speed Flow Cantrel
4 Sofwnre Downlosd

& Ascil Config Downdoad

@ Cornfiguation File
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IP page for a stack

Configuration > IP

IP Setting

unie [l 2
|  Configurable | _InUse _[LastBootP|
BootP Request Mode |BootP Disabled j
InBand Stack IP Address [192167.12043 192.167.120.43 0.0.0.0
In-Band Switch IP Address [192167.12041 0.0.0.0 0.0.0.0
InBand Subnet Mask  [2552552550 255 266 2560 0.0.00
Default Gateway [1921671201 1921671201 0.0.0.0
L Submit ]

Note: To change the IP information for a specific unit in the
stack, choose that unit and enter the desired IP information into
the In-Band Switch IP address field.

The following table "IP page items" (page 201) describes the items
on the IP screen.

IP page items

Section Item Range Description

Boot Mode BootP BootP When Needed Choose this mode to inform the

Setting Request switch to send a BootP request
Mode when the switch |IP address stored

in non volatile memory is the factory
default value. If the stored IP
address differs from the factory
default value, the switch uses the
stored network parameters. If the
switch cannot find a BootP server, it
tries five more times to find one and
then defaults to the factory settings.

Note: This is the default.

BootP Always Choose this mode to inform the
switch, each time the switch boots,
to ignore stored network parameters
and send a BootP request. If the
BootP request fails, the switch
boots with the factory default IP
configuration. This setting disables

Nortel Ethernet Routing Switch 4500 Series
Overview — System Configuration
NN47205-500 02.01 Standard
5.0 23 February 2007
Copyright © 2007, Nortel Networks Nortel Networks Confidential



202 Switch administration tasks
B |

Section Item Range Description

remote management if no BootP
server is set up for the switch, but it
enables the switch to boot normally.

BootP Disabled Choose this mode to inform the
switch, each time the switch
boots, to use the IP configuration
parameters stored in non volatile
memory. If a BootP configuration
is in progress when you issue this
command, the BootP configuration

stops.
Boot Mode BootP or Last Address Choose this mode to inform the
Setting switch, at each startup, to obtain its
(continued) IP configuration using BootP. If the

BootP request fails, the switch uses
the network parameters stored in its
non volatile memory.

Note: Valid parameters obtained in
using BootP always replace current
information stored in the non volatile
memory.

Note: Whenever the switch broadcasts BootP requests, the BootP
process times out if a reply is not received within (approximately)

7 minutes. When the process times out, the BootP request mode
automatically changes to BootP Disabled mode. To restart the
BootP process, change the BootP request mode to one of the three
following modes: BootP When Needed, BootP Always, or to BootP or
Last Address.

IP Setting In-Band XXX XXX XXX XXX Type a new stack IP address in the
Stack IP appropriate format.
Address
In-Band XXX XXX XXX XXX Type a new switch IP address in the
Switch IP appropriate format.
Address

Note: When you enter the IP address
in the In-Band IP Address field, and
the In-Band Subnet Mask field value
is not present, the software provides
an in-use default value for the In-Band
Subnet Mask field that is based on
the class of the IP address entered in
the In-Band IP Address field.

Nortel Ethernet Routing Switch 4500 Series
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Section Item Range Description
In-Band XXX XXX XXX XXX Type a new subnet mask in the
Subnet appropriate format.
Mast
Gateway Default XXX XXX XXX XXX Type an IP address for the default
Setting Gateway gateway in the appropriate format.

Note: If you assign an IP address to the device and the BootP
process times out, the BootP mode remains the default mode
of BootP when needed.

However, if you do not assign an IP address to the device and
the BootP process times out, the BootP mode automatically
changes to BootP disabled. But this change to BootP disabled is
not stored, and the BootP reverts to the default value of BootP
when needed after you reboot the device.

2 In the fields provided, enter the IP configuration information.

3 Click Submit.

—End—

Modifying system settings
The you can configure or change the system name, system location, and
network manager contact information.

Note: The configurable parameters on the System screen are displayed
in a read only-format on the Web-based Management Interface System
Information home page.

To configure system settings, perform the following procedure:

Step Action

1 To open the System screen, select Configuration > System, as
illustrated in "System page" (page 204).
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System page

Configuration > System q

System Characterintics Sefting
System Description Ethemet Aouting Switch LS4BGT.PWS N Ol FW 1,00 14 51 010 083 8N 83 (x) Narte Netwariy
Stem ObjectiD 128141453712

System Up Time 21184

Syatem Contact
Syatem Hame HE4AGT PWR
Sytem Location

xxxxx

@ Port Management
& High Speed Flow Cortel
@ Somware Downicsd

@ Ascil Gonfig Download
@ Configuration File

The following table "System page items" (page 204) describes the
items on the System screen.

System page items

Item Description

System Description The factory set description of the hardware and software versions.

The character string that the vendor created to uniquely identify this

System Object ID device.

System Up Time The elapsed time since the last network management portion of the
system was last reinitialized.

Note: This field is updated only when the screen is redisplayed.

System Contact Type a character string to create the contact information for the
network manager or the selected person to contact regarding switch
operation; for example, networkmanager@company.com

Note: To operate correctly with the Web Interface, the system contact
must be an e-mail address.

System Name Type a character string to create a name to identify the switch; for
example, Finance Group.

System Location Type a character string to create a name for the switch location;
for example, First Floor.

2 In the fields provided, enter the desired information.

3 Click Submit.

—End—
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Managing remote access by IP address
Configuration of the remote access is allowed through the Web interface.
Up to 50 IP addresses can be specified to allow Web access, SNMP
access, or Telnet access to the switch.

To configure remote access, perform the following procedure.

Step Action

1 To open the Remote Access screen, select Configuration >
Remote Access, as illustrated in "Remote Access page" (page 206).
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Remote Access page

Configuration > Remote Access

Femote Access Settlings

Telnet  [Alowed =] [ves =]
N s | |

Web Page  Alowed | 7es =]

Allowed Source IP and Subnet Bask

b [Atlawed Source IP [Allowed Source Mask
1 [pooo oo
2 [ s5255055 [265 255,265 255

3 [esszssassess  [resrosessess
4 [smczszss  [psszssoeszs
5 [5zsemass  [pecssemoss
6 [ts5zs5oss7e5 [rssosnoesoss |
7 [55256265256  [255256.265 255

B [c55255255255  [esscs62952%8 |
o [pEEEisszes  [peeosnoescss
105255255255  [255255.255.255
ol
12555255755 [255.255 265 255
Ol
s Esesoss s
U B
G
1 [ss s onsoes  [ssossessaes
18[2655.256.265.255 [265.256.265 255
1825556265266 [265.256.265 255
0 [2s5255255255 [255255.255.256

P T T
22 [csiss o555 [esecsnoseiss
B[es5 55255255  [es5255256255 |
|24 [ess s ess 255 [o55 255265 255
[esszmsesmess  [psessenos
26 [25 255 055 255 [peosnoeg osh
=,
28 [r55 255255 755 [eoazs6zeszsh |
9 [255.255.255255 [265256.255.255
[esszs5285255 [ssomsesacss
| e T T
R e
kN
3 [zsszm5 25525 [25 255 255 255
Blmmtomes  [Bomenos

| o e
37 [csszss2ss 285 [ssossossosh
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m[sssoesces  [ssossessoss
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The following table "Remote Access page fields" (page 207)
describes the fields on the Remote Access page.

Remote Access page fields

Section Item Range Description
Remote Access Telnet/Access Allowed Enable Telnet access.
Settings Disallowed
Telnet/Use List Yes Restrict Telnet access
No to the specified 50
source IP addresses.
SNMP/Access Allowed Enable SNMP access.
Disallowed
SNMP/Use List Yes Restrict SNMP access
No to the specified 50
source IP addresses.
Web Page/ Display allowed Web
Access Interface access.
Web/Use List Yes Restrict Web Interface
No access to the
specified 50 source IP
addresses.
Allowed Source Allowed Source XXX XXX XXX XXX Enter the source
IP and Subnet IP IP address to allow
Mask switch access.
Allowed Source XXX XXX XXX XXX Enter the source IP
Mask mask to allow switch
access.

2 Complete fields as described in the table.

3 Click Submit.

—End—

General Switch Administration using the JDM
This section contains the following topics:

¢ "Viewing unit information" (page 208)

¢ "Viewing switch IP information" (page 209)

e "Viewing SFP GBIC ports" (page 215)

¢ "Editing the chassis configuration" (page 215)
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* "Editing and viewing switch ports" (page 229)

« "Editing and viewing switch PoE configurations" (page 237)

e "Editing Bridging Information" (page 240)

e "Configuring SNTP" (page 245)

*  "Viewing topology information using Device Manager" (page 247)

Viewing unit information
To view Unit information, perform the following procedure.

Step Action
1 Select the unit by clicking in the Device View area of the switch.
2 To open the Unit screen, selectEdit > Unit, as illustrated in "Unit

dialog box" (page 208).

Unit dialog box
x|

Uit | PoE |

Type: 767
Descr: 48 ports 10/100/1000 BaseT with PoE and 4 shared SFP ports
Wer: 45435T-PWR HW: 0B
Serhum: SDLIT7001G
BaseMumParts; 45
TotalMurmPorts: 48

Refreshl Closel Help...l

The following table "Unit tab items" (page 208) describes the Unit
screen fields.

Unit tab items

Field Description

Type The type number

Descr The type of switch

Ver The version number of the switch

SerNum The number of the switch

BaseNumPorts The base number of ports

TotalNumPorts The total number of ports
—End—
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Viewing PoE information
To view PoE information, select the PoE tab in the Unit dialog box and read
the information associated with the fields. See "PoE tab for a single unit"
(page 239)

Viewing switch IP information
You can view the switch IP information using the IP dialog box.

To open the Edit IP dialog box from the Device Manager main menu,
perform the following procedure.

Step Action
1 Select Edit. The Edit selection list appears.
2 Select IP from the Edit selection list. The IP dialog box opens with

the Globals tab displayed.

—End—

The following sections provide a description of the tabs in the IP dialog box
and details about each item on the tab. The IP tabs are read-only.

¢ "IP Globals tab" (page 210)
e |P Addresses tab

« |P ARP tab

e |P TCP tab

e |P TCP Connections tab

e IP UDP Listeners tab

IP Globals tab
To open the Globals tab from the Device Manager main menu, perform the
following procedure.

Step Action

1 Select Edit. The Edit selection list appears.

2 Select IP . The IP Globals tab appears.

3 Click Refresh to refresh the tab information display.

—End—
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IP Globals tab
=

Globals | Addresses | ARP | TP | TCP Cornections | UIDP Listeners

DefaultTTL: 64
ReasmTimeout: 60 sec

Refreshl Closel Help...l

Table 1
IP Globals tab fields

Field and MIB association | Description

DefaultTTL Default value inserted into the Time-To-Live field of the IP header
of datagrams originated by the switch whenever a TTL value is not
supplied by the transport layer protocol. Default value is 64.

ReasmTimeout Maximum number of seconds that received fragments are held while
they are awaiting reassembly by the switch. Default value is 60.

IP Addresses tab
The Addresses tab contains the IP address information for the device.

To open the Addresses tab from the Device Manager main menu, perform
the following procedure.

Step Action

1 Select Edit. The Edit selection list appears.

2 Select IP. The IP Globals tab appears.

3 Select the Addresses tab. The Addresses tab opens.
4 Click Refresh to refresh the tab information display.

—End—
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IP Addresses tab
=

Globals Addresses | ARp | TCP | TCP Comnections | DR Listeners

Addr MetMask BrastAddr | ReasmMaxSize
192,167,120,41 |255,255,255.0 1 65535

1 pawls)

IP Addresses tab fields

Field Description

Addr The device IP address.

NetMask The subnet mask address.

BcastAddr The value of the least-significant bit in the IP broadcast address

used for sending datagrams on the (logical) interface associated

with the IP address for this entry. For example, when the Internet
standard all-ones broadcast address is used, the value will be

1. This value applies to both the subnet and network broadcasts

addresses used by the entity on this (logical) interface.

ReasmMaxSize The size of the largest IP datagram that this entity can reassemble
from incoming IP fragmented datagrams received on this interface.

IP ARP tab
The Address Resolution Protocol (ARP) tab contains the MAC addresses
and the associated IP addresses for the switch.

To open the ARP tab from the Device Manager main menu, perform the
following procedure.

Step Action

1 Select Edit. The Edit selection list appears.
2 Select IP. The IP Globals tab appears.

3 Select the ARP tab. The ARP tab opens.
4

Click Refresh to refresh the tab information display.

—End—
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IP ARP tab
x

Globalsl Addresses  ARP | TCPI TCP Connectionsl LIDP Listeners

Interface Macaddress IpAddress Type
1)1 |00:0c:F8:42: 70078 |192,167.120.1 |dynaric

1 rowi(s)

IP ARP tab fields

Field Description
Interface The unit and port number.
MacAddress The unique hardware address of the device.
IPAddress The Internet Protocol (IP) address of the device used to represent a
point of attachment in a TCP/IP internetwork.
Type The type of mapping.
IP TCP tab

The Transport Control Protocol (TCP) tab contains the TCP information
for the switch.

To open the TCP tab from the Device Manager main menu, perform the
following procedure.

Step Action

1 Select Edit. The Edit selection list appears.
2 Select IP. The IP Globals tab appears.

3 Select the TCP tab. The TCP tab opens.
4

Click Refresh to refresh the tab information display.

—End—
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IP TCP tab
x

Globalsl .C\ddressesl ARP  TCP | TCP Cornections | UDP Listerers
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Rtoalgarithm

REtalin

RtoMax | MaxConn

wanj

50000

F200000 4

1 rowls)

Field Description

RtoAlgorithm The algorithm that determines the timeout value used for
retransmitting unacknowledged octets.

RtoMin The minimum value permitted by a TCP implementation for the
retransmission timeout, measured in milliseconds.

RtoMax The maximum value permitted by a TCP implementation for the
retransmission timeout, measured in milliseconds.

MaxConn The limit on the total number of TCP connections that the entity can

support. In entities where the maximum number of connections is
dynamic, this object contains the value -1.

IP TCP Connections tab
The TCP Connections tab contains the xxxxxx for the switch.

Copyright © 2007, Nortel Networks

To open the TCP Connections tab from the Device Manager main menu,
perform the following procedure.

Step Action

1 Select Edit. The Edit selection list appears.

2 Select IP. The IP Globals tab appears.

3 Select the TCP Connections tab. The TCP Connections tab opens.
4 Click Refresh to refresh the tab information display.

—End—
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IP TCP Connections tab
x
Globals | Addresses | ARP | TP TCP Connections | UDP Listeners

Localaddress | LocalPort | Remaddress | RemPort | State
0.0.0.0 23(0.0.0.0 0 listen
0.0.0.0 80(0.0.0.0 0 listen

ReFreshl Delete |E|_@Iﬂ| Help...l

2 rowis)

IP TCP Connections tab fields

Field Description

LocalAddress The local IP address for this TCP connection: the value is 0.0.0.0
for a connection in the listen state. A connection in the listen state
is a connection wiling to accept connections for any IP interface
associated with the node .

LocalPort The local port number for this TCP connection.
RemAddress The remote IP address for this TCP connection.
RemPort The remote port number for this TCP connection.
State The state of this TCP connection.

IP UDP Listeners tab
The User Datagram Protocol (UDP) Listeners tab contains information on
the UDP listeners currently maintained by the switch.

To open the UDP Listeners tab from the Device Manager main menu,
perform the following procedure.

Step Action

1 Select Edit. The Edit selection list appears.

2 Select IP. The IP Globals tab appears.

3 Select the UDP Listeners tab. The UDP Listeners tab opens.
4 Click Refresh to refresh the tab information display.

—End—
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IP UDP Listeners tab
x
Globalsl F'.ddressesl P.RPl TCP| TCP Connections UDP Listeners

LocalAddress | LocalPark
0.0.0.0 1]
0.0.0.0 161

2 rowis)

IP UDP Listeners tab fields

Field Description

LocalAddress The local IP address for this UDP listener. The value for a UDP
listener that accepts datagrams for any IP interface associated with
the node is 0.0.0.0.

LocalPort The local port number for this UDP listener.

Viewing SFP GBIC ports

You can view the details of an SFP GBIC port only if the port is active.

To view the SFP GBIC ports, perform the following procedure.

Step Action
1 Select the SFP GBIC ports from the Device View.
2 To open the Port screen, select Edit > Port.

—End—

Editing the chassis configuration

You can edit the chassis configuration from the Edit Chassis screen "Edit
Chassis screen -- System tab" (page 217).

To open the Edit Chassis screen, perform the following procedure.

Step Action
1 Select the chassis in the Device View.
2 To open the Edit Chassis screen, select Edit > Chassis .

—End—

The following sections describe the tabs in the Edit Chassis screen:
e "System tab" (page 216)
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e "Base Unit Info tab" (page 219)
« "Stack Info tab" (page 221)

« "Agent tab" (page 224)

e "SNMP tab" (page 226)

e " Power Supply tab" (page 226)
* " Fan tab" (page 227)

For information about the Banner tab or the Custom Banner tabs, see
"Banner tab" (page 111)or "Custom Banner tab" (page 113).

For information about the SNMP and Trap Receivers tabs, see
Nortel Ethernet Routing Switch 4500 Series Security — Configuration
(NN47205-505).

System tab
Use the System tab to specify, among other things, tracking information for
a device and device descriptions.

Step Action

1 Open the System tab using the procedure at the beginning of this
section. The following dialog box appears.
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T

Edit Chassis dialog box -- System tab

System I Base Linit Infol StackInFol Agentl SNMPl Trap Receiversl PowerSuppIyl Fanl Bannerl Custom Bannerl

sysDescr: Ethernet Routing Switch 4545GT-PWR - HWI0B  PWhS.0.0,16 SWiv5.0.0,097 BM:97 () Morkel Netwarks
syslpTime: S days, 06h:51m:22s
sysObjectID: .1.3.6.1.4.1.45.3.71.2

sysCaontack: I

syshame: I

syslocakion: I
Serhum; SDLITF001G
[+ AuthenticationTraps

ReBoot: |+ running ¢ reboak

AutoPyid: | {% enabled (" disabled
Managementylanld: Il 1..4094

StackInsertionUnitMumber: ID_ 0.8
¥ AutolnitReplacementEnabled

MextBootMgmtProtocol: ipCnky
CurrentMgmtProtocol: ipOnly

BootMade: |("' othier €% Jacal € net ¢ netWhenMeeded  netOrlastAddress

ImageloadMode: local
CurrentImageVersion: v5.0.0.097
LocalStoragelmageyersion: 5.0.0,097
MextBootDefaultGateway: 192,167,120,1
CurrentDefaultGateway: 192.167.120.1
MextBootloadPratocal: ipOnky
LastLoadProkocal: ip

P.pplyl ReFreshl Closel Help...l

Note: The chassis tracks the elapsed time and calculates the
time and date using the system clock of the Device Manager
machine as a reference.

The following table "System tab items" (page 217) describes the
System tab items.

System tab items

Field Description

sysDescr A description of the device.

sysUpTime The time since the system was last
booted.

sysObjectID Displays the system object identification
number.

sysContact Type the contact information (in this
case, an e-mail address) for the system
administrator.

sysName Type the name of this device.

sysLocation Type the physical location of this device.
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Field

Description

SerNum

Displays the individual switch serial
number.

AuthenticationTraps

Click enable or disable. When you
select enabled, SNMP traps are sent

to trap receivers for all SNMP access
authentication. When you select disabled,
no traps are received.

To view traps, click the Trap toolbar
button.

=

Reboot

Action object to reboot the agent.

Reset - initiates a hardware reset.

The agent attempts to return a response
before the action occurs. If any of

the combined download actions are
requested, neither action occurs until the
expiration of sbAginfoScheduleBootTime,
if set.

AutoPvid

Click enabled or disabled. When you
select enabled, Port VLAN ID (PVID) is
automatically assigned.

ManagementVlanid

The current management VLAN ID.

StackInsertionUnitNumber

The unit number to be assigned to the
next unit that joins the stack. You cannot
set the value to the unit number of an
existing stack member. When a new
unit joins the stack, and the value of this
object is used as its unit number, the
value reverts to 0. If the value of this
object is 0, it is not used to determine the
unit number of new units.

AutoUnitReplacement
Enabled

Determine whether auto-unit-replacement
is enabled or disabled.

NextBootMgmtProtocol The transport protocols to use after the
next boot of the agent.
CurrentMgmtProtocol The current transport protocols that the

agent supports.

Copyright © 2007, Nortel Networks
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Field Description

BootMode The source from which to load the initial
protocol configuration information to boot
the switch the next time. The options
available are local, net, netWhenNeeded,
netOrLastAddress, or none.

ImageLoadMode The source from which to load the agent
image at the next boot.

CurrentimageVersion The version number of the agent image
that is currently used on the switch.

LocalStoragelmage The version number of the agent image

Version that is stored in flash memory on the
switch.

NextBootDefaultGateway The IP address of the default gateway for
the agent to use after the next time you
boot the switch.

CurrentDefaultGateway The IP address of the default gateway
that is currently in use.

NextBootLoadProtocol The transport protocol that the agent uses
to load the configuration information and
the image at the next boot.

LastLoadProtocol The transport protocol last used to load
the image and configuration information
about the switch.

See also:

* "Base Unit Info tab" (page 219)
» "Stack Info tab" (page 221)

* "Agent tab" (page 224)

* " Power Supply tab" (page 226)
* " Fan tab" (page 227)

* "Banner tab" (page 111)

e "Custom Banner tab" (page 113)

—End—

Base Unit Info tab
The Base Unit Info tab provides read-only information about the operating
status of the hardware and whether the default factory settings are used.
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Step Action

1 Open the Edit Chassis screen in the manner detailed at the
beginning of this section.

2 Select the Base Unit Info tab, as illustrated in "Edit Chassis screen
-- Base Unit Info tab" (page 220).

Edit Chassis screen -- Base Unit Info tab

*. 192.167.120.43 - Chassis

System  Base Unit Info I Stack Infol Agentl SNMPl Trap Receiversl PowerSuppIyl Fanl Bannerl Custom Bannerl

Type: 767
Descr: 48 porks 10/100/1000 BaseT with PoE and 4 shared SFP ports
er: 4548GT-PWR HW 0B
SerMum: SDLII7001G
LstChng: O day, 00h:00m;:24s

AdminState: | (% enable ¢ reset

OperState: normal

Lacation: |
RelPos: 0
BaseMumParks: 45
TotalurmPorks: 48

IpAddress: 192.167.120.41

F\pplyl Refreshl Closel Help...l

The following table "Base Unit Info tab items" (page 220) describes
the Base Unit Info tab items.

Base Unit Info tab items

Field Description

Type The switch type.

Descr A description of the switch hardware,
including number of ports and transmission
speed.

Ver The switch hardware version number.

SerNum The switch serial number.

LstChng The value of sysUpTime at the time the

interface entered its current operational
state. If you entered the current state prior
to the last reinitialization of the local network
management subsystem, the value is zero.

AdminState Administrative state of the switch. Select
either enable or reset.

Note: In a stack configuration, Reset resets
only the base unit.
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Field Description

OperState The operational state of the switch.
Location Type the physical location of the switch.
RelPos The relative position of the switch.
BaseNumPorts The number of base ports of the switch.

TotalNumPorts

The number of ports of the switch.

IpAddress

The base unit IP address.

See also

"System tab" (page 216)
"Stack Info tab" (page 221)
"Agent tab" (page 224)

" Power Supply tab" (page 226)
" Fan tab" (page 227)
"Banner tab" (page 111)

"Custom Banner tab" (page 113)

—End—

Stack Info tab
The Stack Info tab provides read-only information about the operating status
of the stacked switches and whether the default factory settings are used.

Step Action

1 Open the Edit Chassis screen in the manner detailed at the
beginning of this section.

2 Click the Stack Info tab, as illustrated in "Edit Chassis screen --
Stack Info tab" (page 221).

Edit Chassis screen -- Stack Info tab

*. 192.167.120.43 - Chassis x|
Systeml Base Unit Info  Stack Info I Agentl SNMPl Trap Receiversl PowerSuppIyl Fanl Bannerl Custom Bannerl
Indx Descr Location LskChng AdminState | OperState Wer Serhum BaselumPorts | TotalNumPorts
1|48 ports 10/100/1000 BaseT with PoE and 4 shared SFP ports 0 day, 00h:00m: 245 |enable normal 4545GT-PWR Hw!0B |SDLI17001G 43 48192
2|48 ports 10{100BaseT plus 2 10/100/1000/SFP combo ports 0 day, 00h:00m: 245 |enable niormal 45507 Hw: 0B SDLILB001R 50 50192
« | i

o] ] B ] @] 5 e e
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The following table "Stack Info tab fields" (page 222) describes the
Stack Info tab fields.

Stack Info tab fields

Field Description
Indx A line number for stack info
Descr A description of the component or

subcomponent. If not available, the value is
a zero length string.

Location The geographic location of a component in a
system modeled as a chassis, but possibly
physically implemented with geographically
separate devices connected to exchange
management information. Chassis modeled
in this manner are sometimes referred to as
virtual chassis. An example value is: 4th flr
wiring closet in big A.

Notes: 1. This field applies only to
components that are in either the Board
or Unit groups. If the information is
unavailable, for example, the chassis is not
modeling a virtual chassis or component is
not in a Board or Unit group, the value is a
zero-length string.

2. If this field is applicable and is not
assigned a value through a SNMP
SET PDU when the row is created, the
value defaults to the value of the object
s5ChasComSerNum.

LstChng The value of sysUpTime when it

was detected that the component or
sub-component was added to the chassis.
If this action has not occurred since the cold
or warm start of the agent, then the value
is zero.
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Field Description
AdminState The state of the component or
subcomponent.

The values that are read-only are

e other: currently in another state

* notAvail: actual value is not available

The possible values that can be read and
written are

e disable: disables operation
* enable: enables operation
* reset: resets component

* test: starts self test of the component,
with a result of normal, warning,
nonFatalErr, or fatalErr in object
s5ChasComOperState The component
type determines the allowable (and
meaningful) values.

OperState The current operational state of the
component. The possible values are

» other: another state

e notAvail: state not available

* removed: component removed

+ disabled: operation disabled

e normal: normal operation

e resetinProg: reset in progress

e testing: performing a self test

e warning: operating at warning level
* nonFatalErr: operating at error level

« fatalErr: error stopped operation

The component type determines the
allowable (and meaningful) values.
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Field Description

Ver The version number of the component or
subcomponent. If not available, the value is
a zero-length string.

SerNum The serial number of the component or
subcomponent. If not available, the value is
a zero-length string.

BaseNumPorts The number of base ports of the component
or subcomponent.
TotalNumPorts The number of ports of the component or
subcomponent.
IpAddress The IP address of the component or
subcomponent.
See also

» "System tab" (page 216)

* "Base Unit Info tab" (page 219)
* "Agent tab" (page 224)

* " Power Supply tab" (page 226)
* " Fan tab" (page 227)

» "Banner tab" (page 111)

e "Custom Banner tab" (page 113)

—End—

Agent tab
The Agent tab provides read-only information about the addresses that the
agent software uses to identify the switch.

Step Action

1 Open the Edit Chassis screen in the manner detailed at the
beginning of this section.

2 Select the Agent tab, as illustrated in "Edit Chassis dialog box --
Agent tab" (page 225).
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Edit Chassis dialog box -- Agent tab

Systeml Base Unit InFoI Stack Info  Agent | SNMPI Trap Receiversl PowerSuppIyI FanI Bannerl Custom Bannerl

NextBootIpAddr | MextBoothetMask | LoadServeraddr ImageFiletame ‘alidFlag | BootRouteraddr MacAddr
192.167.120.43 |255.255.255.0 192,167.120.13  |botanybay_S00s.img walid 0.0.0.0 00:16:caidaicd:0l

e G LT TR = =

The following table "Agent tab fields" (page 225) describes the
Agent tab fields.

Agent tab fields

Field Description

NextBootpAddr The IP address of the BootP server to use the
next time the switch is booted.

NextBootNetMask The subnet mask to use the next time the switch

is booted.

LoadServerAddr The IP address of the server from which the
device loads the image file.

ImageFileName The name of the image file.

ValidFlag Indicates whether the configuration or image files,

or both, were downloaded from this interface and
if the file names did not change.

BootRouterAddr The IP address of the boot router for the
configuration file or the image file, or both.
MacAddr The switch MAC address.
See also

* "System tab" (page 216)

* "Base Unit Info tab" (page 219)
» "Stack Info tab" (page 221)

* "Agent tab" (page 224)

* " Power Supply tab" (page 226)
* " Fan tab" (page 227)

* "Banner tab" (page 111)

e "Custom Banner tab" (page 113)

—End—
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SNMP tab

The SNMP tab provides read-only information about the last unauthenticated
IP address, the last unauthenticated community string, and the trap receiver
entries. For detailed information about SNMP, see Nortel Ethernet Routing
Switch 4500 Series Security Configuration, NN47205-505.

To open the SNMP tab from the Edit Chassis dialog box, click the SNMP tab.

Trap Receivers tab

The Trap Receivers tab provides read-only information about index, net
address, and community trap receivers. For detailed information about
Trap Receivers, see Nortel Ethernet Routing Switch 4500 Series Security
Configuration, NN47205-505.

To open the Trap Receivers tab from the Edit Chassis dialog box, click the
Trap Receivers tab.

Edit chassis dialog box Trap Receivers tab
x|

[ Indx | netaddr | Community |
|

o] e || ] ] ] ] 5] o]

Power Supply tab
The Power Supply tab provides read-only information about the operating
status of the switch power supplies.

The power supply parameters for the PoE switches, 4550T-PWR and
4548-GT-PWR, differ slightly because they support Power over Ethernet

(PoE).

Step Action

1 Open the Edit Chassis screen in the manner detailed at the
beginning of this section.

2 Select the PowerSupply tab, as illustrated in " Edit Chassis screen

-- Power Supply tab" (page 226).

Edit Chassis screen -- Power Supply tab

Systeml Base Lnit InFol Skack. InFol ngentl SNMPl Trap Receivers PowerSupply I Fanl Bannerl Custom Banner

Chassis 1 Primary Power Supply: normal
Chassis 1 Redundant Power Supply: removed

Chassis 2 Primary Power Supply: normal
Chassis 2 Redundant Power Supply: removed

Refreshl Closel Help...l
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—End—

The following table "Power Supply status values" (page 227) describes the
Power Supply status values.

Power Supply status values

Field Description
OperStat The operational state of the power supply. Possible values
include

» other: another state.

* notAvail: State not available.

* removed: Component was removed.

» disabled: Operation disabled.

* normal: State is in normal operation.

» resetinProg: A reset is in progress.

e testing: System is performing a self test.

* warning: System is operating at a warning level.
* nonFatalErr: System is operating at error level.
» fatalErr: A fatal error stopped operation.

» notConfig: You need to configure a module. The
component type determines the allowable values.

See also:

« "System tab" (page 216)

e "Base Unit Info tab" (page 219)
e "Stack Info tab" (page 221)

« "Agent tab" (page 224)

* " Fan tab" (page 227)

e "Banner tab" (page 111)

e "Custom Banner tab" (page 113)
Fan tab

The Fan tab provides read-only information about the operating status of
the switch fans.
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Step Action

1 Open the Edit Chassis screen in the manner detailed at the
beginning of this section.

2 Select the Fan tab, as illustrated in " Edit Chassis screen -- Fan
tab" (page 228).

Edit Chassis screen -- Fan tab

*. 192.167.120.43 - Chassis

Systeml Base Unit InFol Stack, InFol ngentl SNMPl Trap Receivers | PowerSupphe  Fan I Bannerl Custom Bannet

Chassis 1 Fan 1: normal
Chassis 1 Fan 2: normal
Chassis 1 Fan 3: normal
Chassis 1 Fan 4: normal

Chassis 2 Fan 1: normal
Chassis 2 Fan 2: normal
Chassis 2 Fan 3: normal
Chassis 2 Fan 4: normal

Refreshl Closel Help...l

—End—

The following table "Fan operating status" (page 228) describes the Fan
operating status.

Fan operating status

Field Description

OperStat The operational state of the fan. Values include:

+ other: another state.

* notAvail: This state is not available.

* removed: Fan was removed.

+ disabled: Fan is disabled.

* normal: Fan is operating in normal operation.
* resetinProg: A reset of the fan is in progress.
» testing: Fan is performing a self test.

* warning: Fan is operating at a warning level.

* nonFatalErr: Fan is operating at error level.
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Field Description

» fatalErr: An error stopped the fan operation

* notConfig: You need to reconfigure the fan. The
component type determines the allowable values.

See also:

e "System tab" (page 216)

e "Base Unit Info tab" (page 219)
« "Stack Info tab" (page 221)

« "Agent tab" (page 224)

e " Power Supply tab" (page 226)
e "Banner tab" (page 111)

e "Custom Banner tab" (page 113)

Editing and viewing switch ports
Perform port configuration in the Java Device Manager (JDM) on the Port
screen. Open the Port screen by selecting a port in the Device View and
selecting Edit > Port . You can edit multiple ports by selecting ports from
the Device View while pressing the Control (CTRL) key. Examples of the
Port screen are illustrated in "Port screen with one port selected" (page
230) and "Port screen with multiple ports selected" (page 230).
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Port screen with one port selected

* 192.167.120.43 - Port 1/1

Interface | vLan | 5T | EAPOL | EAPOL Advance | PoE | LACP | Rate Limit

Descr

Indes:

Marne:

Adminstatus:

OperSkatus:
LastChange:

LinkTrap:

1

ethernetCsmacd
9216
00:16:caidaici0l

f up { down

up
5 days, 07h:52m:52s

' enabled (" disabled

: Mortel Ethernet Routing Switch 4548GT PWR Module - Unit 1 Port 1
Type:

MEu:
Physaddress:

AdminDuplex:
OperDuples:
AdminSpeed:

Cperspesd:
AukoMegotiationCapability:

AutoMeqgotiationddvertisements:

MIEId:
IsPortShared:
PorbActiveComponent:

I¥ aukoMeqotiate

Full

|(" mbps1d % mbpsiod ¢ mbpsi0od € mbpsi0000

100 mbps

10Half, 10Full, 100HalF, 100Full, LDDOFUll, FauseFrame
[ 10Half v 1oFul [ 100Half
[ tooFul [~ 1000HalF [ 1000Ful

¥ PauseFrame I asymmPauseFrame

a
portiotShared
fixedPork

P.pplyl ReFreshl Closel Help...l

As demonstrated in "Port screen with one port selected" (page 230) and
"Port screen with multiple ports selected" (page 230), the presentation of
the Port screen differs when you select one port or multiple ports. This
difference is mainly in presentation although some options are unavailable
when you select multiple ports. These exceptions are noted in their

descriptions.

Port screen with multiple ports selected

. 192.167.120.43 - Port x|
Interface | yLan | EAPOL | EAPOL Advance | PoE | LACP |

Index Port | Mame | Descr | Type | Mtu | Phwsaddress | AdminStatus | Operstatus | LastChange | LinkTrap | AutoMegotiate | AdminDuples: | OperDuplex | AdminSpeed | OperSpeed | Autollegotiz
1113 11 Mort... |eth... |9216|00:16:ca:d... |up up S days, 07... |enabled |true Full Full mbps100 100 10Half, 10Full
2012) 14z Mort,., |eth.., 9216 |00:16:ca:d... |up down S days, 07.., |enabled |true Full Full mbps1000 1000 | 10Half, 10Full
313 113 Mort,.. |eth... |9216|00:16:ca:d... |up down 5 days, 07... |enabled |true Full Full mbps1000 1000 | 10Half, 10Full
5i1/5) 15 Mort... |eth... |9216|00:16:ca:d... |up dawn S days, 07... |enabled |true Full Full mbps1000 1000 | 10Half, 10Full
G 1/E) 116 Mort,., |eth.., 9216 |00:16:ca:d... |up down S days, 07.., |enabled |true Full Full mbps1000 1000 | 10Half, 10Full
T 17 Mort,.. |eth... |9216|00:16:ca:d... |up down 5 days, 07... |enabled |true Full Full mbps1000 1000 | 10Half, 10Full
ai1/s) 115 Mort... |eth... |9216|00:16:ca:d... |up dawn S days, 07... |enabled |true Full Full mbps1000 1000 | 10Half, 10Full
4 ]

Applvl Refreshl Closel Help...l

The following sections describe some of the tabs on the Port screen:

« "Interface tab" (page 231)
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e "PoE tab" (page 235)
« "Configuring Rate Limiting" (page 237)

For information about the VLAN, LACP, and STP BPDU-Filtering tabs,
see Nortel Ethernet Routing Switch 4500 Series Configuration — VLANS,
Spanning Tree, and MultiLink Trunking (NN47205-501).

Interface tab

The Interface tab shows the basic configuration and status of a port.

To view the Interface tab, perform the following procedure.

Step Action

1 Select the port to edit from the Device View. Select Edit > Port .

The Port screen

opens with the Interface tab displayed, as

illustrated in "Port screen -- Interface tab" (page 231).

Port screen -- Interface tab

* 192.167.120.43 - Port 1/1 x|

Interface | vLan | 576 | EAPOL | EAPOL Advance | PoE | LACP | Rate Limit

Indesx:

MNarmne:

Descr;

Twpe:

Meu:
Physaddress:

AdminStatus:

OperStatus:
LaskChange:

LinkTrap:

1

Mortel Ethernet Routing Switch 4548GT PWR Module - Unit 1 Port 1
ethernetCsmacd

9216

00:16:caidaici0l

{* up { down

up
5 days, 08h:01m:41s

+ enabled (" disabled

AdminDuplex:
OperDuples:
AdminSpeed:

OperSpeed:
AutoNeqgotiationC apability:

AutoMeqgotiationAdvertisements:

MlkId:
IsPortshared:
Pt ctiveCompanent:

¥ &utolegotiate

Full

|(" mbps1d €% mbpsion ¢ mbpsiood & mbpsi000d

100 mbps
10Half, 10Full, 100Half, 100Full, LODOFUll, PauseFrame

[ 10Half [ 10Ful [ 100Half
[ 100Ful [~ 1000HalF [ 1000Ful

¥ PauseFrame [ AsymmPauseFrame

a
portMotshared
fixedPart

'°|IJI3|V| Refreshl Closel Help...l

To continue, go to:

* "Interface tab" (page 231)
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Interface tab items

The following table "Interface tab fields" (page 232) describes the
Interface tab fields.

Interface tab fields

Field Description

Index A unique value assigned to each interface. The
value ranges from 1 to 64 stand-alone. On a
stack, the index value of the first port of the
second unit is 65. The maximum value is 512.

Name Enter an optional name for the port.

Descr The type of switch and number of ports.

Type The media type of this interface.

Mtu The size of the largest packet, in octets, that can
be sent or received on the interface.

PhysAddress The MAC address assigned to a particular
interface.

AdminStatus The current administrative state of the interface,

which can be one of the following:

. up
e down

When you initialize a managed system, all
interfaces start with AdminStatus in the down
state. AdminStatus changes to the up state
(or remains in the down state) as a result of
either management action or the configuration
information available to the managed system.

OperStatus The current operational state of the interface,
which can be one of the following:

L[] up
e« down
e testing

If AdminStatus is up, then OperStatus is also up
if the interface is ready to transmit and receive
network traffic. If AdminStatus is down, then
OperStatus is also down. The interface remains
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Field Description

in the down state if and only if there is a fault
that prevents it from going to the up state.
The testing state indicates that no operational
packets can be passed.

LastChange The value of sysUpTime at the time the interface
entered its current operational state. If the
current state was entered prior to the last
reinitialization of the local network management
subsystem, the value is zero.

LinkTrap Indicates whether linkUp/linkDown traps are
generated for this interface. By default, this
object has the value enabled for interfaces that
do not operate on top of any other interface (as
defined in the ifStackTable).

AutoNegotiate Indicates whether this port is enabled for
autonegotiation.

AdminDuplex Set the administrative duplex mode of the port
(half or full).

OperDuplex Show the current administrative duplex mode
of the port (half or full).

AdminSpeed Set the port speed.

OperSpeed The current operating speed of the port.

AutoNegotiation The port speed and duplex capabilities that

Capability hardware can actually support on a port, and

which can be advertised by the port using auto
negotiation. Bit 7 tells if a port supports pause
frame capabilities (for full-duplex links) as a part
of the advertisement.

bit 0: 10 half duplex advertisements

bit 1: 10 full duplex advertisements

bit 2: 100 half duplex advertisements

bit 3: 100 full duplex advertisements

bit 4: 1000 half duplex advertisements

bit 5: 1000 full duplex advertisements

bit 6: PAUSE frame support advertisements
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Field Description

bit 7: Asymmetric PAUSE frame support
advertisements

If the port hardware does not support
autonegotiation, then all bits are zero.

AutoNegotiation The port speed and duplex abilities to be
Advertisements advertised during link negotiation.

bit 0: 10 half duplex advertised

bit 1: 10 full duplex advertised

bit 2: 100 half duplex advertised

bit 3: 100 full duplex advertised

bit 4: 1000 half duplex advertised

bit 5: 1000 full duplex advertised

bit 6: PAUSE frame support advertised

bit 7: Asymmetric PAUSE frame support
advertised

The abilities specified in this object are used
only when auto-negotiation is enabled on the
port. If all bits in this object are disabled, and
auto negotiation is enabled on the port, then the
physical link process on the port is disabled.

Mitid The multilink trunk to which the port is assigned
(if any).

IsPortShared Indicates whether the selected port is a shared
port or not.

PortActive Displays the active component of shared ports.

Component

2 After you make changes, clickApply.
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See also

* "PoE tab" (page 235)

* "Configuring Rate Limiting" (page 237)
« TDR tab

—End—

PoE tab
The PoE tab enables the configuration of the POE power settings for a

port in the Ethernet Routing Switch 4500. This tab is displayed only for
PoE-capable units.

To view the PoE tab, perform the following procedure.

Step Action

1 Select the port to edit from the Device View. Select Edit > Port.

The Port screen appears. Select the PoE tab, as illustrated in "Port
screen -- PoE tab" (page 235).

Port screen -- PoE tab
S

Interface | vLaN | 5TG | EAPOL | EAPOL Advance PoE | Lack | Rate Limit

¥ AdminEnable

DetectionStatus: otherFault
PowerClassifications: class0

PowerPriority: |("' critical ¢~ high (% I0w|

Appl\y’l Refreshl Closel Help...l

"PoE tab fields" (page 235) describes the PoE tab fields.

PoE tab fields

Field Description
AdminEnable Enable or disable PoE on this port.
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Field Description

Detection Status The operational status of the
power-device detecting mode on
the specified port:

» disabled: detecting function disabled

» searching: detecting function is
enabled and the system is searching
for a valid powered device on this port

» deliveringPower: detection found a
valid powered device and the port is
delivering power

» fault: power-specific fault detected on
port

» test: detecting device in test mode

e otherFault

Note: Nortel recommends against using
the test operational status.

PowerClassifications The operational status of the port PD
classification.

PowerPriority Set the power priority for the specified
port to:

e critical
* high

e |low

Note: Use the PoE tab to set POE parameters for each port. The
Power Supply tab on the Chassis screen displays the status of
the internal Nortel Ethernet Routing Switch power supply.

—End—

See also
« "Interface tab" (page 231)
¢ "Configuring Rate Limiting" (page 237)
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Configuring Rate Limiting
You can use the Rate Limit tab to configure the Rate Limiting for a single
port.

Step Action

1 Select the port to test from the Device View.

2 Select Edit > Port.
The Port screen appears.

3 Select the Rate Limit tab.
The Rate Limit tab appears.

Rate Limit tab
x|

Interface | VLAN | 5TG | EAPOL | EAPCL Advance | PoE | Lack  Rate Limit

TrafficType | AllowedRate | Enable
mulkicast 0% {none) true
broadcast  |0%:(none) true

[ stee] B ] ] ] 5] o v

Rate Limiting Feature is disabled when AllowedRate=0
Can not disable, Enable=Ffalse, both multicast & broadcast entries.

The following table describes the Rate Limit tab items.

Field Description

TrafficType Specify the two types of traffic that can be set with rate limiting: broadcast
and multicast.

AllowedRate Set the rate limiting percentage. The available range is from 0 percent
(none) to 10 percent.

Enable Enable and disable rate limiting on the port for the specified traffic type.
Options are true (enabled) or false (disabled).

—End—

See also

« "lInterface tab" (page 231)
e "PoE tab" (page 235)

» TDR tab

Editing and viewing switch PoE configurations
You can configure and view the PoE parameters that apply to the whole
switch using the Unit screen.
T EEEEEEEEEEEEE——
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The PowerSupply tab on the Edit Chassis screen displays the status of the
internal Nortel Ethernet Routing Switch 4500 Series power supply.

Note: View and edit the POE parameters for each PoE-capable
Ethernet Routing Switch 4500 one by one. If you select more than one
unit, the POE power parameters, such as the PoE tab, are not displayed.

Edit the PoE parameters from the Edit Unit screen on Ethernet Routing
Switch 4500 PoE-capable units.

Step Action
1 Select the unit.
2 Open the Edit Unit screen by selecting Edit > Unit.

—End—

Unit tab for a single unit
To open the Unit tab for a single unit, perform the following procedure.

Step Action

1 Open the Edit Unit screen using the procedure detailed at the
beginning of this section.

The Unit screen appears with the Unit tab displayed ("Unit screen"
(page 238)).

Unit screen
|

Linit | PoE |

Type: 767
Descr: 48 ports 10/100/1000 BaseT with PoE and 4 shared SFP ports
Ver: 4543G6T-PWR Hw':0B
Serfum: SDLIIF001G
BaseNurmParts: 48
TotalNumPorts: 48

Refreshl Closel Help...l

The following table "Unit tab items" (page 238) describes the Unit
tab items.

Unit tab items

Item Description

Type The switch type.
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Item Description

Descr A description of the switch hardware
including number of ports and
transmission speed.

Ver The switch hardware version.

SerNum The serial number of this device.
BaseNumPorts The number of base ports on the switch.
TotalNumPorts The total number of ports on the switch,

including MDA ports.

See also

* "PoE tab for a single unit" (page 239)

—End—

PoE tab for a single unit

To set the power usage threshold, the power pairs to use, and the power
detection method to use, select a single Nortel Ethernet Routing Switch
4500 Series switch.

Note: You can view and set these parameters only by selecting one
unit. If you select, more than one unit, the PoE tab is not displayed.

To open the PoE tab for a single unit, perform the following procedure.

Step Action
1 Select the relevant Ethernet Routing Switch 4500 unit.
2 To open the Unit screen, select Edit > Unit.
3 Select the PoE tab, as illustrated in "Unit screen -- PoE tab" (page
239).
Unit screen -- PoE tab
X
Unit PoE |

Power: 320 watts
OperStatus: on
ConsumptionPower: 0 watts

UsageThreshald: IBD 1..99 9%
v MatificationControlEnable

PoweredDeviceDetect Type: |("' 802,3af + 802 3afandLegacySupport

Applyl ReFreshl Closel Help...l
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The following table "PoE tab items for a single unit" (page
240)describes the PoE tab items for a single unit.

PoE tab items for a single unit

Item Description

Power The total power available to the Nortel Ethernet
Routing Switch 4500 Series switch.

OperStatus The power state of the Nortel Ethernet Routing

Switch 4500 Series switch.:

s on
+ off
« faulty

Consumption
Power

Displays the power used by the Nortel Ethernet
Routing Switch 4500 Series switch.

Usage Set a percentage of the total power usage of
Threshold the Nortel Ethernet Routing Switch 4500 Series
switch based on which system sends a trap.

Note: You must have the traps enabled (see
NotificationControlEnable) to receive a power
usage trap.

Notification Enable or disable sending traps if the switch

Control power usage exceeds the percentage set in the

Enable UsageThreshold field.

PowerDevice Set the power detection method that the switch

DetectType uses to detect a request for power from a device

connected to all ports on the switch:

+ 802.3af
» 802.3af and legacy

—End—

Editing Bridging Information
Bridging information displays the MAC Address Table for the switch. To view
Bridging information, open the Bridge screen by selecting Edit > Bridge.
This screen is illustrated in "Bridge screen" (page 241).
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Bridge screen

% 192.168.249.46 - Bridge

i| Transparent | Forwarding

EridgeAddress: 00:11:19:35:d0:02

MumPaorts: 26

Type: transparertOnly

Refresh| Close| Help... |

For details, see the following topics:
« "Base tab" (page 241)

e "Transparent tab" (page 242)

* "Forwarding tab" (page 243)

Base tab
The Base tab displays basic Bridge information including the MAC address,
type, and number of ports participating in the Bridge.

You must uniquely refer to the MAC address used by the bridge. The Mac
address must be the smallest MAC address (numerically) of all ports that
belong to the bridge. However, the Mac address must be unique only when
it is integrated with dotldStpPriority. A unigue Bridgeldentifier is formed and
is used in the Spanning Tree Protocol.

To view the Base tab, perform the following procedure.

Step Action

1 Open the Bridge screen by selecting Edit > Bridge.

The Bridge screen appears with the Base tab selected. This screen
and tab are illustrated in "Bridge screen" (page 241).

"Bridge screen -- Base tab fields" (page 241) describes the fields
on this tab.

Bridge screen -- Base tab fields

Field Description

BridgeAddress MAC address of the bridge when it is
uniquely referred to. This address must
be the smallest MAC address of all ports
that belong to the bridge. However, it
must be unique. When concatenated with
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Field Description

dot1dStpPriority, a unique bridge ID is
formed that is then used in the Spanning
Tree Protocol.

Number of ports controlled by the bridging

NumPorts .
entity.

Type The type of bridging this bridge can
perform. If the bridge is actually
performing a certain type of bridging, this
fact is indicated by entries in the port table
for the given type.

—End—

See also:

« "Transparent tab" (page 242)
* "Forwarding tab" (page 243)
Transparent tab

Use the Transparent tab to view information about learned forwarding
entries.

To view the Transparent tab, perform the following procedure.

Step Action

1 Open the Bridge screen by selecting Edit > Bridge.

The Bridge screen appears.

2 Select the Transparent tab, as illustrated in "Bridge screen --
Transparent tab" (page 242).

Bridge screen -- Transparent tab

Forwarding

Baze iTransparent

LearnedEntryDiscards: 0

AgingTime: IBDD 10..1000000
Close| Help...

Apply | Refresh
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"Bridge screen -- Transparent tab fields" (page 243) describes the
fields on this tab.

Bridge screen -- Transparent tab fields

Field Description

LearnedEntryDiscards Number of Forwarding Database entries
learned discarded due to insufficient
space in the Forwarding Database. If
this counter increases, it indicates that
the Forwarding Database is becoming
full regularly. This condition affects the
performance of the subnetwork. If the
counter has a significant value and is
not presently increasing, it indicates
that the problem has occurred but is not
persistent.

AgingTime Time-out period in seconds for removing
old dynamically learned forwarding
information.

Note: The 802.1D-1990 specification
recommends a default of 300 seconds.

3 If the AgingTime field is modified, click Apply.

—End—

See also:

* "Base tab" (page 241)

* "Forwarding tab" (page 243)
Forwarding tab

The Forwarding tab displays the current state of the port, as defined by
application of the Spanning Tree Protocol.

To view the Forwarding tab, perform the following procedure.

Step Action

1 Open the Bridge screen by selecting Edit > Bridge.

The Bridge screen appears.

2 Select the Forwarding tab, as illustrated in "Bridge screen --
Forwarding tab" (page 244).
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Bridge screen -- Forwarding tab

| Statuz | Address | Port
SIS

(IR0 NPT TS ]
[EGrhed UUTOe 28T CTud TS

IEGaFhEd UTOe 29 CT T LE=]
(IESFhEd (DO e300 &29 [T
[EGarfeEd U0TE" g 3879eeT TS
IEGarfed UTOe CuigsTToouT TS
TESFRED |0 O B Ol J0TET (k=]

G L0y = (A R ]
[EGarfed U0 SO S0en [Th
ITESI’I"IECI [RL= N P el T T ]

Refresh El@l Cloze il

11 rowe(E])

To continue, go to:
* "Forwarding tab fields" (page 244)

—End—

See also:
* "Base tab" (page 241)
e "Transparent tab" (page 242)

Forwarding tab fields
The following table "Forwarding tab fields" (page 244) describes the

Forwarding tab fields.

Forwarding tab fields

Field Description

Status The values for this field include:

* invalid: Entry is no longer valid, but has not been removed from
the table.

+ learned: Value of the corresponding instance of
dotldTpFdbPort was learned and is being used.

« self: Value of the corresponding instance of dot1dTpFdbAddr
ess represents an address of the bridge. The corresponding
instance of dotldTpFdbPort indicates that a specific port on
the bridge has this address.
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Field Description

« mgmt(5): Value of the corresponding instance of
dot1dTpFdbAddress is also the value of an existing instance
of dotldStaticAddress.

« other: None of the preceding. This includes instances
where another MIB object (not the corresponding instance
of dotldTpFdbPort or an entry in the dotldStaticTable)
is used to determine if frames addressed to the value of
dot1dTpFdbAddress are being forwarded.

Address A unicast MAC address for which the bridge has forwarding or
filtering information.

Port Either the value 0 or the port number on a frame has been seen.
The source address must be equal to the value of the corresponding
instance of dotldTpFdbAddress

A value of 0 indicates that the port number has not been learned,
so the bridge does have the forwarding or filtering information for
this address (in the dotldStaticTable). You must assign the port
value to this object whenever it is learned even for addresses for
which the corresponding value of dot1dTpFdbStatus is not learned.

Configuring SNTP
The SNTP screen contains the parameters for configuring Simple Network
Time Protocol (SNTP).

Step Action

1 Open the SNTP screen by selecting Edit > SNTP as illustrated in
"SNTP screen" (page 246).
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SNTP screen
~ 192.168.151.170 - SNTP x|

Simple Network Time Protocol I

PrimaryServerAddress: ID,U.IJ,EI

SecondaryServeriddress: |0,0 0o
State: | (= disabled (" uricast

Syncinterval; |24 0..168 hours (O=boot time only)

ManualSyncRequest: : @ requestSync

LastSyncTime: Jan-1-0000, 00:00:00 GMT
LastSyncSource; 0,000
NextSyncTime: Jan-1-0000, 00:00:00 GMT
PrimaryServerSyncFailures: 00
SecondaryServerSyncFailures: 00
CurrentTime: Jan-1-0000, 00:00:00 GMT

Apply | Refreshl C]nsel Help...l

The following table "SNTP dialog box fields" (page 246) describes
the SNTP screen fields.

SNTP dialog box fields

Field Description

PrimaryServer The IP address of the primary SNTP server.
Address

SecondaryServer The IP address of the secondary SNTP server.
Address

State Control whether the device uses SNTP to

synchronize the device clock to the Coordinated
Universal Time (UTC). If the value is disabled,
the device does not synchronize its clock using
SNTP.

If the value is unicast, the device synchronizes
shortly after boot time when network access
becomes available, and periodically thereafter.

Synchinterval Control the frequency, in hours, with which the
device attempts to synchronize with the NTP
servers.
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Field Description

ManualSynch Specify that the device must immediately attempt
Request to synchronize with the NTP servers.

LastSynch The Coordinated Universal Time when the
Time device last synchronized with an NTP server.
LastSynch The IP source address of the NTP server with
Source which this device last synchronized.

NextSynch The Coordinated Universal Time at which the
Time next synchronization is scheduled.

PrimaryServer
SynchFailures

The number of times the switch failed to
synchronize with the primary server address.

However, synchronization with the secondary
server address can still occur.

The number of times the switch failed to
synchronize with the secondary server address.

SecondaryServer
SynchFailures

CurrentTime The switch current Coordinated Universal Time.

2 Edit the fields in the manner indicated by the table.
3 Click Apply.

—End—

Viewing topology information using Device Manager
This section describes topology diagnostic information available in Device
Manager through the following tabs:

« "Topology tab" (page 247)
* "Topology Table tab" (page 248)

Topology tab

To view topology information, select Edit > Diagnostics > Topology.

The Topology dialog box appears with the Topology tab displayed.
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Topology tab
x|

gy ‘l Topology Table |

IpAddr: 10.127.233.3

Status: | (* topOn " bopff

NmmLstCha: 3 davs, 18h:55m:52s
NrmmMaxtum: 100
NromCurum: 2

Apply | Refreshl closel Help-ul

The following table describes the Topology tab fields.

Topology tab fields

Field Description

IpAddr The IP address of the device.

Whether Nortel topology is on (topOn) or off (topOff) for the

Status . :
device. The default value is topOn.

NmmLstChg The value of sysUpTime the last time an entry in the
network management MIB (NMM) topology table was
added, deleted, or modified. If the table has not changed
since the last cold or warm start of the agent, then the
value is zero.

NmmMaxNum The maximum number of entries in the NMM topology
table.

NmmCurNum The current number of entries in the NMM topology table.

See also:

« "Topology Table tab" (page 248)

Topology Table tab

To view more topology information, perform the following procedure.

Step Action
1 From the Device Manager menu bar, select Edit > Diaghostics >
Topology.

The Topology dialog box appears with the Topology tab displayed.

2 Click the Topology Table tab.
The Topology Table tab appears.
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# 10.127.233.3 - Topology x|

Sot | port | Ipaddr | Seqid MacAddr ChassisType BkplType | LocalSeq | curstate |
0 010.127.233.3 | D|0D:11iF9:34:34:01 |mERSSS30-24TFD |enetfastGigenet [true  heartbeat |
1| 13/10.127.233.2 | 514/00:13:03:03:00:41 |mPassport3606  |enetFastGigEnet [true |heartbeat |

Refreshl @l Bl ﬁl C]osel Help...l

2 row(s)

The following table describes the Topology Table tab fields

Topology Table tab fields

Field Description

The slot number in the chassis in which the topology

Slot .
message was received.

The port on which the topology message was

Port

received.

IpAddr

The IP address of the sender of the topology
message.

Segld

The segment identifier of the segment from which
the remote agent sent the topology message. This
value is extracted from the message.

MacAddr

The MAC address of the sender of the topology
message.

ChassisType

The chassis type of the device that sent the topology
message.

BkplType

The backplane type of the device that sent the
topology message.

LocalSeg

Indicates if the sender of the topology message is on
the same Ethernet segment as the reporting agent.

CurState

The current state of the sender of the topology
message. The choices are

« topChanged: Topology information recently
changed.

* heartbeat: Topology information is unchanged.

e new: The sending agent is in a new state.

—End—

See also:
* "Topology tab" (page 247)
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Link Layer Discovery Protocol (802.1ab)

This chapter describes the Link Layer Discovery Protocol (LLDP) (IEEE
802.1ab) and contains the following topics:

* "Link Layer Discover Protocol (IEEE 802.1ab) Overview" (page 251)
e "Configuring LLDP using the CLI" (page 255)
e "Configuring LLDP using Device Manager" (page 269)

Link Layer Discover Protocol (IEEE 802.1ab) Overview
Release 5.0 software supports the Link Layer Discovery Protocol (LLDP)
(IEEE 802.1ab), which enables stations connected to a LAN to advertise
their capabilities to each other, enabling the discovery of physical topology
information for network management. LLDP-compatible stations can
consist of any interconnection device including PCs, IP Phones, switches,
and routers. Each LLDP station stores LLDP information in a standard
Management Information Base (MIB), making it possible for a network
management system (NMS) or application to access the information.

Each LLDP station:

* advertises connectivity and management information about the local
station to adjacent stations on the same 802 LAN (802.3 Ethernet with
4500 Series).

* receives network management information from adjacent stations on
the same LAN.

LLDP also makes it possible to discover certain configuration inconsistencies
or malfunctions that can result in impaired communications at higher layers.
For example, it can be used to discover duplex mismatches between an IP
Phone and the connected switch.

LLDP is compatible with IETF PROTO MIB (IETF RFC 2922).

LLDP: how it works shows an example of how LLDP works in a network.

Nortel Ethernet Routing Switch 4500 Series
Overview — System Configuration
NN47205-500 02.01 Standard
5.0 23 February 2007
Copyright © 2007, Nortel Networks Nortel Networks Confidential



252 Link Layer Discovery Protocol (802.1ab)

LLDP How it works

Ethernet Routing Switch
Router 4500 Series

Management IP Phone

Workstation

1. The Ethernet Routing Switch and LLDP-enabled router advertise
chassis/port IDs and system descriptions to each other.

2. The devices store the information about each other in local MIB
databases, accessible by using SNMP.

3. A network management system retrieves the data stored by each device
and builds a network topology map.

LLDP operational modes
LLDP is a one-way protocol. An LLDP agent can transmit information
about the capabilities and current status of the system associated with its
MAC service access point (MSAP) identifier. The LLDP agent also can
receive information about the capabilities and current status of the system
associated with a remote MSAP identifier. However, LLDP agents cannot
solicit information from each other.

You can set the local LLDP agent to transmit only, receive only, or to both
transmit and receive LLDP information. You can configure the state for
LLDP reception and transmission using SNMP or CLI commands.

Connectivity and management information
The information fields in each LLDP frame are contained in a Link Layer
Discovery Protocol Data Unit (LLDPDU) as a sequence of short, variable
length information elements known as TLVs (type, length, value).

Each LLDPDU includes the following four mandatory TLVS:
* Chassis ID TLV
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e PortID TLV
e Time To Live TLV
e End Of LLDPDU TLV

The chassis ID and the port ID values are concatenated to form a logical
MSAP identifier that the recipient uses to identify the sending LLDP agent
and port.

A non-zero value in the Time to Live (TTL) field of the TTL TLV indicates to
the receiving LLDP agent how long the LLDPDU information from the MSAP
identifier remains valid. The receiving LLDP agent automatically discards all
LLDPDU information, if the sender fails to update it in a timely manner. A
zero value in TTL field of Time To Live TLV tells the receiving LLDP agent to
discard the information associated with the LLDPDU MSAP identifier.

In addition to the four mandatory TLVs, Release 5.0 software

supports the TLV extension set consisting of Management TLVs and
organizationally-specific TLVs. Organizationally-specific TLVs are defined
by either the professional organizations or the individual vendors that are
involved with the particular functionality being implemented. You can specify
which of these optional TLVs to include in the transmitted LLDPDUs for
each port.

For more information about the supported TLV extension set, see the
following:

¢ "Management TLVs" (page 253)

* "IEEE 802.1 organizationally-specific TLVS" (page 253)
« "|EEE 802.3 organizationally-specific TLVs" (page 254)
Management TLVs

The optional management TLVs are as follows:

e Port Description TLV

e System Name TLV

e System Description TLV

* System Capabilities TLV (indicates both the system supported
capabilities and enabled capabilities, such as end station, bridge, or
router)

¢ Management Address TLV

IEEE 802.1 organizationally-specific TLVs

The optional IEEE 802.1 organizationally-specifc TLVs are:
e Port VLAN ID TLV contains the local port PVID.
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e Port And Protocol VLAN ID TLV contains the VLAN IDs of the port and
protocol VLANSs that contain the local port.

« VLAN Name TLV contains the VLAN names of the VLANSs that contain
the local port.

* Protocol Identity TLV advertises the protocol supported. The following
values are used for supported protocols on the 4500 Series:

— Stp protocol {0x00,0x26,0x42,0x42,0x03, 0x00, 0x00, 0x00}
— Rstp protocol string {0x00,0x27,0x42,0x42,0x03, 0x00, 0x00, 0x02}
— Mstp protocol string {0x00,0x69,0x42,0x42,0x03, 0x00, 0x00, 0x03}
— Eap protocol string {0x88, 0x8E, 0x01}
— Lldp protocol string {0x88, OxCC}

IEEE 802.3 organizationally-specific TLVs

The optional IEEE 802.3 organizationally-specifc TLVs are:

* MAC/PHY Configuration/Status TLV indicates the autonegotiation
capability and the speed and duplex status of IEEE 802.3 MAC/PHYSs.

* Power-Via-MDI TLV indicates the capabilities and current status of IEEE
802.3 PMDs that either require or can provide power over twisted-pair
copper links.

e Link Aggregation TLV indicates the current link aggregation status of
IEEE 802.3 MACs.

¢ Maximum Frame Size TLV indicates the maximum supported 802.3
frame size.

Transmitting LLDPDUs When a transmit cycle is initiated, the LLDP
manager extracts the managed objects from the LLDP local system MIB
and formats this information into TLVs. TLVs are inserted into the LLDPDU.

LLDPDU are regularly transmitted at a user-configurable transmit interval
(tx-interval) or when any of the variables contained in the LLPDU is modified
on the local system (such as system name or management address).

Tx-delay is "the minimum delay between successive LLDP frame
transmissions."

TLV system MIBs The LLDP local system MIB stores the information for
constructing the various TLVs to be sent. The LLDP remote systems MIB
stores the information received from remote LLDP agents.
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LLDPDU and TLV error handling LLDPDUs and TLVs that contain
detectable errors are discarded. TLVs that are not recognized, but that also
contain no basic format errors, are assumed to be validated and are stored
for possible later retrieval by network management.

Configuring LLDP using the CLI

You can enable and configure LLDP using the CLI. For more information
about LLDP, see "Link Layer Discover Protocol (IEEE 802.1ab) Overview"
(page 251). This section covers the following commands:

e "lldp command" (page 255)

e "lldp port command" (page 256)

e "lldp tx-tlv command" (page 257)

e "lldp tx-tlv dotl command" (page 257)

e "lldp tx-tlv dot3 command" (page 258)

* lldp location-identification coordinate-base command
* lldp location-identification civic-address command
* "show lldp command" (page 262)

e "default lldp command" (page 258)

» "default lldp port command" (page 259)

* "default lldp tx-tlv command" (page 259)

o "default lldp tx-tlv dotl command" (page 260)

» "default lldp tx-tlv dot3 command" (page 261)

* "no lldp port command" (page 261)

e "no lldp tx-tlv command" (page 262)

* "no lldp tx-tlv dotl command" (page 262)

* "no lldp tx-tlv dot3 command" (page 262)

e "show lldp port command" (page 264)

e "LLDP configuration example" (page 264)

[l[dp command
The 11dp command sets the LLDP transmission parameters. The syntax
for the 11dp command is

11dp [tx-interval <5-32768>] [tx-hold-multiplier
<2-10>] [reinit-delay <1-10>] [tx-delay <1-8192>]
[notification-interval <5-3600>] 1]

Run the 11dp command in Global Configuration command mode.
T EEEEEEEEEEEEEE——
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"lldp command parameters and variables" (page 256) describes the
parameters and variables for the 11dp command.

Ildp command parameters and variables

Parameters and variables Description

Set the interval between successive

tx-interval <5-32768> .
transmission cycles.

Set the multiplier for the tx-interval used to
tx-hold-multiplier <2-10> compute the Time To Live value for the TTL
TLV.

Set the delay for the reinitialization attempt if
the adminStatus is disabled.

reinit-delay <1-10>

Set the minimum delay between successive

x-delay <1-8192> LLDP frame transmissions.

Set the interval between successive

ification-i <5- > - e
notification-interval <5-3600 transmissions of LLDP notifications.

[ldp port command
The 11dp port command sets the LLDP port parameters. The syntax for
the 11dp port command is

1l1dp port <portlist> [config notification] [status {rxOnly |
txAndRx | txOnly}]

Run the 11dp port command in Interface Configuration command mode.

"lldp port command parameters and variables" (page 256) describes the
parameters and variables for the 11dp port command.

Ildp port command parameters and variables

Parameters and variables Description

port <portlist> Specify the ports affected by the command.

Enable notification when new neighbor
config notification information is stored or when existing
information is removed.

Set the LLDPU transmit and receive status on

the ports.
status {rxonly | txAndRx | * rxonly: enables LLDPU receive only
txOnly} « txAndRx: enables LLDPU transmit and
receive

¢ txOnly: enables LLDPU transmit only
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[ldp tx-tlv command
The 11dp tx-tlv command sets the optional Management TLVs to be
included in the transmitted LLDPDUs. The syntax for the 11dp tx-tlv
command is

1ldp tx-tlv [port <portlist>] [port-desc] [sys-name]
[sys-desc] [sys-cap] [local-mgmt-addr]

Run the 11dp tx-tlv command in Interface Configuration command
mode.

"lldp tx-tlv command parameters and variables" (page 257) describes the
parameters and variables for the 11dp tx-tlv command.

Ildp tx-tlv command parameters and variables

Parameters and variables Description

port <portlist> The ports affected by the command.
port-desc The port description TLV.

sys-name The system name TLV.

sys-desc The system description TLV.
sys-cap The system capabilities TLV.
local-mgmt-addr The local management address TLV.

[ldp tx-tlv dotl command
The 11dp tx-tlv dotl command sets the optional IEEE 802.1
organizationally-specifc TLVs to be included in the transmitted LLDPDUSs.
The syntax for the 11dp tx-tlv dotl command is

11dp tx-tlv [port <portlist>] dotl [port-vlan-id]
[vlian-name <vlanlist>] [port-protocol-vlan-id <vlanlist>]
[protocol-identity [EAP] [LLDP] [STP] ]

The 11dp tx-tlv dotl command is in the Interface Configuration
command mode.

"lldp tx-tlv dotl command parameters and variables" (page 257) describes
the parameters and variables for the 11dp tx-tlv dotl command.

Ildp tx-tlv dotl command parameters and variables

Parameters and variables Description

port <portlist> The ports affected by the command.
port-vlan-id The port VLAN ID TLV.

vlan-name The VLAN name TLV.
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Parameters and variables Description
port-protocol-vian-id The port and protocol VLAN ID TLV.
FSr;E)I'tI(D)]C ol-identity [EAPT[LLDPT | - 1 protocol identity TLV.

[ldp tx-tlv dot3 command
The 11dp tx-tlv dot3 command sets the optional IEEE 802.3
organizationally-specifc TLVs to be included in the transmitted LLDPDUSs.
The syntax for the 11dp tx-tlv dot3 command is

11dp tx-tlv [port <portlist>] dot3 [mac-phy-config-status]
[mdi-power-support] [link-aggregation] [maximum-frame-size]

Run the 11dp tx-tlv dot3 command in Interface Configuration
command mode.

"lldp tx-tlv dot3 command parameters and variables" (page 258) describes
the parameters and variables for the 11dp tx-tlv dot3 command.

Ildp tx-tlv dot3 command parameters and variables

Parameters and variables Description

port <portlist> The ports affected by the command.
mac-phy-config-status The MAC/Phy configuration or status TLV.
mdi-power-support The power via MDI TLV.

link-aggregation The link aggregation TLV.
maximum-frame-size The maximum frame size TLV.

default lldp command
The default 11dp command sets the LLDP transmission parameters to
their default values. The syntax for the default 11dp command is

default 1ldp [tx-interval ] [tx-hold-multiplier ]
[reinit-delay] [tx-delay] I[notification-intervall

If no parameters are specified, the default 11dp sets all parameters
to their default parameters.

Run the default 11dp command in Global Configuration command mode.
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"default lldp command parameters and variables" (page 259) describes the
parameters and variables for the default 11dp command.

default Ildp command parameters and variables

Parameters and variables Description
. Set the retransmit interval to the default value
tx-interval
(30).
. Set the transmission multiplier to the default
tx-hold-multiplier
value (4).

Set the reinitialize delay to the default value

reinit-delay @
Set the transmission delay to the default value
tx-delay @

Set the notification interval to the default value

(5).

notification-interval

default lldp port command
The default 1lldp port command sets the port parameters to their
default values. The syntax for the default 11ldp port command is

default 1lldp port <portlist> [config notification] [status]

Run the default 11dp port command in Interface Configuration
command mode.

"default lldp port command parameters and variables" (page 259) describes
the parameters and variables for the default 11dp port command.

default lldp port command parameters and variables

Parameters and variables Description

port <portlist> The ports affected by the command.

Set the config notification to its default value
(disabled).

Set the LLDPU transmit and receive status to
the default value (txAndRXx).

config notification

status

default lldp tx-tlv command
The default 11ldp tx-tlv command sets the LLDP Management
TLVs to their default values. The syntax for the default 11ldp tx-tlv
command is

default 11dp tx-tlv [port <portlist>] [port-desc] [sys-namel]
[sys-desc] [sys-capl [local-mgmt-addr]
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T

Run the default 11dp tx-tlv command in Interface Configuration
command mode.

"default lldp tx-tlv command parameters and variables" (page 260) describes
the parameters and variables for the default 11dp tx-tlv command.

default lldp tx-tlv command parameters and variables

Parameters and variables Description
port <portlist> The ports affected by the command.
port-desc The port description TLV (default value is

false: not included).

The system name TLV (default value is false:

sys-name not included).

The system description TLV (default value is
sys-desc ) .

false: not included).

The system capabilities TLV (default value is
sys-cap

false: not included).

The local management address TLV (default

local-mgmt-addr value is false: not included).

default lldp tx-tlv dotl command
The default 11ldp tx-tlv dotl command sets the optional IEEE
802.1 organizationally-specifc TLVs to their default values. The syntax for
the default 1ldp tx-tlv dotl command is

default 11dp tx-tlv [port <portlist>] dotl [port-vlan-id]
[vlian-name ] [port-protocol-vlan-id] [protocol-identity [EAP]
[LLDP] [STP] 1

Run the default 11ldp tx-tlv dotl command in Interface
Configuration command mode.

"default lldp tx-tlv dotl command parameters and variables" (page 260)
describes the parameters and variables for the default 11ldp tx-tlv
dotl command.

default lldp tx-tlv dotl command parameters and variables

Parameters and variables Description

port <portlist> The ports affected by the command.

The port VLAN ID TLV (default value is false:
not included).

port-vlian-id

vlan-name The VLAN Name TLV (default value is none).
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Parameters and variables Description

The port and protocol VLAN ID TLV (default
value is none).

port-protocol-vian-id

protocol-identity [EAP] [LLDP] | The protocol identity TLV (default value is
[STP] none).

default lldp tx-tlv dot3 command
The default 1lldp tx-tlv dot3 command sets the optional IEEE
802.3 organizationally-specifc TLVs to their default values. The syntax for
the default 1l1ldp tx-tlv dot3 command is

default 11dp tx-tlv [port <portlist>] dot3
[mac-phy-config-status] [mdi-power-support]
[link-aggregation] [maximum-frame-size]

Run the default 11ldp tx-tlv dot3 command in Interface
Configuration command mode.

"default lldp tx-tlv dot3 command parameters and variables" (page 261)
describes the parameters and variables for the default 11ldp tx-tlv
dot3 command.

default Ildp tx-tlv dot3 command parameters and variables

Parameters and variables Description

port <portlist> The ports affected by the command.

The MAC/Phy Configuration/Status TLV
(default value is false: not included).

mac-phy-config-status

The power via MDI TLV (default value is false:

mdl-power-support not included).

The link aggregation TLV (default value is

link-aggregation false: not included).

The maximum frame size TLV (default value

maximum-frame-size . :
is false: not included).

no lldp port command
The no 11dp port command disables LLDP features on the port. The
syntax for the no 11dp port command is

no 11ldp [port <portlist>] [config notification] [status]

Run the no 11dp port command in Interface Configuration command
mode.
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no lldp tx-tlv command

The no 11dp tx-tlv command specifies the optional Management TLVs

not to include in the transmitted LLDPDUSs. The syntax for the no 11dp
tx-tlv command is

no lldp tx-tlv [port <portlist>] [port-desc] I[sys-namel]
[sys-desc] [sys-cap] [local-mgmt-addr]

Run the no 11dp tx-tlv command in Interface Configuration command
mode.

no lldp tx-tlv dotl command

Theno 1lldp tx-tlv dotl command specifies the optional IEEE 802.1
TLVs not to include in the transmitted LLDPDUs. The syntax for the no
1l1dp tx-tlv dotl command is

no lldp tx-tlv [port <portlist>] dotl [port-vlan-id]

[vlian-name] [port-protocol-vlan-id] [protocol-identity [EAP]
[LLDP] [STP] ]

Run the no 11dp tx-tlv dotl command in Interface Configuration
command mode.

no lldp tx-tlv dot3 command

The no 11dp tx-tlv dot3 command specifies the optional IEEE 802.3
TLVs not to include in the transmitted LLDPDUSs. The syntax for the no
1l1dp tx-tlv dot3 command is

no lldp tx-tlv [port <portlist>] dot3
[mac-phy-config-status] [mdi-power-supportl]
[link-aggregation] [maximum-£frame-size]

Run the no 11dp tx-tlv dot3 command in Interface Configuration
command mode.

show lldp command

The show 11dp command displays the LLDP parameters. The syntax for
the show 11ldp command is

show 11ldp [local-sys-data {dotl | dot3 | detail}]
[mgmt - sys-datal

[rx-stats] [tx-stats] [stats] [pdu-tlv-size]
[tx-tlv {dotl | dot3 }]

[neighbor { dotl [vlan-names | protocol-id]l } | [dot3] |
[detail] 1]

[neighbor-mgmt-addr]

Run the show 11dp command in Privileged EXEC command mode.
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The following table describes the show 11dp command parameters and

variables.

show lldp command parameters

Parameters and variables

Description

local-sys-data {dotl | dot3
| detail}

The organizationally-specific TLV properties on
the local switch:

* dotl: displays the 802.1 TLV properties

* dot3: displays the 802.3 TLV properties

» detail: displays all organizationally specific
TLV properties

To display the properties of the optional
management TLVs, include only the
local-sys-data parameter in the command.

mgmt-sys-data

The local management system data.

rx-stats The LLDP receive statistics for the local system.
tx-stats The LLDP transmit statistics for the local system.
stats The LLDP table statistics for the remote system.
pdu-tlv-size The different TLV sizes and the number of TLVs

in an LLDPDU.

tx-tlv {dot1 | dot3 }

Display which TLVs are transmitted from the local
switch in LLDPDUSs:

» dotl: displays status for 802.1 TLVs
» dot3: displays status for 802.3 TLVs
To display the transmission status of the optional

management TLVs, include only the tx-tlv
parameter in the command.

neighbor { dotl
[vlan-names | protocol-id] }

|
[dot3] [detail]

The neighbor TLVs:
* dotl: displays 802.1 TLVs:
— vlan-names: VLAN Name TLV

— protocol-id: Protocol Identity TLV

* dot3: displays 802.3 TLVs
» detail: displays all TLVs

[neighbor-mgmt-addr]

The LLDP neighbor management address.
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show lldp port command

The show 11dp port command displays the LLDP port parameters. The
syntax for the show 11ldp port command is

show 1lldp port <portlist> [rx-stats] [tx-stats] [pdu-tlv-si
ze] [tx-tlv {dotl | dot3 }]
[neighbor {dotl [vlan-names | protocol-id] } | [dot3]

Run the show 11dp port command in Privileged EXEC command mode.

show lldp port command parameters

Parameters and variables Description

rx-stats The LLDP receive statistics for the local port.
tx-stats The LLDP transmit statistics for the local port.
du-tlv-size The different TLV sizes and the number of TLVs
P in an LLDPDU.
Display which TLVs are transmitted from the
local port in LLDPDUSs:
e dotl: displays status for 802.1 TLVs
tx-tlv {dot1 | dot3 } » dot3: displays status for 802.3 TLVs

To display the transmission status of the
optional management TLVs, include only the
tx-tlv parameter in the command.

The port neighbor TLVs:
e dotl: displays 802.1 TLVs:
— vlan-names: VLAN Name TLV

neighbor { dot1 [vlan-names
| protocol-id] } |

[dot3] | [detail — protocol-id: Protocol Identity TLV

e dot3: displays 802.3 TLVs
e detail: displays all TLVs.

[neighbor-mgmt-addr] The port neighbor LLDP management address.

LLDP configuration example

By default, LLDP is enabled for Tx and Rx on all switch ports. The default
value for the LLDP Tx interval is 30 seconds (LLDPDUs are sent at 30
seconds). With the default settings, only the mandatory TLVs are sent, but
the switch can receive any LLDP Core, DOT1, or DOT3 TLV from its peers.

"LLDP configuration example" (page 265)
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LLDP configuration example

Ethernet Routing Switch
Router 5500 Series

IP Phone

Management
Workstation

To configure the example shown above, you must perform the following

tasks:

Step Action

1 Modify the default LLDP Tx interval from (the default 30 second
value) to 60 seconds.
Note that if any modification is detected in the LLDP local-sys-data
before the Tx interval expires, an LLDPDU is immediately sent on all
active links in order to update the peers neighbor tables.

2 Enable the Port Description TLV for transmission. (contains the
description of the LLPD sending port)

3 Enable the System Name TLV for transmission. (contains the name
of the LLDP device)

4 Enable the System Description TLV for transmission. (contains the
description of the LLDP device)

5 Enable the System Capabilities TLV for transmission. (contains the
capabilities of the LLDP device)

6 Enable the Management Address TLV for transmission. (contains
the management address of the LLDP device)

7 Enable the Port VLAN ID TLV for transmission. (contains the PVID

of the LLDP sending port)
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8 Enable the Port And Protocol VLAN ID TLV for transmission.
(indicates the Port and Protocol VLANSs to which the LLDP sending
port belongs to).

9 Enable the VLAN Name TLV for transmission. (indicates the names
of the VLANSs to which the LLDP sending port belongs to)

10 Enable the Protocol Identity TLV for transmission. (indicates the
supported protocols by the LLDP sending port)

11 Enable the MAC/PHY Configuration/Status TLV for transmission.
(indicates the IEEE 802.3 duplex and bitrate capabilities and settings
of the LLDP sending port)

12 Enable the Power Via MDI TLV for transmission. (indicates the MDI
power support capabilities of the LLDP sending port)

13 Enable the Link Aggregation TLV for transmission. (indicates the link
aggregation capability and status of the LLDP sending port)

14 Enable the Maximum Frame Size TLV for transmission. (indicates
the maximum frame size that could be handled by the LLDP sending

port)

15 Enable the Location Identification TLV for transmission. (indicates
the physical location of the LLDP sending port; three coordinate sets
are available to configure and send)

16 Enable the Extended Power-via-MDI TLV for transmission. (provides
detailed informations regarding the PoE parameters of the LLDP
sending device)

17 Enable the Inventory — Hardware Revision TLV for transmission.
(indicates the hardware revision of the LLDP sending device)

18 Enable the Inventory — Firmware Revision TLV for transmission.
(indicates the firmware revision of the LLDP sending device)

19 Enable the Inventory — Software Revision TLV for transmission.
(indicates the software revision of the LLDP sending device)

20 Enable the Inventory — Serial Number TLV for transmission.
(indicates the serial number of the LLDP sending device)

21 Enable the Inventory — Manufacturer Name TLV for transmission.
(indicates the manufacturer name of the LLDP sending device)

22 Enable the Inventory — Model Name TLV for transmission. (indicates
the model name of the LLDP sending device)

—End—
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Note: There is currently no ACG support for LLDP.

Detailed configuration commands
The following section describes the detailed CLI commands required to carry
out the configuration depicted by "LLDP configuration example" (page 265)

Modifying the default LLDP Tx interval Enter configuration commands,
one for each line. End with CNTL/Z.

4548GT-PWR-PWR>enable
4548GT-PWR#configure terminal
4548GT-PWR (config) #11dp tx-interval 60

Checking the new LLDP global settings

4548GT-PWR (config) #show 11dp

802.l1lab configuration:

TxInterval:60
TxHoldMultiplier:4
RxInitDelay:?2
TxDelay:2
NotificationInterval:5

Enabling all LLDP Core TLVs for transmission on the router and IP
Phone ports

4548GT-PWR (config) #interface fastEthernet 1/13 454

8GT-PWR (config-if)#11ldp tx-tlv port 1/13 port-desc
4548GT-PWR (config-if) #11dp tx-tlv port 1/13 sys-name
4548GT-PWR (config-if) #11ldp tx-tlv port 1/13 sys-desc
4548GT-PWR (config-if) #11dp tx-tlv port 1/13 sys-cap
4548GT-PWR (config-if) #11dp tx-tlv port 1/13 local-mgmt-addr

Checking the LLDP settings of the router and IP Phone ports

4548GT-PWR (config-if) #show 1l1ldp port 1/13 tx-tlv

PortDesc SysName SysDesc SysCap MgmtAddr

1 true true true true true
13 true true true true true
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Enabling all LLDP DOT1 TLVs for transmission on the router and IP
Phone ports

4548GT-PWR (config-if) #11dp tx-tlv port 1/13 dotl port-vlan-id
4548GT-PWR (config-if) #11dp tx-tlv port 1/13 dotl
port-protocol-vlan-id

4548GT-PWR (config-if) #11dp tx-tlv port 1/13 dotl vlan-name
4548GT-PWR (config-if) #11dp tx-tlv port 1/13 dotl
protocol-identity EAP LLDP STP

Checking the LLDP settings of the router and IP Phone ports

4548GT-PWR (config-if) #show 11ldp port 1/13 tx-tlv dotl

Dotl protocols: STP,EAP,LLDP

Port PortVlanId VlanNameList
PortProtocolVlanId ProtocolIdentity

1 true 1 1
ALL
13 true 1 1
ALL

Enabling all LLDP DOT3 TLVs for transmission on the router and IP
Phone ports

4548GT-PWR (config-if) #11dp tx-tlv port 1/13 dot3
mac-phy-config-status

4548GT-PWR (config-if)#11dp tx-tlv port 1/13 dot3
mdi-power-support

4548GT-PWR (config-if) #11dp tx-tlv port 1/13 dot3
link-aggregation

4548GT-PWR (config-if)#11dp tx-tlv port 1/13 dot3
maximum-frame-size

Checking the LLDP settings of the router and IP Phone ports

4548GT-PWR (config-if) #show 1l1ldp port 1/13 tx-tlv dot3

Port MacPhy MdiPower Link MaxFrameSize
ConfigStatus Support Aggregation

1 true true true true
13 true true true true
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Configuring LLDP using Device Manager
The following sections describe how to configure and view LLDP information
using Device Manager.

"Viewing and configuring LLDP global and transmit properties" (page
269)

"LLDP_Port_dotl dialog box" (page 294)
"LLDP_Port_dot_3 dialog box" (page 305)

Viewing and configuring LLDP global and transmit properties
Use the following tabs to configure and view LLDP global and transmit
properties for local and neighbor systems:

"Globals tab" (page 269)

"Port tab" (page 273)

"TX Stats tab" (page 275)

"Graphing LLDP transmit statistics" (page 277)
"RX Stats tab" (page 278)

"Graphing LLDP receive statistics" (page 280)
"Local System tab" (page 281)

"Local Port tab" (page 283)

"Local Management tab" (page 285)
"Neighbor tab" (page 286)

"Neighbor Mgmt Address tab" (page 289)
"Unknown TLV tab" (page 290)
"Organizational Defined Info tab" (page 292)

Globals tab
With the Globals tab, you can configure LLDP transmit properties and view
remote table statistics.

To open the Globals tab, perform the following procedure:

Step Action

1

From the Device Manager menu bar, choose Edit > Diagnostics >
802.1ab > LLDP.

The LLDP dialog box appears with the Globals tab displayed ("LLDP
Globals tab" (page 270)).
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LLDP Globals tab
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"LLDP Globals tab fields" (page 270) describes the Globals tab
fields.

LLDP Globals tab fields

Field Description

lldpMessageTxInterval The interval, in seconds, at which LLDP
frames are transmitted on behalf of this
LLDP agent.

lldpMessageTx The time-to-live value expressed as

HoldMultiplier a multiple of the object. The actual

time-to-live value used in LLDP frames,
transmitted on behalf of this LLDP agent,
is expressed by the following formula:
TTL = min(65535, (lldpMessageTxInterval
*ldpMessageTxHoldMultiplier))

For example, if the value of
lldpMessageTxInterval is 30, and

the value of lldpMessageTxHoldMultiplier
is 4, the value 120 is encoded in the TTL
field in the LLDP header.

lldpReinitDelay The lldpReinitDelay indicates the delay
(in seconds) from when the LLDP Port
AdminStatus of a particular port is
disabled until reinitialization begins.

lldpTxDelay The lldpTxDelay indicates the delay (in
seconds) between successive LLDP
frame transmissions initiated by value

or status changes in the LLDP local
systems MIB. The recommended value
for the lldpTxDelay is set by the following
formula:

1 <= lldpTxDelay <= (0.25 *
lldpMessageTxInterval)
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Field Description

lldpNotificationinterval This object controls the transmission

of LLDP notifications. The agent

must not generate more than one
lldpRemTablesChange notification-event
in the indicated period, where a
notification-event is the "transmission of
a single notification PDU type to a list
of notification destinations." If additional
changes in lldpRemoteSystemsData
object groups occur within the indicated
throttling period, these trap-events must
be suppressed by the agent. An NMS
must periodically check the value of
lldpStatsRemTableLastChangeTime to
detect any missed lldpRemTablesChange
notification-events, for example, due

to throttling or transmission loss. If
notification transmission is enabled for
particular ports, the suggested default
throttling period is 5 seconds.

RemTablesLast The value of the sysUpTime object
ChangeTime (defined in IETF RFC 3418) at the
time an entry is created, modified, or
deleted in tables associated with the
lldpRemoteSystemsData objects, and
all LLDP extension objects associated
with remote systems. An NMS can
use this object to reduce polling of the
lldpRemoteSystemsData objects.

RemTablesInserts The number of times the complete

set of information advertised by a
particular MSAP is inserted into tables
contained in lldpRemoteSystemsData and
lldpExtensions objects. The complete set
of information received from a particular
MSAP is inserted into related tables. If
partial information cannot be inserted

for a reason such as lack of resources,
all of the complete set of information is
removed. This counter is incremented
only once after the complete set of
information is successfully recorded in

all related tables. Any failures occurring
during insertion of the information set,
which result in deletion of previously
inserted information, do not trigger any
changes in lldpStatsRemTablesInserts
because the insert is not completed yet or
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Field

Description

in lldpStatsRemTablesDeletes, because
the deletion is only a partial deletion. If the
failure is the result of a lack of resources,
the lldpStatsRemTablesDrops counter is
incremented once.

RemTablesDeletes

The number of times the complete

set of information advertised by a
particular MSAP is deleted from tables
contained in lldpRemoteSystemsData
and lldpExtensions objects. This counter
is incremented only once when the
complete set of information is completely
deleted from all related tables. Partial
deletions, such as a deletion of rows
associated with a particular MSAP, from
some tables, but not from all tables, are
not allowed, and thus, do not change the
value of this counter.

RemTablesDrops

The number of times the complete set
of information advertised by a particular
MSAP can not be entered into tables
contained in lldpRemoteSystemsData
and lldpExtensions objects because of
insufficient resources.

RemTablesAgeouts

The number of times the complete

set of information advertised by a
particular MSAP is deleted from tables
contained in lldpRemoteSystemsData
and lldpExtensions objects because

the information timeliness interval has
expired. This counter is incremented only
once when the complete set of information
is completely invalidated (aged out) from
all related tables. Partial aging, similar to
deletion case, is not allowed, and thus,
does not change the value of this counter.

—End—

See also:
« "Port tab" (page 273)

e "TX Stats tab" (page 275)

e "Graphing LLDP transmit statistics" (page 277)
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* "RX Stats tab" (page 278)

e "Graphing LLDP receive statistics" (page 280)
e "Local System tab" (page 281)

e "Local Port tab" (page 283)

* "Local Management tab" (page 285)

* "Neighbor tab" (page 286)

* "Neighbor Mgmt Address tab" (page 289)

e "Unknown TLV tab" (page 290)

e "Organizational Defined Info tab" (page 292)
Port tab

With the Port tab, you can set the optional TLVs to include in the LLPDUs
transmitted by each port.

To open the Port tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diagnostics >
802.1ab > LLDP.
The LLDP dialog box appears with the Globals tab displayed.

2 Click the Port tab.
The Port tab appears.
LLDP Port tab

@ 192.168.249.46 - LLDP B
lobats [FOrt ] mo Stats | Rt Stats | Local System | Local Port | Local Management | Mesghbor | Mesghbor Mgt Address | Uinknown TLY | Organiational Defined Info |

JMJQJ GIEIQ__JJ
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T

"Port tab fields" (page 274) describes the Port tab fields.

Port tab fields

Field Description
PortNum Port number.
AdminStatus The administratively desired status of the

local LLDP agent:

* txOnly: the LLDP agent transmits
LLDP frames on this port and does not
store any information about the remote
systems to which it is connected.

e rxOnly: the LLDP agent receives but
does not transmit LLDP frames on this
port.

* txAndRx: the LLDP agent transmits and
receives LLDP frames on this port.

» disabled: the LLDP agent does not
transmit or receive LLDP frames on this
port. If the port receives remote systems
information which is stored in other
tables before AdminStatus is disabled,
the information ages out.

NotificationEnable Controls, on a per-port basis, whether
notifications from the agent are enabled.

« true: indicates that notifications are
enabled

» false: indicates that notifications are
disabled.

TLVsTxEnable Sets the optional Management TLVs to be
included in the transmitted LLDPDUSs:

e portDesc: Port Description TLV

* sysName: System Name TLV

» sysDesc: System Description TLV
* sysCap: System Capabilities TLV

Note: The Local Management tab controls
Management Address TLV transmission.
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Field Description

VLANTxEnable(dot1) Specifies whether the IEEE 802.1
organizationally defined port VLAN TLV
transmission is included in the transmitted
LLDPDUs.

TLVsTxEnable(dot3) Sets the optional IEEE 802.3 organizationally
defined TLVs to be included in the transmitted
LLDPDUs:

* macPhyConfigStatus: MAC/PHY
configuration/status TLV

» powerViaMDI: Power over MDI TLV

» linkAggregation: Link Aggregation TLV

* maxFrameSize: Maximum-frame-size
TLV.

—End—

See also:

e "Globals tab" (page 269)

e "TX Stats tab" (page 275)

e "Graphing LLDP transmit statistics" (page 277)
* "RX Stats tab" (page 278)

e "Graphing LLDP receive statistics" (page 280)
e "Local System tab" (page 281)

e "Local Port tab" (page 283)

e "Local Management tab" (page 285)

e "Neighbor tab" (page 286)

* "Neighbor Mgmt Address tab" (page 289)

e "Unknown TLV tab" (page 290)

e "Organizational Defined Info tab" (page 292)
TX Stats tab

With the TX Stats tab, you can view LLDP transmit statistics by port.

To open the TX Stats tab, perform the following procedure.
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Step Action

1 From the Device Manager menu bar, choose Edit > Diagnostics >
802.1ab > LLDP.
The LLDP dialog box appears with the Globals tab displayed.

2 Click the TX Stats tab.
The TX Stats tab appears ("TX Stats tab" (page 276).

TX Stats tab

* 192.168,249.46 - LLDP = x|
obuls | Port [TH5E8ES || it Stats | Local System | Local Port | Lozal Management | Nesghbor | Neighbor Mmt Address | Unknorm TLY | Organizational Defined Infa
Porthium | FramesToral

0 9

BN

0 rowis)

"TX Stats tab fields" (page 276) describes the TX Stats tab fields.

TX Stats tab fields

Field Description

PortNum port number

FramesTotal the number of LLDP frames transmitted
by this LLDP agent on the indicated port

—End—

See also:

e "Globals tab" (page 269)

* "Port tab" (page 273)

e "Graphing LLDP transmit statistics" (page 277)
* "RX Stats tab" (page 278)

e "Graphing LLDP receive statistics" (page 280)
e "Local System tab" (page 281)

e "Local Port tab" (page 283)

e "Local Management tab" (page 285)

* "Neighbor tab" (page 286)

¢  "Neighbor Mgmt Address tab" (page 289)

e "Unknown TLV tab" (page 290)

e "Organizational Defined Info tab" (page 292)
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Graphing LLDP transmit statistics
To graph LLDP transmit statistics, perform the following procedure.

Step Action
1 From the TX Stats tab "TX Stats tab" (page 276)), select the port for
which you want to display statistics.
2 Click Graph.
The TX Stats - Graph dialog box appears.
%5 192.168.249.46 - LLDP Port 1/1 x|
Absolutealue | Cumulati *A It HM"m.f Maximumy: Lastyalf:
e S0 BgTS:S L8 W'IBI WEragelsec iy Sﬁo CHTTILT), SGS.CI S5V 3l SE;
@[Q'EL@ Clear Countsrsl Closel Help‘..l Pol Interval: [10s+ ] 0 day, D0hiosmiass
3 Highlight a data column to graph.
4 Click one of the graph buttons.
—End—
See also:

"Globals tab" (page 269)

"Port tab" (page 273)

"TX Stats tab" (page 275)

"RX Stats tab" (page 278)

"Graphing LLDP receive statistics" (page 280)
"Local System tab" (page 281)

"Local Port tab" (page 283)

"Local Management tab" (page 285)
"Neighbor tab" (page 286)

"Neighbor Mgmt Address tab" (page 289)
"Unknown TLV tab" (page 290)
"Organizational Defined Info tab" (page 292)
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RX Stats tab
With the RX Stats tab, you can view LLDP receive statistics by port.

To open the RX Stats tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diagnostics >
802.1ab > LLDP.
The LLDP dialog box appears with the Globals tab displayed.

2 Click the RX Stats tab.
The RX Stats tab appears ("RX Stats tab" (page 278)).

RX Stats tab

=, 192.168.249.45 - LLDP x|
Gobals | Port | T Stats [FASIEE]| Locsl System | Loal Port | Local Mansgement | Neighbor | Meighbor Mgmt Address | Unknown TLY | Orgarzstiondl Defined Info
Porthim | I | [ [ T [ AgeoitsTotal |
I o] ] B o Ll o 2
1z 8| ol ol 0| o] o
T o 0 o] a [ 0
18] of ] o] L] ]| o)
s 0| L] 1] a [] 1]
| 0| ] o 0 o ol
7 0| [l 0| | o ol
s o ol o o ) o
1] al 0| o o| 1] ol
e o] o o] o “of [
i ] 0 (1] a ] o
i.J'!Z ﬂi o 0f -(:ll 0 ol
FI[E] 0| 0| o a 0 ol
114 o [l 0 o o ol
s ol g o ol 9 o
i ol ol o i L] o)
7 0 a ] a [ (]
e of o] 9 Ll o] L]
118 | al o a [] o -
if#, Ll ] o a 0 (]
121 | il o 0| o ol
| |
2] L — — 7 ) — -
: rafresh | 13| B3| (5] Cloce | . |
26 row(s:

"RX Stats tab fields" (page 278) describes the RX Stats tab fields.

RX Stats tab fields

Field Description
PortNum Port number.
FramesDiscardedTotal The number of LLDP frames received on

the port and discarded for any reason.
This counter provides an indication that
LLDP header formatting problems exist
with the local LLDP agent in the sending
system, or that LLDPDU validation
problems exist with the local LLDP agent
in the receiving system.

FramesErrors The number of invalid LLDP frames
received on the port, while the LLDP
agent is enabled.
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Field Description

FramesTotal The number of valid LLDP frames
received on the port, while the LLDP
agent is enabled.

TLVsDiscardedTotal The number of LLDP TLVs discarded for
any reason.

TLVsUnrecognizedTotal The number of LLDP TLVs received on
a given port that are not recognized by
this LLDP agent on the indicated port.
An unrecognized TLV is referred to as
the TLV whose type value is in the range
of reserved TLV types (000 1001 - 111
1110) in Table 9.1 of IEEE 802.1AB-2004.
An unrecognized TLV can be a basic
management TLV from a later LLDP
version.

AgeoutsTotal This counter represents the number of
age-outs that occurred on a given port.
An age-out is "the number of times the
complete set of information advertised by
a particular MSAP is deleted from tables
contained in lldpRemoteSystemsData
and lldpExtensions objects because

the information timeliness interval has
expired." This counter is similar to
lldpStatsRemTablesAgeouts, except that
it is on a per-port basis. This enables
NMS to poll tables associated with the
lldpRemoteSystemsData objects and all
LLDP extension objects associated with
remote systems on the indicated port
only. This counter is set to zero during
agent initialization. When the admin
status for a port changes from disabled
to rxOnly, txOnly or txAndRX, the counter
associated with the same port is reset

to 0. The agent also flushes all remote
system information associated with the
same port. This counter is incremented
only once when the complete set of
information is invalidated (aged out) from
all related tables on a particular port.
Partial aging is not allowed, and thus,
does not change the value of this counter.

—End—
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See also:

e "Globals tab" (page 269)

* "Port tab" (page 273)

e "TX Stats tab" (page 275)

e "Graphing LLDP transmit statistics" (page 277)
e "Graphing LLDP receive statistics" (page 280)
e "Local System tab" (page 281)

e "Local Port tab" (page 283)

* "Local Management tab" (page 285)

* "Neighbor tab" (page 286)

e "Neighbor Mgmt Address tab" (page 289)

e "Unknown TLV tab" (page 290)

e "Organizational Defined Info tab" (page 292)

Graphing LLDP receive statistics
To graph LLDP receive statistics, perform the following procedure.

Step Action

1 From the RX Stats tab "RX Stats tab" (page 278), select the port for
which to display statistics.

2 Click Graph.
The RX Stats - Graph dialog box appears.

%5 192.168.249.46 - LLDP Port 1/1 x|
AbsoluteValue | Cumulative | Average/sec | Minimumjsec | Maximum/sec | LastValfsec

(FramesDiscardedTotal

FramesEtrors

FramesTokal
TLVsDiscardedTatal
TLYsUnrecognizedTotal

E‘@lg@@l Clear Countersl Ciosal Help...l Poll Inkterval: IlUs '|Dday, 00h:00m: 205

== ===
(== == E=]
oooiolo
(== =R =] =]
oolololo
olo|ojolo

3 Highlight a data column to graph.
4 Click one of the graph buttons.
—End—
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See also:

e "Globals tab" (page 269)

* "Port tab" (page 273)

e "TX Stats tab" (page 275)

e "Graphing LLDP transmit statistics" (page 277)
* "RX Stats tab" (page 278)

e "Local System tab" (page 281)

e "Local Port tab" (page 283)

* "Local Management tab" (page 285)

* "Neighbor tab" (page 286)

e "Neighbor Mgmt Address tab" (page 289)

e "Unknown TLV tab" (page 290)

e "Organizational Defined Info tab" (page 292)
Local System tab

With the Local System tab, you can view LLDP properties for the local
system.

To open the Local System tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diagnostics >
802.1ab > LLDP.
The LLDP dialog box appears with the Globals tab displayed.

2 Select Local System.
The Local System tab appears ("Local System tab" (page 281)).

Local System tab
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"Local System tab fields" (page 282) describes the Local System
tab fields.

Local System tab fields

Field Description

ChassisldSubtype The type of encoding used to identify the
local system chassis:

» chassisComponent
* interfaceAlias

e portComponent

* macAddress

* networkAddress

e interfaceName

* local
Chassisld The chassis ID.
SysName The local system name.
SysDesc The local system description .
SysCapSupported The system capabilities supported on the
local system.
SysCapEnabled The system capabilities that are enabled

on the local system

—End—

See also:

e "Globals tab" (page 269)

* "Port tab" (page 273)

e "TX Stats tab" (page 275)

e "Graphing LLDP transmit statistics" (page 277)
* "RX Stats tab" (page 278)

e "Graphing LLDP receive statistics" (page 280)
e "Local Port tab" (page 283)

* "Local Management tab" (page 285)

* "Neighbor tab" (page 286)

¢ "Neighbor Mgmt Address tab" (page 289)
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e "Unknown TLV tab" (page 290)
e "Organizational Defined Info tab" (page 292)
Local Port tab

With the Local Port tab, you can view LLDP port properties for the local
system.

To open the Local Port tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diagnostics >
802.1ab > LLDP.
The LLDP dialog box appears with the Globals tab displayed.

2 Click the Local Port tab.
The Local Port tab appears ("Local Port tab" (page 283)).

Local Port tab

. 192.168,249.46 - LLDP

| Meighbor | Meighibor Mgt Addrass | Linknosn TLY | Orgentzational Defired [nfo |

1f24macAddress 001 L% 35:00:18 (Port 24 =l

ten] ]3] B o]

% rowe(s)

"Local Port tab fields" (page 283) describes the Local Port tab fields.

Local Port tab fields

Field Description

PortNum Port number.
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Field Description

PortldSubtype The type of port identifier encoding used
in the associated Portld object.

* interfaceAlias

e portComponent
* macAddress

* networkAddress
* interfaceName

* agentCircuitld

* J|ocal.

Portld The string value used to identify the port
component associated with a given port
in the local system.

PortDesc The string value used to identify the 802
LAN station port description associated
with the local system. If the local agent
supports IETF RFC 2863, the PortDesc
object has the same value as the ifDescr
object.

—End—

See also:

e "Globals tab" (page 269)

e "Port tab" (page 273)

e "TX Stats tab" (page 275)

e "Graphing LLDP transmit statistics" (page 277)
* "RX Stats tab" (page 278)

e "Graphing LLDP receive statistics" (page 280)
* "Local System tab" (page 281)

e "Local Management tab" (page 285)

* "Neighbor tab" (page 286)

* "Neighbor Mgmt Address tab" (page 289)

e "Unknown TLV tab" (page 290)

e "Organizational Defined Info tab" (page 292)
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Local Management tab
With the Local Management tab, you can view LLDP management
properties for the local system.

To open the Local Management tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diagnostics >
802.1ab > LLDP.
The LLDP dialog box appears with the Globals tab displayed.

2 Click the Local Management tab.

The Local Management tab appears ("Local Management tab"
(page 285)).

Local Management tab
L 192.168.249.46 - LLDP x|
Gobls | Part | Tx Stats | Rt tats | Local System | Local Port [Uocal Managiivr | Mesghbor | Nelghbor Mgt Addvess | inknou TLY | Organizational Defined Irfo |

| add [ addrien] | addrirrd
it IRIGE2NAG ) 4junknown | Of.1.3:

o | ot | 0] Y] 9] ] &3 e .|

"Local Management tab fields" (page 285) describes the Local
Management tab fields.

Local Management tab fields

Field Description

AddrSubtype The type of management address
identifier encoding used in the associated
Addr object.

Addr The string value used to identify the
management address component
associated with the local system.
This address is used to contact the
management entity.

AddrLen The total length of the management
address subtype and the management
address fields in LLDPDUs transmitted by
the local LLDP agent. The management
address length field is needed so that the
receiving systems that do not implement
SNMP are not required to implement

an iana family numbers/address length
equivalency table to decode the
management address.
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Field Description

AddrlfSubtype Identifies the numbering method used to
define the interface number associated
with the remote system.

* unknown
* iflndex
» systemPortNumber

Addrifld The integer value used to identify the
interface number of the management
address component associated with the
local system.

AddrOID The value used to identify the type of
hardware component or protocol entity
associated with the management address
advertised by the local system agent.

AddrPortsTxEnable Identifies the ports on which the local
system management address TLVs are
transmitted in the LLPDUs.

—End—

See also:

e "Globals tab" (page 269)

e "Port tab" (page 273)

e "TX Stats tab" (page 275)

e "Graphing LLDP transmit statistics" (page 277)
* "RX Stats tab" (page 278)

e "Graphing LLDP receive statistics" (page 280)
* "Local System tab" (page 281)

e "Local Port tab" (page 283)

* "Neighbor tab" (page 286)

* "Neighbor Mgmt Address tab" (page 289)

e "Unknown TLV tab" (page 290)

e "Organizational Defined Info tab" (page 292)

Neighbor tab
With the Neighbor tab, you can view LLDP properties for the remote system.
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To open the Neighbor tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diagnostics >
802.1ab > LLDP.
The LLDP dialog box appears with the Globals tab displayed.

2 Click the Neighbor tab.
The Neighbor tab appears ("Neighbor tab" (page 287)).

Neighbor tab

T X
Gobals | Port | T Stats | Rt Stats | L | Locaiport | [Hisighticr || Nesghisor Mgt Addrass | Uinknown TLY | Organisstional Defined Info |

[ Timettak | aam | inde | €h [ chassstd [ svse [ Systaptnabled [ Sratiame | Sysbiose | Portidsubiype | Porttd [ Fortiesc |

0 rows)

"Neighbor tab fields" (page 287) describes the Neighbor tab fields.

Neighbor tab fields

Field Description

TimeMark The TimeFilter for this entry.

See the TimekFilter textual convention
in IETF RFC 2021 for details about
TimeFilter.

LocalPortNum Identifies the local port on which the
remote system information is received.

Index An arbitrary local integer value used

by this agent to identify a particular
MSAP. An agent is encouraged to assign
monotonically increasing index values to
new entries, starting with one, after each
reboot.

ChassisldSubtype The type of encoding used to identify the
remote system chassis:

» chassisComponent
* interfaceAlias

* portComponent

* macAddress

* networkAddress

* interfaceName

e Jocal.

Chassisld Remote chassis ID.
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Field Description

SysCapSupported Identifies the system capabilities
supported on the remote system.

SysCapEnabled Identifies the system capabilities that are
enabled on the remote system.

SysName Remote system name.

SysDesc Remote system description.

PortldSubtype The type of encoding used to identify the

remote port.

* interfaceAlias

* portComponent
* macAddress

* networkAddress
* interfaceName

* agentCircuitld

* local
Portld Remote port ID.
PortDesc Remote port description.
—End—

See also:

e "Globals tab" (page 269)

e "Port tab" (page 273)

e "TX Stats tab" (page 275)

e "Graphing LLDP transmit statistics" (page 277)
* "RX Stats tab" (page 278)

* "Graphing LLDP receive statistics" (page 280)
e "Local System tab" (page 281)

e "Local Port tab" (page 283)

* "Local Management tab" (page 285)

* "Neighbor Mgmt Address tab" (page 289)

e "Unknown TLV tab" (page 290)

* "Organizational Defined Info tab" (page 292)
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Neighbor Mgmt Address tab
With the Neighbor Mgmt Address tab, you can view LLDP management
properties for the remote system.

To open the Neighbor Mgmt Address tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diagnostics >
802.1ab > LLDP.
The LLDP dialog box appears with the Globals tab displayed.

2 Click the Neighbor Mgmt Address tab.

The Neighbor Mgmt Address tab appears ("Neighbor Mgmt Address
tab" (page 289)).

Neighbor Mgmt Address tab

x|
Gobals | Port | T Stats | Rt Stats | L | Locaiport | | Meighteor [Msigiibior it Aidress | Unknow TLY | Organizational Defined Info |
|[|w| gum | S | [ ads| vpe | ekt | aarcap |
Drows)

"Neighbor Mgmt Address tab fields" (page 289) describes the
Neighbor Mgmt Address tab fields.

Neighbor Mgmt Address tab fields

Field Description
TimeMark The TimeFilter for this entry.
LocalPortNum The local port on which the remote system

information is received.

Index An arbitrary local integer value used

by this agent to identify a particular
MSAP. An agent is encouraged to assign
monotonically increasing index values to
new entries, starting with one, after each
reboot.

AddrSubtype The type of encoding used in the
associated Addr object.

Addr The management address associated
with the remote system.
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Field Description

AddrlfSubtype The numbering method used to define
the interface number associated with the
remote system.

* unknown
* iflndex
» systemPortNumber

Addrifld The integer value used to identify the
interface number of the management
address component associated with the
remote system.

AddrOID The value used to identify the type of
hardware component or protocol entity
associated with the management address
advertised by the remote system agent.

—End—

See also:

e "Globals tab" (page 269)

* "Port tab" (page 273)

e "TX Stats tab" (page 275)

e "Graphing LLDP transmit statistics" (page 277)
* "RX Stats tab" (page 278)

* "Graphing LLDP receive statistics" (page 280)
e "Local System tab" (page 281)

* "Local Port tab" (page 283)

* "Local Management tab" (page 285)

e "Neighbor tab" (page 286)

* "Unknown TLV tab" (page 290)

* "Organizational Defined Info tab" (page 292)
Unknown TLV tab

With the Unknown TLV tab, you can view details about unknown TLVs
received on the local system.

To open the Unknown TLV tab, perform the following procedure.
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Step Action

1 From the Device Manager menu bar, choose Edit > Diagnostics >
802.1ab > LLDP.
The LLDP dialog box appears with the Globals tab displayed.

2 Click the Unknown TLV tab.
The Unkown TLV tab appears ("Unknown TLV tab" (page 291)).

Unknown TLV tab

., 192.168,249.46 - LLDP
obals | Port | T Stk | R Stats | L | Lo Port | | Meighbor | Meightbor Mgme Addrass [Iikreen TLV | organizational Defined Info |
[ miemettark | Locaarttium | tndes | UnknownTLType |

] ] ] 8] o] .

"Unknown TLV tab fields" (page 291) describes the Unkown TLV
tab fields.

Unknown TLV tab fields

Field Description
TimeMark The TimeFilter for this entry.
LocalPortNum The local port which receives the remote

system information.

Index An arbitrary local integer value used

by this agent to identify a particular
MSAP. An agent is encouraged to assign
monotonically increasing index values to
new entries, starting with one, after each
reboot.

UnknownTLVType The value extracted from the type field of
the unknown TLV.

UnknownTLVInfo The value extracted from the value field
of the unknown TLV.

—End—

See also:

e "Globals tab" (page 269)

* "Port tab" (page 273)

e "TX Stats tab" (page 275)

e "Graphing LLDP transmit statistics" (page 277)
* "RX Stats tab" (page 278)
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e "Graphing LLDP receive statistics" (page 280)
e "Local System tab" (page 281)

e "Local Port tab" (page 283)

e "Local Management tab" (page 285)

* "Neighbor tab" (page 286)

* "Neighbor Mgmt Address tab" (page 289)

e "Organizational Defined Info tab" (page 292)
Organizational Defined Info tab

With the Organizational Defined Info tab, you can view Organizationally-
specific properties for the remote system.

To open the Organizational Defined Info tab, perform the following

procedure.
Step Action
1 From the Device Manager menu bar, choose Edit > Diagnostics >

802.1ab > LLDP.
The LLDP dialog box appears with the Globals tab displayed.

2 Click the Organizational Defined Info tab.

The Organizational Defined Info tab appears ("Organizational
Defined Info tab" (page 292)).

Organizational Defined Info tab

. 192.168,249.46 - LLDP

Gobals | Port | T Stats | Rt Stats | L | Locai Port | | Meighber | Neighbor Mgt Addrass | Unknown TLY [roanizationsl Diefivied o ||
[Temettask ] [ e | [ [ [[Grapefinta]

[

0 rowis)

] ] ] 8] o] .

"Organizational Defined Info tab fields" (page 292) describes the
Organizational Defined Info tab fields.

Organizational Defined Info tab fields

Field Description

TimeMark The TimeFilter for this entry.

LocalPortNum The local port that receives the remote
system information.
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Field

Description

Index

An arbitrary local integer value used

by this agent to identify a particular
MSAP. An agent is encouraged to assign
monotonically increasing index values to
new entries, starting with one, after each
reboot.

OrgDeflnfoOUI

The Organizationally Unique Identifier,
as defined in IEEE 802-2001, is a 24 bit
(three octets) globally unique assigned
number referenced by various standards,
of the information received from the
remote system.

OrgDefInfoSubtype

The integer value used to identify

the subtype of the organizationally
defined information received from the
remote system. The subtype value is
required to identify different instances

of organizationally defined information
that cannot be retrieved without a unique
identifier that indicates the particular type
of information contained in the information
string.

OrgDefInfolndex

This object represents an arbitrary local
integer value used by this agent to identify
a particular unrecognized organizationally
defined information instance, unique
only for the OrgDefInfoOUI and
lldpRemOrgDefinfoSubtype of the same
remote system. An agent is encouraged
to assign monotonically increasing index
values to new entries, starting with one,
after each reboot. It is unlikely that

the lldpRemOrgDefinfolndex will wrap
between reboots.

OrdDefInfo

The string value used to identify the
organizationally defined information of
the remote system. The encoding for this
object is the same as that defined for
SnmpAdminString TC.

—End—

See also:

¢ "Globals tab" (page 269)
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e "Port tab" (page 273)

e "TX Stats tab" (page 275)

e "Graphing LLDP transmit statistics" (page 277)
* "RX Stats tab" (page 278)

e "Graphing LLDP receive statistics" (page 280)
e "Local System tab" (page 281)

e "Local Port tab" (page 283)

¢ "Local Management tab" (page 285)

* "Neighbor tab" (page 286)

* "Neighbor Mgmt Address tab" (page 289)

* "Unknown TLV tab" (page 290)

LLDP_Port_dotl dialog box
You can use the LLDP_Port_dot1 dialog box to configure and view IEEE
802.1 LLDP information. For more information, see the following sections:

e "Local VLAN Id tab" (page 294)

e "Local Protocol VLAN tab" (page 295)

e "Local VLAN Name tab" (page 297)

e "Local Protocol tab" (page 298)

e "Neighbor VLAN Id tab" (page 300)

* "Neighbor Protocol VLAN tab" (page 301)
¢ "Neighbor VLAN Name tab" (page 303)

* "Neighbor Protocol tab" (page 304)
Local VLAN Id tab

With the Local VLAN Id tab, you can view LLDP VLAN ID properties for
the local system.

To open the Local VLAN Id tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diaghostics
> 802.1ab > Port dotl.
The LLDP_Port_dotl dialog box appears with the Local VLAN Id tab
displayed ("Local VLAN Id tab" (page 295)).
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Local VLAN Id tab

1 192,160.249.46 - LLDP_Port_dot 1 x|
Local VAR | Local Protacol VLaN | Local VLAN Mame | Local Protocel | Meighbes VLAN Id | Weighber Protoecl vLAN | Meighbsor VLAN Name | Meighber Pregocal |
Farthum | Vianid
11 1 12
A
UE] 1
14 1
1,
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17 1
(7.3 T
19 ]
T
111 1
I 1A
113 i
14 1 =l
Rafresh i@_l_ﬂ_l@ cm;} Hub'
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"Local VLAN Id tab fields" (page 295) describes the Local VLAN
Id tab fields.

Local VLAN Id tab fields

Field Description
PortNum The port number.
Vlanid The local port VLAN ID. A value of zero
is used if the system does not know the
PVID.
—End—

See also:

e "Local Protocol VLAN tab" (page 295)

e "Local VLAN Name tab" (page 297)

* "Local Protocol tab" (page 298)

e "Neighbor VLAN Id tab" (page 300)

* "Neighbor Protocol VLAN tab" (page 301)
*  "Neighbor VLAN Name tab" (page 303)

* "Neighbor Protocol tab" (page 304)
Local Protocol VLAN tab

With the Local Protocol VLAN tab, you can view LLDP Protocol VLAN
properties for the local system.

To open the Local Protocol VLAN tab, perform the following procedure.
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Step Action

1 From the Device Manager menu bar, choose Edit > Diaghostics
> 802.1ab > Port dotl.
The LLDP_Port_dotl dialog box appears with the Local VLAN Id
tab displayed.

2 Click the Local Protocol VLAN tab.
The Local Protocol VLAN tab appears ("Local Protocol VLAN tab"
(page 296)).

Local Protocol VLAN tab

= 192.166.249.46 - LLDP _Port_dot1 x|
Local VLR 1d [[ocal Profocel VCAR] Local VL4t tame | Local Frotose | Nesghbor VLAN 1d | Mesghbor Protoccd YLAN | Nolghbor VLA Nome | Welghbor Protocol |
Forthium | Frota¥iantd | Frotoiiansupported | ProtovianEnabled | ProtoiisnT «Enable |
{1 1 jtue. |brue Fatse: =
- i true Jtrue false
5] e e jiae
14 15us [tros [faise
15| 1 tue Jtrue lfsise
T — T e e
17| 1 tue [Eroe |fekse
18 e true false
i8] e [true TFalse
110/ 1 brue b fakse
i e lrus e
ifiz] 1 true [trie false
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| Altn true {fakse.
| 1 tue [tree false
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"Local Protocol VLAN tab fields" (page 296) describes the Local
Protocol VLAN tab fields.

Local Protocol VLAN tab fields

Field Description
PortNum The port number.
ProtoVianid The ID of the port and protocol VLANS

associated with the local port. A value of
zero is used if the system does not know
the protocol VLAN ID (PPVID).

ProtoVlanSuported Indicate whether the local port supports
port and protocol VLANSs.

ProtoVlanEnabled Indicate whether the port and protocol
VLANSs are enabled on the local port.

ProtoVlanTxEnable Indicate whether the corresponding local
port and protocol VLAN information are
transmitted from the port.

—End—
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See also:

"Local VLAN Id tab" (page 294)

"Local VLAN Name tab" (page 297)
"Local Protocol tab" (page 298)
"Neighbor VLAN Id tab" (page 300)
"Neighbor Protocol VLAN tab" (page 301)
"Neighbor VLAN Name tab" (page 303)
"Neighbor Protocol tab" (page 304)

Local VLAN Name tab
With the Local VLAN Name tab, you can view LLDP VLAN Name properties
for the local system.

To open the Local VLAN Name tab, perform the following procedure.

Step Action

1

From the Device Manager menu bar, choose Edit > Diaghostics
> 802.1ab > Port dotl.

The LLDP_Port_dotl dialog box appears with the Local VLAN Id
tab displayed.

Click the Local VLAN Name tab.
The Local VLAN Name tab appears ("Local VLAN Name tab" (page
297)).

Local VLAN Name tab

= 192.168.249.46 - LLDP_Port_dot1 x|

[ ] B ] Q] S o]
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T

"Local VLAN Name tab fields" (page 298) describes the Local VLAN
Name tab fields.

Local VLAN Name tab fields

Field Description
PortNum The port number.
Vlanid The integer value used to identify the

IEEE 802.1Q VLAN IDs with which the
given port is compatible.

VlanName The string value used to identify the
VLAN name identified by the VLAN ID
associated with the given port on the local
system. This object contains the value
of the dot1QVLANStaticName object
(defined in IETF RFC 2674) identified with
the given lldpXdotlLocVianlid.

VlanNameTxEnable Indicates whether the corresponding
Local System VLAN name instance is
transmitted from the port.

—End—

See also:

e "Local VLAN Id tab" (page 294)

e "Local Protocol VLAN tab" (page 295)

e "Local Protocol tab" (page 298)

* "Neighbor VLAN Id tab" (page 300)

¢ "Neighbor Protocol VLAN tab" (page 301)
¢ "Neighbor VLAN Name tab" (page 303)

* "Neighbor Protocol tab" (page 304)
Local Protocol tab

With the Local Protocol tab, you can view LLDP protocol properties for
the local system.

To open the Local Protocol tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diaghostics
> 802.1ab > Port dotl.

Nortel Ethernet Routing Switch 4500 Series
Overview — System Configuration
NN47205-500 02.01 Standard
5.0 23 February 2007
Copyright © 2007, Nortel Networks Nortel Networks Confidential



Configuring LLDP using Device Manager 299
e |

The LLDP_Port_dot1 dialog box appears with the Local VLAN Id

tab displayed.
2 Click the Local Protocol tab.

The Local Protocol tab appears ("Local Protocol tab" (page 299)).

Local Protocol tab

% 192.168.249.46 - LLDP_Port_dot1

Local VLA 1d | Local Protocol VLAN | Local VLAM Name: [Local Friticel | niesghbor VLAN 1d | Neihbor Protocol YLAN | Neighbor VLAN Nome | Weighbor Protocal |

w|mdw Frotocolld | ProtocolTxEnsble
| |Fafse

1]

o] 50| 3] Y] 0] B3] B e .|

0 rowtsd

"Local Protocol tab fields" (page 299) describes the Local Protocol

tab fields.

Local Protocol tab fields

Field

Description

PortNum

The port number.

Protocollndex

An arbitrary local integer value used by
this agent to identify a particular protocol
identity.

Protocolld

The octet string value used to identify the
protocols associated with the given port
of the local system.

ProtocolTxEnable

Indicate whether the corresponding Local
System Protocol Identity instance is
transmitted on the port.

—End—

See also:
e "Local VLAN Id tab" (page 294)

e "Local Protocol VLAN tab" (page 295)
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e "Local VLAN Name tab" (page 297)

* "Neighbor VLAN Id tab" (page 300)

e "Neighbor Protocol VLAN tab" (page 301)
* "Neighbor VLAN Name tab" (page 303)

* "Neighbor Protocol tab" (page 304)
Neighbor VLAN Id tab

With the Neighbor VLAN Id tab, you can view LLDP VLAN ID properties
for the remote system.

Step Action
To open the Neighbor VLAN Id tab:

1 From the Device Manager menu bar, choose Edit > Diaghostics
> 802.1ab > Port dotl.
The LLDP_Port_dotl dialog box appears with the Local VLAN Id
tab displayed.

2 Click the Neighbor VLAN Id tab.
The Neighbor VLAN Id tab appears ("Neighbor VLAN Id tab" (page
300)).

Neighbor VLAN Id tab

= 192.168.249.46 - LLDP_Port_dot1 x|
Local VLA 1d | Local Prokocol VLAN | Local VLAM Mame | Local Protocol [ieighbar VAR 1] Aeiohbor Protocol YLAN | Nelghbor VLAN Name | Hiekghbor Protocal |

Timabirk; \aml Index \v\i’\ldl

0 rowe(sh

et | )| 1| (8] cose| v

"Neighbor VLAN Id tab fields" (page 300) describes the Neighbor
VLAN Id tab fields.

Neighbor VLAN Id tab fields

Field Description

TimeMark The TimeFilter for this entry.

LocalPortNum Identifies the local port on which the
remote system information is received.
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Field Description

Index An arbitrary local integer value used

by this agent to identify a particular
MSAP. An agent is encouraged to assign
monotonically increasing index values to
new entries, starting with one, after each
reboot.

Vlanid The port VLAN identifier associated with
the remote system. If the remote system
does not know the PVID or does not
support port-based VLAN operation, the
value is zero.

—End—

See also:

¢ "Local VLAN Id tab" (page 294)

"Local Protocol VLAN tab" (page 295)
"Local VLAN Name tab" (page 297)

e "Local Protocol tab" (page 298)
"Neighbor Protocol VLAN tab" (page 301)
¢ "Neighbor VLAN Name tab" (page 303)

¢ "Neighbor Protocol tab" (page 304)

Neighbor Protocol VLAN tab
With the Neighbor Protocol VLAN tab, you can view LLDP Protocol VLAN
properties for the remote system.

To open the Neighbor Protocol VLAN tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diagnostics
> 802.1ab > Port dotl.
The LLDP_Port_dot1 dialog box appears with the Local VLAN Id
tab displayed.

2 Click the Neighbor Protocol VLAN tab.
The Neighbor Protocol VLAN tab appears ("Neighbor Protocol VLAN
tab" (page 302)).
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Neighbor Protocol VLAN tab

= 192.168.249.46 - LLDP_Port_dot1 x|
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"Neighbor Protocol VLAN tab fields" (page 302) describes the
Neighbor Protocol VLAN tab fields.

Neighbor Protocol VLAN tab fields

Field Description
TimeMark The TimeFilter for this entry.
LocalPortNum Identify the local port on which the remote

system information is received.

Index An arbitrary local integer value used

by this agent to identify a particular
MSAP. An agent is encouraged to assign
monotonically increasing index values to
new entries, starting with one, after each
reboot.

ProtoVlanid The ID of the port and protocol VLANS
associated with the remote port. A value
of zero is used if the system does not
know the protocol VLAN ID (PPVID).

ProtoVlanSuported Indicate whether the remote port supports
port and protocol VLANSs.

ProtoVlanEnabled Indicate whether the port and protocol
VLANSs are enabled on the remote port.

—End—

See also:

e "Local VLAN Id tab" (page 294)

e "Local Protocol VLAN tab" (page 295)
e "Local VLAN Name tab" (page 297)

e "Local Protocol tab" (page 298)

* "Neighbor VLAN Id tab" (page 300)

* "Neighbor VLAN Name tab" (page 303)
* "Neighbor Protocol tab" (page 304)

Nortel Ethernet Routing Switch 4500 Series
Overview — System Configuration
NN47205-500 02.01 Standard
5.0 23 February 2007
Copyright © 2007, Nortel Networks Nortel Networks Confidential



Configuring LLDP using Device Manager 303

Neighbor VLAN Name tab
With the Neighbor VLAN Name tab, you can view LLDP VLAN Name
properties for the remote system.

To open the Neighbor VLAN Name tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diaghostics
> 802.1ab > Port dotl.
The LLDP_Port_dotldialog box appears with the Local VLAN 1D
tab displayed.

2 Click the Neighbor VLAN Name tab.
The Neighbor VLAN Name tab appears ("Neighbor VLAN Name
tab" (page 303)).

Neighbor VLAN Name tab

& 192.168.240.46 - LLDP _Port_dot1 x|
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"Neighbor VLAN Name tab fields" (page 303) describes the
Neighbor VLAN Name tab fields.

Neighbor VLAN Name tab fields

Field Description
TimeMark The TimeFilter for this entry.
LocalPortNum Identify the local port on which the remote

system information is received.

Index An arbitrary local integer value used

by this agent to identify a particular
MSAP. An agent is encouraged to assign
monotonically increasing index values to
new entries, starting with one, after each
reboot.

Vlanid The integer value used to identify the
IEEE 802.1Q VLAN IDs with which the
remote port is compatible.

VlanName The VLAN name identified by the VLAN
ID associated with the remote system.

—End—
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See also:

e "Local VLAN Id tab" (page 294)

e "Local Protocol VLAN tab" (page 295)

e "Local VLAN Name tab" (page 297)

e "Local Protocol tab" (page 298)

* "Neighbor VLAN Id tab" (page 300)

* "Neighbor Protocol VLAN tab" (page 301)
* "Neighbor Protocol tab" (page 304)
Neighbor Protocol tab

With the Neighbor Protocol tab, you can view LLDP Protocol properties
for the remote system.

To open the Neighbor Protocol tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diaghostics
> 802.1ab > Port dotl.
The LLDP_Port_dotl dialog box appears with the Local VLAN Id
tab displayed.

2 Click the Neighbor Protocol tab.
The Neighbor Protocol tab appears ("Neighbor Protocol tab" (page
304)).

Neighbor Protocol tab
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"Neighbor Protocol tab fields" (page 304) describes the Neighbor
Protocol tab fields.

Neighbor Protocol tab fields

Field Description

TimeMark The TimeFilter for this entry.

LocalPortNum The local port on which the remote system
information is received.
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Field Description

Index An arbitrary local integer value used

by this agent to identify a particular
MSAP. An agent is encouraged to assign
monotonically increasing index values to
new entries, starting with one, after each
reboot.

Protocolindex This object represents an arbitrary local
integer value used by this agent to identify
a particular protocol identity.

Protocolld The protocols associated with the remote
port.

—End—

See also:

e "Local VLAN Id tab" (page 294)

e "Local Protocol VLAN tab" (page 295)

e "Local VLAN Name tab" (page 297)

e "Local Protocol tab" (page 298)

e "Neighbor VLAN Id tab" (page 300)

* "Neighbor Protocol VLAN tab" (page 301)
* "Neighbor VLAN Name tab" (page 303)

LLDP_Port_dot_3 dialog box
You can use the LLDP_Port_dot3 dialog box to configure and view IEEE
802.3 LLDP information. For more information, see the following tabs:

e "Local Port Auto-negotiation tab" (page 306)

e "Local PoE tab" (page 307)

e "Local Link Aggregate tab" (page 309)

e "Local Max Frame tab" (page 311)

* "Neighbor Port Auto-negotiation tab" (page 312)
* "Neighbor PoE tab" (page 313)

* "Neighbor Link Aggregate tab" (page 315)

* "Neighbor Max Frame tab" (page 317)
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Local Port Auto-negotiation tab
With the Local Port Auto-negotiation tab, you can view LLDP
auto-negotiation properties for the local system.

To open the Local Port Auto-negotiation tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diaghostics
> 802.1ab > Port dot3.
The LLDP_Port_dot3 dialog box appears with the Local Port
Auto-negotiation tab displayed ("Local Port Auto-negotiation tab"
(page 306)).

Local Port Auto-negotiation tab
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"Local Port Auto-negotiation tab fields" (page 306) describes the
Local Port Auto-negotiation tab fields.

Local Port Auto-negotiation tab fields

Field Description
PortNum The port number.
AutoNegSupported Indicate whether the local port supports

Auto-negotiation.

AutoNegEnabled Indicate whether Auto-negotiation is
enabled on the local port.
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Field Description

AutoNegAdvertisedCap This object contains the value (bitmap)
of the ifMauAutoNegCapAdvertisedBits
object (defined in IETF RFC 3636)
associated with the local port on the
system.

OperMauType A value that indicates the operational
MAU type of the given port on the local
system.

—End—

See also:

e "Local PoE tab" (page 307)

¢ "Local Link Aggregate tab" (page 309)

e "Local Max Frame tab" (page 311)

¢ "Neighbor Port Auto-negotiation tab" (page 312)
¢ "Neighbor PoE tab" (page 313)

* "Neighbor Link Aggregate tab" (page 315)

e "Neighbor Max Frame tab" (page 317)

Local PoE tab

With the Local PoE tab, you can view LLDP PoE properties for the local
system.

To open the Local PoE tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diaghostics
> 802.1ab > Port dot3.
The LLDP_Port_dot3 dialog box appears with the Local Port
Auto-negotiation tab displayed.

2 Click the Local PoE tab.
The Local PoE tab appears.
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"Local PoE tab fields" (page 308) describes the Local PoE tab fields.

Local PoE tab fields

Field Description

PortNum The port number.

PowerPortClass The port Class of the local port.
PowerMDISupported Indicate whether MDI power is supported

on the local port.

PowerMDIEnabled Indicate whether MDI power is enabled
on the local port.

PowerPairControlable Derived from the value of the
pethPsePortPowerPairsControlAbility
object (defined in IETF RFC 3621), this
value is used to indicate whether pair
selection can be controlled on the local
port.

PowerPairs This object contains the value of the
pethPsePortPowerPairs object (defined
in IETF RFC 3621) for the local port:

* signal
e spare
PowerClass This object contains the value of the

pethPsePortPowerClassifications object
(defined in IETF RFC 3621) for the local

port:
e classO
e classl
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Field Description

* class2
* class3

e class4

—End—

See also:

e "Local Port Auto-negotiation tab" (page 306)

e "Local Link Aggregate tab" (page 309)

¢ "Local Max Frame tab" (page 311)

¢ "Neighbor Port Auto-negotiation tab" (page 312)
* "Neighbor PoE tab" (page 313)

* "Neighbor Link Aggregate tab" (page 315)

* "Neighbor Max Frame tab" (page 317)

Local Link Aggregate tab

With the Local Link Aggregate tab, you can view LLDP link aggregation
properties for the local system.

To open the Local Link Aggregate tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diaghostics
> 802.1ab > Port dot3.
The LLDP_Port_dot3 dialog box appears with the Local Port
Auto-negotiation tab displayed.

2 Click the Local Link Aggregate tab.
The Local Link Aggregate tab appears ("Local Link Aggregate"
(page 310)).
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Local Link Aggregate
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"Local Link Aggregate tab fields" (page 310) describes the Local
Link Aggregate tab fields.

Local Link Aggregate tab fields

Field Description

PortNum The port number.

LinkAggStatus Specify the link aggregation capabilities
and the current aggregation status of the
link.

LinkAggPortld Contains the IEEE 802.3 aggregated port

identifier, aAggPortID (IEEE 802.3-2002,
30.7.2.1.1), derived from the ifNumber of
the ifindex for the port component in link
aggregation. If the port is not in a link
aggregation state or does not support link
aggregation, this value is set to zero.

—End—

See also:

e "Local Port Auto-negotiation tab" (page 306)

e "Local PoE tab" (page 307)

e "Local Max Frame tab" (page 311)

* "Neighbor Port Auto-negotiation tab" (page 312)
* "Neighbor PoE tab" (page 313)

* "Neighbor Link Aggregate tab" (page 315)

Nortel Ethernet Routing Switch 4500 Series
Overview — System Configuration
NN47205-500 02.01 Standard
5.0 23 February 2007
Copyright © 2007, Nortel Networks Nortel Networks Confidential



Configuring LLDP using Device Manager 311

¢ "Neighbor Max Frame tab" (page 317)

Local Max Frame tab
With the Local Max Frame tab, you can view LLDP maximum frame size
properties for the local system.

To open the Local Max Frame tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diaghostics
> 802.1ab > Port dot3.
The LLDP_Port_dot3 dialog box appears with the Local Port
Auto-negotiation tab displayed.

2 Click the Local Max Frame tab.
The Local Max Frame tab appears ("Local Max Frame tab" (page
311)).

Local Max Frame tab
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"Local Max Frame tab fields" (page 311) describes the Local Max
Frame tab fields.

Local Max Frame tab fields

Field Description

PortNum The port number.

MaxFrameSize The maximum frame size for the port.
—End—
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See also:

e "Local Port Auto-negotiation tab" (page 306)

e "Local PoE tab" (page 307)

e "Local Link Aggregate tab" (page 309)

* "Neighbor Port Auto-negotiation tab" (page 312)
* "Neighbor PoE tab" (page 313)

* "Neighbor Link Aggregate tab" (page 315)

¢ "Neighbor Max Frame tab" (page 317)
Neighbor Port Auto-negotiation tab

With the Neighbor Port Auto-Negotiation tab, you can view LLDP
auto-negotiation properties for the remote system.

To open the Neighbor Port Auto-Negotiation tab, perform the following

procedure.
Step Action
1 From the Device Manager menu bar, choose Edit > Diaghostics

> 802.1ab > Port dot3.
The LLDP_Port_dot3 dialog box appears with the Local Port
Auto-negotiation tab displayed.

2 Click the Neighbor Port Auto-negotiation tab.
The Neighbor Port Auto-negotiation tab appears ("Neighbor Port
Auto-negotiation tab" (page 312)).

Neighbor Port Auto-negotiation tab

1492.160.2449.46 - LLD®_Port_dotd
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"Neighbor Port Auto-negotiation tab fields" (page 312) describes the
Neighbor Port Auto-negotiation tab fields.

Neighbor Port Auto-negotiation tab fields

Field Description

TimeMark The TimeFilter for this entry.

LocalPortNum The local port on which the remote system
information is received.
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Field Description

Index An arbitrary local integer value used

by this agent to identify a particular
MSAP. An agent is encouraged to assign
monotonically increasing index values to
new entries, starting with one, after each
reboot.

AutoNegSupported The truth value used to indicate whether
the given port (associated with a remote
system) supports Auto-negotiation.

AutoNegEnabled Indicate whether Auto-negotiation is
enabled on the remote port.

AutoNegAdvertisedCap This object contains the value (bitmap)
of the ifMauAutoNegCapAdvertisedBits
object (defined in IETF RFC 3636)
associated with the remote port.

OperMauType A value that indicates the operational
MAU type of the given port on the remote
system.

—End—

See also:

« "Local Port Auto-negotiation tab" (page 306)
e "Local PoE tab" (page 307)

e "Local Link Aggregate tab" (page 309)

¢ "Local Max Frame tab" (page 311)

¢ "Neighbor PoE tab" (page 313)

"Neighbor Link Aggregate tab" (page 315)

¢ "Neighbor Max Frame tab" (page 317)

Neighbor PoE tab
With the Neighbor PoE tab, you can view LLDP PoE properties for the
remote system.

To open the Neighbor PoE tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diagnostics
> 802.1ab > Port dot3.
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The LLDP_Port_dot3 dialog box appears with the Local Port
Auto-negotiation tab displayed.

2 Click the Neighbor PoE tab.
The Neighbor PoE tab appears ("Neighbor PoE tab" (page 314)).

Neighbor PoE tab
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"Neighbor PoE tab fields" (page 314) describes the Neighbor PoE
tab fields.

Neighbor PoE tab fields

Field Description
TimeMark The TimeFilter for this entry.
LocalPortNum The local port on which the remote system

information is received.

Index An arbitrary local integer value used
by this agent to identify a particular
MSAP. An agent is encouraged to assign
monotonically increasing index values to
new entries, starting with one, after each

reboot.
PowerPortClass The port Class of the remote port.
PowerMDISupported Indicate whether MDI power is supported

on the remote port.

PowerMDIEnabled Indicate whether MDI power is enabled
on the remote port.

PowerPairControlable Derived from the value of the
pethPsePortPowerPairsControlAbility
object (defined in IETF RFC 3621), this
value is used to indicate whether pair
selection can be controlled on the remote
port.
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Field Description

PowerPairs This object contains the value of the
pethPsePortPowerPairs object (defined
in IETF RFC 3621) for the remote port.

* signal
* spare
PowerClass This object contains the value of the

pethPsePortPowerClassifications object
(defined in IETF RFC 3621) for the
remote port.

* classO
* classl
» class2
* class3
* class4
—End—

See also:

« "Local Port Auto-negotiation tab" (page 306)

¢ "Local PoE tab" (page 307)

e "Local Link Aggregate tab" (page 309)

¢ "Local Max Frame tab" (page 311)

¢ "Neighbor Port Auto-negotiation tab" (page 312)

"Neighbor Link Aggregate tab" (page 315)
¢ "Neighbor Max Frame tab" (page 317)
Neighbor Link Aggregate tab

With the Neighbor Link Aggregate tab, you can view LLDP link aggregation
properties for the remote system.

To open the Neighbor Link Aggregate tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diagnostics
> 802.1ab > Port dot3.
The LLDP_Port_dot3 dialog box appears with the Local Port
Auto-negotiation tab displayed.
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2 Click the Neighbor Link Aggregate tab.
The Neighbor Link Aggregate tab appears ("Neighbor Link
Aggregate tab fields" (page 316)).
Neighbor Link Aggregate tab fields
l |||.na||rtlawegn| ux:mm Frame | Msighbor Pt Ato-negotisbon | Nesghbor poE [RERFEGr Lrk Aggreoate | Meighbor Max Frame | o
| I
o] 1| | ] e .|
"Neighbor Link Aggregate tab fields" (page 316) describes the
Neighbor Link Aggregate tab fields.
Neighbor Link Aggregate tab fields

Field Description

TimeMark The TimeFilter for this entry.

LocalPortNum The local port on which the remote system
information is received.

Index An arbitrary local integer value used
by this agent to identify a particular
MSAP. An agent is encouraged to assign
monotonically increasing index values to
new entries, starting with one, after each
reboot.

LinkAggStatus Specify the link aggregation capabilities
and the current aggregation status of the
remote link.

LinkAggPortld Contains the IEEE 802.3 aggregated port
identifier, aAggPortID (IEEE 802.3-2002,
30.7.2.1.1), derived from the ifNumber of
the ifindex for the port component in link
aggregation. If the port is not in a link
aggregation state or does not support link
aggregation, this value is set to zero.

—End—
See also:

Copyright © 2007, Nortel Networks

"Local Port Auto-negotiation tab" (page 306)
"Local PoE tab" (page 307)

"Local Link Aggregate tab" (page 309)
"Local Max Frame tab" (page 311)
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* "Neighbor Port Auto-negotiation tab" (page 312)
* "Neighbor PoE tab" (page 313)

* "Neighbor Link Aggregate tab" (page 315)

¢ "Neighbor Max Frame tab" (page 317)
Neighbor Max Frame tab

With the Neighbor Max Frame tab, you can view LLDP maximum frame size
properties for the remote system.

To open the Neighbor Max Frame tab, perform the following procedure.

Step Action

1 From the Device Manager menu bar, choose Edit > Diaghostics
> 802.1ab > Port dot3.
The LLDP_Port_dot3 dialog box appears with the Local Port
Auto-negotiation tab displayed.

2 Click the Neighbor Max Frame tab.
The Neighbor Max Frame tab appears ("Neighbor Max Frame tab"
(page 317)).

Neighbor Max Frame tab
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"Neighbor Max Frame tab fields" (page 317) describes the Neighbor
Max Frame tab fields.

Neighbor Max Frame tab fields

Field Description
TimeMark The TimeFilter for this entry.
LocalPortNum The local port on which the remote system

information is received.

Index An arbitrary local integer value used

by this agent to identify a particular
MSAP. An agent is encouraged to assign
monotonically increasing index values to
new entries, starting with one, after each
reboot.

MaxFrameSize The maximum frame size for the remote
port.
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—End—

See also:

e "Local Port Auto-negotiation tab" (page 306)

e "Local PoE tab" (page 307)

e "Local Link Aggregate tab" (page 309)

e "Local Max Frame tab" (page 311)

* "Neighbor Port Auto-negotiation tab" (page 312)
* "Neighbor PoE tab" (page 313)

* "Neighbor Link Aggregate tab" (page 315)

Nortel Ethernet Routing Switch 4500 Series
Overview — System Configuration
NN47205-500 02.01 Standard
5.0 23 February 2007
Copyright © 2007, Nortel Networks Nortel Networks Confidential






Nortel Ethernet Routing Switch 4500 Series
Overview — System Configuration

Copyright © 2007, Nortel Networks
All Rights Reserved.

Publication: NN47205-500
Document status: Standard
Document version: 02.01
Document date: 23 February 2007

To provide feedback or to report a problem in this document, go to www.nortel.com/documentfeedback

Sourced in Canada and the United States of America

The information in this document is subject to change without notice. Nortel Networks reserves the right to make changes in design
or components as progress in engineering and manufacturing may warrant.

Nortel, the Nortel logo and the Globemark are trademarks of Nortel Networks.
Adobe and Acrobat Reader are trademarks of Adobe Systems Incorporated.
Java is a trademark of Sun Microsystems, Inc.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation.

NCORTEL



http://www.avaya.com/cgi-bin/comments/comments.cgi?key=techdocform&amp;amp;template=/templates/comments/cu_forms.html

	Overview — System Configuration
	Contents
	Preface
	Nortel Ethernet Routing Switch 4500 Series
	Related publications
	Finding the latest updates on the Nortel Web site
	How to get help
	Getting help from the Nortel Web site
	Getting help over the phone from a Nortel Solutions Center
	Getting help from a specialist using an Express Routing Code
	Getting help through a Nortel distributor or reseller


	4500 Series user interfaces
	Command line interface
	Accessing the CLI
	CLI command modes

	Java Device Manager
	Obtaining the Java Device Manager
	Installing the Java Device Manager
	Starting the Java Device Manager
	Configuring Device Manager properties
	Opening a Switch with the Java Device Manager
	Device Manager interface components
	Shortcut menus
	Status bar
	Using the buttons in Device Manager screens
	Editing objects
	Telnet session to a switch
	Opening an SSH connection to the switch
	Trap log
	Accessing the Web-based Management Interface
	Device Manager Online Help

	Web-based Management Interface
	Accessing the Web-based Management Interface
	Web-based Management Interface layout


	Basic configuration tasks
	Factory default configuration
	Setting user access limitations
	Setting user access limitations using the CLI
	 Setting user access limitations using the Web-based Management Interface

	Updating switch software
	Changing switch software in the CLI
	Changing switch software in the Java Device Manager
	Changing switch software in the Web-based Management Interface
	LED activity during software download

	Setting TFTP parameters
	Setting a default TFTP server
	Displaying the default TFTP server
	Clearing the default TFTP server

	Working with configuration files
	Configuration files in the CLI
	Configuration files in the JDM
	Configuration files in the Web-based Management Interface
	Automatically downloading a configuration file

	Terminal setup
	Setting Telnet access
	telnet-access command
	no telnet-access command
	default telnet-access command

	Setting server for Web-based management
	web-server command
	no web-server command

	Setting boot parameters
	boot command

	Defaulting to BootP-when-needed
	Configuring with the command line interface

	Customizing the CLI banner
	show banner command
	banner command
	no banner command

	Displaying complete GBIC information
	Displaying hardware information
	Shutdown command
	Reload command
	CLI Help

	About the Nortel Ethernet Routing Switch 4500 Series
	Hardware features
	Cooling fans
	Redundant power supply
	DC-DC Converter Module
	Stacking capabilities

	Auto Unit Replacement
	AUR function
	Configuring AUR using the CLI
	Configuring AUR using Device Manager
	Agent Auto Unit Replacement 

	Features of the Nortel Ethernet Routing Switch 4500 Series
	Flash memory storage
	Policy-enabled networking
	Power over Ethernet
	Virtual Local Area Networks
	Spanning Tree Protocol groups
	Rapid Spanning Tree Protocol
	Multiple Spanning Tree Protocol
	Trunk groups
	Security
	Port mirroring
	Auto-MDI/X
	Auto-polarity
	Autosensing and autonegotiation
	ASCII configuration file
	Displaying unit uptime
	Port naming
	Port error summary
	IP address for each unit in a stack
	BootP mode
	Web Quick Start
	Simple Network Time Protocol
	Ping enhancement

	Supported standards and RFCs
	Standards
	RFCs


	Power over Ethernet
	PoE overview
	Port power priority
	External power source
	Stacking
	Power pairs
	Power availability
	Internal power source only option
	External power source only option
	Power sharing option
	Power Supply Unit (PSU) option

	Diagnosing and correcting PoE problems
	Messages
	Connecting the PSU

	Power management
	Configuring PoE using the CLI
	Set port power enable or disable
	Set port power priority
	Set power limit for channels
	Set traps control
	Show main power status
	Set power usage threshold
	Setting PoE detection method
	Show port power status
	Show port power measurement

	Viewing PoE ports using the JDM
	Configuring PoE using the JDM
	Configuring PoE using the Web-based Management Interface
	Configuring power management on the switch
	Configuring power management for the ports


	Switch administration tasks
	General switch administration using the Command Line Interface
	Multiple switch configurations
	Assigning and clearing IP addresses
	Assigning and clearing IP addresses for specific units
	Displaying Interfaces
	Setting port speed
	Enabling Autotopology
	Enabling flow control
	Enabling rate-limiting
	Using Simple Network Time Protocol
	Clock configuration
	Custom Autonegotiation Advertisements
	Connecting to Another Switch
	Domain Name Server (DNS) Configuration

	General Switch Administration using the Web-based Management Interface
	Viewing stack information
	Viewing summary switch information
	Changing stack numbering
	Identifying unit numbers
	Configuring BootP, IP, and gateway settings
	Modifying system settings
	Managing remote access by IP address

	General Switch Administration using the JDM
	Viewing unit information
	Viewing PoE information
	Viewing switch IP information
	IP Globals tab
	IP Addresses tab
	IP ARP tab
	IP TCP tab
	IP TCP Connections tab
	IP UDP Listeners tab
	Viewing SFP GBIC ports
	Editing the chassis configuration
	Editing and viewing switch ports
	Editing and viewing switch PoE configurations
	Editing Bridging Information
	Configuring SNTP

	Viewing topology information using Device Manager
	Topology tab
	Topology Table tab

	Link Layer Discovery Protocol (802.1ab)
	Link Layer Discover Protocol (IEEE 802.1ab) Overview
	LLDP operational modes
	Connectivity and management information

	Configuring LLDP using the CLI
	lldp command
	lldp port command
	lldp tx-tlv command
	lldp tx-tlv dot1 command
	lldp tx-tlv dot3 command
	default lldp command
	default lldp port command
	default lldp tx-tlv command
	default lldp tx-tlv dot1 command
	default lldp tx-tlv dot3 command
	no lldp port command
	no lldp tx-tlv command
	no lldp tx-tlv dot1 command
	no lldp tx-tlv dot3 command
	show lldp command
	show lldp port command

	Configuring LLDP using Device Manager
	Viewing and configuring LLDP global and transmit properties
	LLDP_Port_dot1 dialog box
	LLDP_Port_dot_3 dialog box


	Tables
	Table 1 IP Globals tab fields
	Table 2


